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Copyright

All rights reserved. No part of this documentation may be copied, photocopied,
reproduced, translated, microfilmed, or otherwise duplicated on any medium without
prior written consent of UBS Corporation Sdn. Bhd.

No patent liability is assumed with respect to the use of the information contained
herein. Every precaution has been made to supply complete and accurate information.
However, UBS Corporation Sdn. Bhd. resumes no responsibility for its use, or for any
infringement of patents or others right of third parties which would result.

Disclaimer

No person should rely on the contents of this publication without first obtaining advice
from a qualified professional person. This documentation is provided on the terms and
understanding that (1) the author and editor and copyright owner are not responsible
for the results of any actions taken on the basis of information in this documentation,
nor for any error in or omission from this documentation; and (2) the author and
editor and copyright owner are not engaged in rendering legal, accounting,
professional or other advice services. The author and editor and copyright owner
expressly disclaim all and any liability and responsibility to any person, whether a
purchaser of related software or reader of this documentation or not, in respect of
anything, and of the consequences of anything, done or omitted to be done by any
such person in reliance, whether wholly or partially, upon the whole or any part of the
contents of this documentation.

UBS CORPORATION SDN BHD (441389-K)
Suite 1B-6, Level 6, Block 1B, Plaza Sentral,
Jalan Stesen Sentral 5, 50470 Kuala Lumpur.

Malaysia.
Website: Attp.//www.ubs-software.com
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Introduction

UBS HRMS is specially designed application software to manage personnel effectively and efficiently
for small and medium-sized enterprise. It promotes a paperless environment for all human resource

related procedure. As such, it reduces bureaucracy, increases speed of processing for relevant
approvals and enhances cross functional (vertical and horizontal) communications within an
organization. It contributes t the increase in productivity of an organization.

Getting Started

Double click UBS Human Resource Management System shortcut icon on the desktop to access
to the system. A default company name will be given, click “Edit” button to update you company

name or click "Add"” button to insert another new company. Different company should keep into
different data folder.

Create Database

After select the company name, the system will automatically generate the data files into the folder

you have selected.

User Login

Enter the Login ID and Password to access into the system. The default Login ID = UBS and
Password = UBS.

Recommended steps in setting up UBS HRMS:-

LoOoNoOn LN

24,

Install HRMS into hard disk

Administrator login

Housekeeping -> Setup -> General Setup --> Sharing ---> Smart Lock
Housekeeping -> Import and Export (for existing HRMS or Payroll user)
Housekeeping -> Setup -> General Setup

HR Department -> Miscellaneous Files

HR Department -> Miscellaneous Files (2)

Housekeeping -> Setup -> Default Setting

HR Department -> Tip -> Tip Scheme

HR Department -> Tip -> Default Tip Scheme

HR Department -> Employee -> Personnel File

Housekeeping -> Re-Calculate Leave (for new HRMS & Payroll user)
Housekeeping -> Administrative Tools -> Group Policy

Housekeeping -> Administrative Tools -> User Manager

Housekeeping -> Administrative Tools -> Department Approval
Housekeeping -> Change Password

Housekeeping -> Direct Access

Housekeeping -> Setup -> Enquiry Setting

HR Department -> Employee -> Salary

HR Department -> Employee -> Tip

HR Department -> Training -> Trainer

HR Department -> Manpower

HR Department -> Budget

HR Department -> Standard Documents (setup path to file location & change letter contents

according to company’s policy)

Please refer to the respective chapter and section for detailed process and explanation.
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Chapter 1 HR DEPARTMENT
Overview:
The main functionality of the system is to setup and manage the employees file. Then, the system has
the benefit to setup and schedule loan installments for the employees. And, it assists users to project,
compare and evaluate manpower utilization and budget plan. Besides, the module provides an easy
solution by providing common sample documents for company’s human resources official letters.
Lastly, this module contains various required miscellaneous files setup options, such as state, race,
branch, department, skill, leave, claim and etc. It is advisable that user should begin the initial operation
of the system by starting off with the miscellaneous files setup.
1.1 Employee
There are 8 categories of maintenance module incorporated under this main feature for keeping
track, storing history and managing of human resources details in term of personnel file, salary,
experience, club & society, reward & disciplinary, accident, career movement and skill.
1.1.1 Personnel File
Menu Location: HR Department > Employee > Personnel File
Description: This maintenance module contains 8 option pages to facilitate users processing
the employees’ personal details and other information including statutory, job, family,
education background, employment history, benefit and training.

User actions that can be performed include adding, searching, editing, deleting and printing of
employees’ records.

i Create/Add new employee data

1. Click “"Add"” button and enter the relevant information.

(i) Personal

** Personnel File Maintenance |§\
Emplayes No. _EUDJ. Hame AGNES TAN TING YING Intial | TTY
Statutory || Job || Family || Education Background || Employment History || Benefit || Training
Badae No. | FooiTrrOL Date of Bitth | n3704/1950
Address |12-K, LORUNG SULATHAN | Wewticho. | sonan3-ns-sase
ET.MLM\I HITAT | o 1jC N 1864985
Past Cods [13400 Town | CHERAS | 1 colour |B
State KUALL LUMPUR | Nationali.ty M¥ v Jex Female v
Fhore Mo, | 03-54697997 | Race CHINESE i
Phone Mo, (2) | 03-89464677 Burniputra | .N.g v
Email dddress | AGNESEHOTHALL . CON Religian | BUDDHIZH v
Permanent :- Emergency Contact :-
Address |22 TALAN WIRD | Persn | MR, JOHNSON
34350 IPOH | Relationship | FsBanD
| PERAK Phone No. 012-3214143
Phaore Mo, 05-7439671

Employee No. : Assign each employee with an identification code (maximum 6
characters).
It is a compulsory field and does not allow for modification after saving
the record.
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Name

Initial

Badge No.
Address
Post Code
Town

State

Nationality

Phone No.

Email Address:
Date of Birth
New I/C No.
Oold 1/C No.
I/C Colour
Sex

Race
Bumiputra
Religion

Permanent

: Enter the employee’s full name (maximum 45 characters)

: Indicate each employee with an unique initial letter not exceeding 3

alphabets.

: Enter the employee’s badge number, if applicable.
: The employee’s current contact address.

: Post code of the contact address.

: Location town/area of the address.

: State or province of the address.

(New state item can be maintained in HR Department >
Miscellaneous Files > State)

: Select the appropriate nationality or citizenship of the employee.

: Telephone numbers of the employee.

Alternatively, user may key in the employee’s hand phone number in
the next field Phone No. (2)

Email address of the employee, if applicable.

: DOB of the employee (dd/mm/yyyy).

: Employee’s new identity card number.

: Employee’s old identity card number.

: Specify colour of the old identity card if applicable. (One alphabet only)
: Female or Male

: Chinese, Indian, Malay or Others

! Yesor No

: Buddhism, Christianity, Hindu, Islam or Others

This section can be used to store the employee’s permanent Address and Phone No.
which is different from the current contact address stated above. For instance, it may be
home town of the employee.

Emergency Contact

This section is used to store Person to contact, Relationship with the employee and
Phone No. of the contact person, in the event of emergency.

2. Click on the "Put Photo” button to load the particular employee’s photograph from the
directory that you have saved. The system supports all graphics files, eg. BMP, JPG or others.

3. Proceed to next page Statutory.
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(ii) Statutory
** Personnel File Maintenance Il(\
Employee ho, E001 MName AGNES TAN YING YING Intidl | TYY
Personal | Statutory | 1ob || Family | Education Backaround || Employment History || Benefit || Training
Account No. :- Work Permit :- Passport :-
EPF 45678913 \wark Permit Mo, Passport No.
Income Tax 30, 489764665 Valid Date From [ 4 Expire Date: a
50050 [vas797978m ] Expire Date [
Tabung Haji
A3N
Transport CaR v
Remark A
e
Highest Education Qualification Degree v
Account No.

This section is used to store the employee’s EPF, Income Tax, SOCSO, Tabung Haji
and ASN number.

Field width to store each account number is 10, 15, 10, 12 and 12 characters
respectively.

Work Permit

For foreign workers, this section is to store the employee’'s Work Permit No. (20
characters) as well as Valid Date and Expire Date (both in dd/mm/yyyy format).

To check for overdue working permits, go to Enquiry - Work Permit Expire

Passport

For foreign workers, this section is to store the employee’s Passport No. (12 characters)
and Expire Date (dd/mm/yyyy format).

To check for expired passports, go to Enquiry > Passport Expire

4. Then, continue with the rest of setup and enter the relevant information.

Transport : Select the transport/vehicle that the employee possess to come to
work.
(New transport type can be created in HR Department >
Miscellaneous Files > Transport)

Remark : Any additional note in explaining more matters related to the employee.

Highest Education

Qualification : Select the employee’s highest academic achievement/qualification,
such as PhD, Master, Degree, Higher Diploma, Diploma, Certificate,
Secondary or Others.

5. After that, proceed to next page Job.
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(iii) Job

** Personnel File Maintenance |X‘

Emplayee Mo, E00L

Job Title HROL
Job Status G
Branch BELL
Department ACCT
Line Mo, .

Category

Date Terminate A
Reason

Pay Status hetive

Personal || Statutory I Job | Family | Education Background || Employment History || Benefit || Training

[rate Join 0z/02/1993
Date Confirm | 01/05/1893
Date Promote | 0170171995

Termination of Service :-

Mame | AGNES TAN YING TING Intial | TvE

+ || HUMAN RESO0URCE MANAGER SPecwhc Job Funickion

v | MANAGEMENT | |1. GIVE BRIEFING ON COMPANY 4
POLTCY T ALL HEW EMPLOYEES.

B [T EE NG T 2. DEAL WITH GOVERNMENT BODY

“ || ACCOUNTS 0N BEHALF OF MANAGING

. | DIRECTOR.
v

v

v

Save Cancel

Job Title

Job Status

Branch

Department

Line No.

Category

Date Join

Date Confirm

Date Promote.

: Select the employee’s job title.

(New type of job title can be created in HR Department >
Miscellaneous Files > Job Function)

: Select the employee’s job status.

(New type of job status can be created in HR Department >
Miscellaneous Files »> Job Status)

: Specify the location branch where the employee is from.

(New branches other than the existing records can be created in HR
Department > Miscellaneous Files » Branch)

: Specify the operational department where the employee is designated.

(New department other than the existing records can be created in HR
Department > Miscellaneous Files > Department)

: Specify the destination line number where the employee is working in.

(New line number can be maintained in HR Department >
Miscellaneous Files - Line No. Please refer to chapter 1.6.7 for
further details.)

: Specify the category or group where the employee is working in.

(New category can be maintained in HR Department >
Miscellaneous Files > Category. Please refer to chapter 1.7.8 for
further details.)

: The system current date. User may change to the appropriate date

when the employee joined the organization (dd/mm/yyyy).

: Initially, leave this field blank.

Update the date (dd/mm/yyyy) when the employee has obtained
his/her confirmation to the job.

Initially, leave this field blank.
Update it manually when the employee was granted job promotion.
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Note:

1. Date Join cannot be left blank or emptied because
this date will be used as the base to calculate the
annual leave entitlement and leave balance days
(in the next index page Benefit).

2. User may check for the employees’ Date Confirm
in module Enquiry - Confirmation.

The date to be confirmed is system-formulated
based on the general confirmation month preset in
Housekeeping - Setup - General Setup - ->
Other

All employees will apply this general setup unless
the particular job title’s confirmation month is
specifically reassigned in Housekeeping = Setup
- Default Setting - Confirmation Month.

For instance, certain categories of executive
employees might have longer confirmation period,
such as 6 months or more.

3. Date Confirm will determine the number of leave
days entitled for each employee during the year.
For instance, annual leave entitlement is only
effective after confirmation of the respective
employee. Please refer to chapter 1.7.15 Leave
Scheme for further details.

4. Date Promote cannot be earlier than Date
Confirm, and these two dates cannot be earlier
than Date Join.

y

Termination of Service

This section is used for recording of the particular employee’s termination details in the
unforeseen future.

(i) Enter the Date Terminate for the employee concerned. It represents the effective
date for employment terminated. Date Terminate cannot be earlier than Date
Join, Date Confirm and Date Promote.

(i) User must specify the Reason of termination such as Resignation, Retirement,
Retrenchment, Dismissal or Others.

(iii) Indicate remark for the termination in the next column provided.

(iv) An employee who has terminated contract of service should be classified as non-
active status.
After the month salary processing, set the salary Pay Status to “ Non-Active” so that
to stop salary processing for the following months.

At the end of this process, the employee will be marked as resigned staff but the data
still retain in the system. To remove the entire employee’s database from the system,

user must perform delete action. But, prior to this, user has to delete all related files in
other modules pertaining to the respective employee, eg. loan, training etc.

Specific
Job Function : Indicate the employee’s specific job function, duties and responsibilities.
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Note:
1. Once user has inputted Date Terminate, reminder can be
viewed in Enquiry - Termination.

2. When it reaches the particular Date Terminate, user must
change Pay Status to “Non-Active’.

[

6. Then, proceed to next page Family.

(iv) Family

** Personnel File Maintenance

Date of Birth 03/01,/1972

Page 11 of 223

—
[X]

Employee o, EooL Name | AGHNES TAN YING YING | Tnidal  TVT
Personal || Statutary || Job I Family | Education Background || Employment Histary || Benefit || Training

Marital Status Married 3

Spouse Mame JOHNS0N CHUN JIN MING Spause I/C Ko, 450704-06-7546

Tax Deduction For Spouse .Na L Total No. of Children Below 18 Years Old 1 [

Child's Name NICHOLAS CHUN

I o 720103-03-4567 Sex Male

A

hild's Mame I No, Sex Date of Birth

MIKI CHUN 780702-03-5466 |F 02/07/1979

SUSIE CHUN 870504-03-5466 |F 04/05/19587
Total o, of Chidren | 3

Save Cancel

Marital Status: Single, Married, Divorced, Widow, Widower, Others

Spouse Name : Enter the employee’s spouse name.

Spouse I/C No. : Enter the spouse’s identity card number.

Tax Deduction

For Spouse : Select " Yes” if the employee chooses to incl
payroll.

Total No. of

Children Below

ude tax deduction in the

18 Years Old: Enter number of children age below 18 years old.

menu.

Sex and Date of Birth.
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** Employee Family Maintenance E|
Child's Name
I/C Ma. ' 1 Sex [ w |
Ciate of Birth . F .
- fhild's Hame 17T Ho, Sex Date o Brth 4 |
| [mIcHOLAS CHIM 720103-03-4567 |M  [03/01/1972
| [mIEI cEim 790702-03-5466 |F  [02/07/1979
| [3UsIE cHUm §70804-03-5466 |F  [04/08/1987
| ¥
~|

9. Click “Save” button to store the record.

10. Select “"Add” button again if you want to insert more children’s record. Select “Edit” button
if you want to modify the existing record or “"Delete” button if you want to remove
unwanted child’s record. Choose “Print” button if you want to print out the £mployees
Children Listing. Otherwise, select “Exit” button to quit this sub-menu.

11. Then, proceed to next page Education Background.

Note:
1. The system will prompt user with message if Total number of

children below 18 years old entered earlier is not tally with
records entered by user in this sub-menu.

2. User may choose to auto update the total number of children
below 18 years old when performing Housekeeping 2 Import
and Export (refer to chapter 6.7)

(v) Education Background

** Parsonnel File Maintenance \_)E|
Employee No. j_EDDl Hame TAGN'ES TAN YING YING mhial [y
Fersonal || Statutary | Job | Family | Education Background :Emuluyment Histary _Benefit | Training
Course Mame .SPH

Education Centre SEKOLAH MENENGAH PEFEMPUAN IPOH

Date Start 05/01/1383 Date Complete |12/12/1068

Grade Obtained "
| i aurse Mame [ Qualfication Education Centre Date Start Date Complete  Grade Obtained A

LCCT PUTRL COLLEGE 0L/0L/1990 |05/05/1991 |PASS
DIPLOMA TN ACCOUNTING PUTREA COLLEGE 100141993 |15/11/1995 [DISTINCTION

v |

Save Cancel

12. Click on “Link” button and the system will prompt with another sub-menu.
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** Employee Education Background Maintenance

Course Mame
Education Centre

Date Start [+ s

Date Complete T
Grade Obtained
: tourse Mame | Qualification Education Centre Dake Stark Date Complete Grade Obtained |
| |5FPM SEKOLAH MENENGAH PEREMF|05/01/1963|12/12/1965(4 |
| |LCCI PUTEA COLLEGE 01/01/1990{05/05/1991 | PASS |
| |[DIPLOMA IN ACCOUNTING PUTEA COLLEGE 10/01/1993[15,/11 /1995 [DISTINCTION

b |

Save Cancel

13. In the Employee Education Background Maintenance sub-menu, click "Add"” button to
input a record. Enter the relevant information.

Course Name : Course tile.
Education Centre: Name of the education centre conducting the said course.
Date Start : The course’s commencement date. (dd/mm/yyyy)
Date Complete : The course’s completion date. (dd/mm/yyyy)
Grade Obtained : Result or performance achieved.
14. At the end of the input, click “"Save” button to store the record.
15. Select “"Add” button again if you want to input another new education record. Select “Edit”
button to modify a particular existing record. Select “Delete” to remove any particular
unwanted record. Select “Print” button if you want to print out the Employee Education

Background Report. Otherwise, click on the “Exit” button to quit this sub-menu.

16. Then, proceed to next page Employment History.

(vi) Employment History

** Personnel File Maintenance iz'

Employee Mo, | E00L Mame | AGNES TAN YING YIHG | mital | vy
Personal || Statutory || Job || Family || Education Background | Employment History | Benefit || Training

Company Name TIiN TEE EERHAD

Date Join 01/02/1970 Date Left .30,-‘06}’1975
Job Title | GENERAL CLERK
Reason Left | FURTHER sTUDY
| fCompany: Hame Date Jain Date Left Tob Title: Reason Left el
WWI SDN. EHD. 01/03/1975 [05/12/1955 [SHIFPING CLERE LOOK FOR EETTER CAREER
YEN CORPORATION 05/03/1986 [08/09/1959 [ACCOUNTS CLERE FURTHEE. 3TUDY

Save Cancel
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17. Click on “Link” button and the system will prompt with another sub-menu.

** Employee Employment History Maintenance

Company Mame
Date Join !
Job Title

Reason Left

: fornpany Mame

Date Left ;o

Dabe Join Date Left

Job Title

Reason Left

TIAN TEE EERHAD

0140241870 |30/06/1975

GENEFAL CLERE

FURTHEE. STUDY

WWI 5DN. EHD.

0140341978 |05/12/1985

SHIPPING CLEFK

LOOE FOE. BETTEE C

YEN CORPORATION

05/03/1986 |06/09/1959

ACCOUNTS CLERK

FURTHEE. STUDY

Save Cancel

B |

18. In the Employee Employment History sub-menu, click *Add” button to input a record.
Enter the relevant information.

Company Name : Previous employer of this particular employee.

Date Join : Date when he/she joined the previous employer. (dd/mm/yyyy)

Date Left : Date when he/she left or resign from the previous employer.
(dd/mm/yyyy)

Job Title : Job position or title held in the previous employment.

Reason Left : Cause of leaving or resignation from his/her previous employment.

19. At the end of the input, click “"Save” button to store the record.

20. Select “"Add"” button again if you want to input another new employment record. Select
“Edit” button to modify a particular existing record. Select "Delete” to remove any
particular unwanted record. Select “"Print” button if you want to print out the Employee
Employment History Report. Otherwise, click on the “Exit” button to quit this sub-menu.

21. Then, proceed to next page Benefit.

(vii) Benefit

** Personnel File Maintenance

Employee Mo, |E001

Leave Scheme Code ?.LSUI

Mazimum Cairied Forward Annual Leave

MName

AGNES TAN YING YING

| FOR MANAGEMENT LEVEL

5.0

Persanal || Statutory || Job | Family || Education Background || Employment History | Benefit | Training

Initial

TYT

Length of Service in Vear  Day Entied

Tip Scheme Code

TCOL

v | FoR. MANAGEMENT 1EVEL

- A E]
Leave Code
| AL hd _Annual Leave we | 5o 5.0

Leave Application Status | Afrer Confirmation to ¢ | 99.0 | 22.0

T v
Total Brought Forward Annual Leave 0.00 -

= - = Mate: '« = Less Than
Total Annual Leave Entitled 0.00 Annual Leave Balance 0.00
Claim Scheme Code |csnz v FOR NON-SALES STAFF
| Elaim Code Claim Description IMax Claim Per Receipt  Max Claim Per Year Remark -
| o2 DENTAL 80,00 80.00
| [os OUTSTATION 500.00 5000.00
E_El? PARKING FEE 100.00 1200.00 b

Save Cancel

%
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22. Firstly, select the appropriate Leave Scheme Code. This is a compulsory entry. The
selected scheme represents all leaves entitled for the respective employee. Click on the
arrow down button of Leave Code to view the content of each leave type. (Details of the
leave can be modified in HR Department > Miscellaneous Files > Leave Scheme.

23.

24,

25.

(viii) Training

This page is showing all the relevant training programs attended by the particular employee
during his/her employment in the company. The information listed in the table is sorted by order

Human Resource Management User Manual Page 15 of 223

Please refer to chapter 1.7.15 for more explanation.)

Note:
1.

During maintenance in “Add” mode, Total Brought Forward Annual
Leave, Total Annual Leave Entitled and Annual Leave Balance are
zero figures and disabled for user input. The system will apply the
selected leave scheme and calculate the actual figure after user has
completed input by pressing “Save” button.

Total Annual Leave Entitled is calculated based on date join of the
employee, cut-off period for leave entittement (in Housekeeping 2>
Setup 2 General Setup - -> Leave) and the leave scheme code.

If the employee has any annual leave brought forward from previous
calendar year, user can input the number of days in “Edit” mode.

Secondly, select the appropriate Claim Scheme Code if it is applicable to the respective
employee. (Details of the claim can be modified in HR Department > Miscellaneous
Files > Claim Scheme. Please refer to chapter 1.7.17 for more explanation.)

Thirdly, select the appropriate 7Tip Scheme Code if the respective employee is entitled for
such benefit. (Details of the tip scheme can be setup in HR Department > Tip 2> Tip

Scheme. Please refer to chapter 1.6.1 for more explanation.)

Finally, user must always remember to click "Save"” button to confirm all inputs and update

the information.

of Skill Code, Date Complete and then Date Retraining.

This page is not editable. The training details are updated from HR Department > Training >

Training Program. Please refer to chapter 1.2.2 for more explanation.

*% Parsonnel File Maintenance [E
Emplayee Mo, EOD0L Mame AGNES TAN YING YING Inikial TYY
Personal || Statutory || Job || Family || Education Background || Employment Histary || Benefit I Training
Program Code PLOG
kil Code aC08 INDUSTEIAL RELATION REGULATIONS

Date Begin 28/05,/2004 Date Complete 28/05/2004
Skill Rate [ 3 Date Retraining 30/07/2004

Frogram Code Skl Code Description Date Begin Date Complete Rate Date Retraining = #

FCO7 SC11 PROJECT MANAGEMENT 15/10/2003 |15/10/2003 0
FCOZ2 3C12 [MANAGEMENT SKILL 05/05/2003 |06/05/2003 5

1z B!
ra

v

Core J_so JL oo JL oot | e ] [ )
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ii Search for an existing employee data

There are two ways to search and locate en existing employee data.

Method 1: by navigation buttons

| Firsk || Previous ” Meck || Lask |

The first button on the left will access to the first listed record of the employee database. The
last button on the right will access to the final record of the employee database. And, the middle
two buttons are to navigate the previous and next record respectively.

Method 2. using Search function button

1. Select "Search” button and the following dialog box will prompt you to search by Employee

No or Name.
** Search |£|
Emploves Mo, Mame Ll
» |
E0OZ WILLIAM 00I 5IM HOI
E0O3 3ITI BINTI ABDULLAH
E004 TaN MING LING
EOOS ANDY LOO CHIN 3IM
E00O& ROBERT LIM HUI MUN
E0O7 LINDA 0O0OI POH POH

et

Left Text E_Employee No. V_: _ _

Containing Text  IEVCSNNNNINNNE v
Enployee No.

Name [ oK H Cancel l

2. Specify searching criteria and click "Search Now" to display all possible results.
Searching Criteria:

(a) Left Text ~ search for character(s) begin from the left that matched exactly with
existing employee record.

(b) Containing Text ~ search for any character(s) that matched exactly with content of
the text.

3. Point to the desired record and double click, or

highlight and click "OK" to choose the record to be displayed.

iii Modify an existing employee data

You can edit all records of an employee with the latest information except Employee No.
Besides, Training page is not editable. Modification and updating must be done in AR
Department > Training > Training Program.

1. Using the searching method described earlier to find and locate the record to be modified.
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2. Select “Edit” button.
3. Update latest information into the employee’s record.

4. Click “Save” to save the information, or “"Cancel” to disapprove any modification done.

iv Delete an existing employee data

Before proceed to delete any employee, make sure the particular employee has been classified
as "Non-Active” in Personnel File Maintenance (Job page Pay Status). Then, you have to
remove all related data in family, education background, employment history, loan, training etc.
Finally, delete the user login profile at Housekeeping > Administrative Tools > User
Manager, and delete also the assigned department approval authorization at Housekeeping >
Administrative Tools > Department Approval for the respective employee.

To delete:-

1. Use the searching method described earlier to find and locate the employee to be deleted.

2. Select “"Delete” button.

3. Click “Yes” to delete the particular employee’s record, otherwise click “No” to cancel deletion.

v Print employee personal details

1. Click on the “Print” button and the system will prompt with a sub-menu.

2. Specify the data extraction criteria and click "OK” button to proceed to the print option.

Maore Filker Parameters

3. Or, you may tick the checkbox to open up more filter parameters.

** Employee Personal Details Report

Employee Mo. Fram j E] To | zzzZZE E] Job Code From j E] To | f.:4:1-4 E]
Dept. Code From B Ta | EEZZZZEZZZZZ B Job Stabus From B To |zz B
Line Ma. From E] To | EZZZZZZZZL E] Branch Code From | E] To |zzzz E]
Category Code From } E] To | zzzzzzzzze E] Leave Scheme From . E] To |zzzz E]
Date Jain From 0170172004 To |3L1/12/2004 Claim Scheme From E] To |zzezz E]
Mare Filter Parameters DateEron

Badge No. From E] To |zzzzzzzzzz E] DOB I To L
Matinnality From E] To |zz E] Passport Expire Ao To [ FA,

Sex ALl Ld . Work Permit Yalid I Ta . #

Race ALL v| work Perrit Expire: ;o To Ry

Bumiputra AJ_J_ w | Confirm j i To F

Pay Stakus All ~ Pramote A Ta [ Fa

Highest Education Qualification A11 v Terminate 'l To i

Tip Scheme Code From E] To |zzzz E]

COPYRIGHT © UBS CORPORATION SDN BHD



EZUBS

User Business System Human Resource Management User Manual Page 18 of 223

Print Dption

Default Printer: 4UBS-SERYER'HP LASERJET 1100 (MS)

Printing options

Print : send the file to printer to produce a printout
Preview : view the actual report on screen

File : generate a text file

Customize: open and view the customized report format
Printer : select the name of the printer to be used
Close : exit this print option box

1.1.2 Salary

Menu Location: HR Department > Employee > Salary

Description: This option is to facilitate user recording and keeping track of the employees’
salary history.

** Employee Salary Maintenance |Z|
Employee Mo, E001
Mame AGNES TaN YING YING
Effective Date 0l/01/2004 | Diake Join 04/02/1993
Salary 3850.00 |
Remark |
Effective Date Salary Remark |
04/02/1993 1500.00
01/01/1985 1600.00
01/01/1998 1800.00
01/01/1999 2000. 00
01/01/2000 Z200.00
01/01/2001 2500.00 =
01/01/2002 2800. 00
01/01/2003 3500.00
01/01 /2004
“
Previous I Mext " Last ] [ Add " Edit " Delete " Search ” Brint ] [ Exit ]

1. Select the employee that you want to update by pressing “Search” button or navigation
buttons.

2. The respective Employee No., Name and Date Join will be displayed.

3. Click on the “"Add" button to update the latest salary information.
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Effective Date : Date when the new salary scheme taking effect.
Salary : Wages amount payable with effect from the date stated earlier.

Remark : Any additional explanation note pertaining to the salary scheme, eg.
approval or adjustment reason.

4. Click “Save” button to store the record.

Note:

Initially, when a new employee joined the company, the
starting salary will auto apply the default salary setting based
on the appointed job title, as per maintenance in
Housekeeping = Setup = Default Setting - Salary.

If the particular employee gains promotion or demotion and it
involve salary adjustment, user must manually maintain the

newly effective salary details.

1.1.3 Tip

Some companies provide the benefit of tip allowance to their employees. Therefore, the
employers need to record and calculate amount of tip or number of point earned by each
employee. Then, at the end of a specified period, users can include the tip figure and export
to UBS Payroll System for salary processing.

Typical operations for setting, recording and calculation of tip can be summarized as the
following steps-

1. Create the tip scheme in HR Department > Tip > Tip Scheme. Please refer to chapter
1.6.1

or,

Implement default tip scheme based on job title in HR Department > Tip > Default Tip
Scheme. Please refer to chapter 1.6.2

2. Assign particular tip scheme to respective employees in HR Department > Employee ->
Personnel File. Please refer to chapter 1.1.1 maintenance for Job and Benefit page.

3. Maintain/modify individual employee’s tip figure in HR Department »> Employee > Tip.
This will be discussed in this chapter.

4. Calculation of tip value in HR Department > Tip > Tip Value. Please refer to chapter
1.6.3

5. View summary reports in Report > Tip > Employee Tip Amount Report and Report
2 Tip 2 Employee Salary and Tip Summary Report.

Basically, there are two types of tip activities, whether it is operated by amount or point. Users
can setup the necessary operation method in Housekeeping > Setup > General Setup -
=-> Tip & Tip (2) pages.

Menu Location: HR Department > Employee 2> Tip
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Description: This option facilitates users to maintain or modify the respective employees’ tip
figure.

** Employee Tip Maintenance

Employee Mo, |E00L

Marne | AGNES TAN YING YING

Tip Scheme Code |Tcol | FOR MANAGEMENT LEVEL

Apply Status |Before Confirmation | Date Join | 04/02/1993 | Date Confirm | 01/05/1993
Effective Date 04/02,/1993 | Mo, of Point | Amount [ 10. 00000

Remark.

FFecEive Date .No. of Point,l’Amount Remark. ~

04/02/1993
04/02/1994 15.00000
04/02/1995 20. 00000
04/02/1996 Z5.00000
04/02/1997 30.00000
04/05/2076 0.00000
v
I Mext " Last ][ Add ” Edit " Delete " Search " Print ][ Exit ]

The footer of the module will display the Employee No, Name and Tip Scheme Code according
to the maintenance in the employee’s personnel file. Apply Status indicates the particular tip
scheme is to be applied before or after employment confirmation of the employee. Date Join will be
the first record as effective date to start the tip calculation. Date Confirm will be the starting date
indicator when to begin the tip calculation if the tip scheme is to be applied After Confirmation.

As shown in the sample screen, if a tip scheme is to be applied Before Confirmation, the first tip
point/amount shall be taking effect immediately from the date the employee joined the company
(same as Date Join).

On the other hand, if a tip scheme is to be applied After Confirmation, the first tip point/amount will
only be effective on the employee’s confirmed date (same as Date Confirm).

** Employee Tip Maintenance

Employee Mo, E00S
Marme ANDY LOO CHIN 5IM
Tip Scheme Code |Tcoz | FOR NON-MAMAGEMENT LEVEL
Apply Status Afrer Confirmation | DateJain 01/07/2001 | Date Confirm | 0171042001
Effective Date 01/07/2001 Mo, of Point f Amount | 0.00000
Remark. [
| .Ff.ective Date Mo, of Po\nt,I;Amount Remark o
| [o1s10/2001 S.00000
| [o1s07/2002 10. 00000
| [o1s07/2003 15.00000
01/07/2004 20. 00000
| [o1s07/2008 Z5.00000
| [o1/10/2084 0.00000
I 9
l First " Previous “ et “ Last ] l Add “ Edit " Delete " Search " Print ] l Exit ]

For instance, based on the sample screen shown above, this employee is having a tip scheme which
will be applied After Confirmation. He joined the company on 01/07/2001 and was confirmed 3
months later, which is on 01/10/2001. Therefore, his Date Join is the first effective date to begin the
tip calculation. But, he is still not entitled for the tip benefit until he obtained his employment

confirmation. Thus, he will only be entitled for the tip benefit with effective from Date Confirm
onwards.
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In this Employee Tip Maintenance menu, all records for Effective Date and No. of
Point/Amount will be listed according to the tip scheme code assigned (at HR Department >
Employee > Personnel File - -> Benefit) or job title appointed (at HR Department >
Employee > Personnel File - -> Job) during the employee’s personnel file maintenance.

Note:
1.

Prior to this maintenance, users MUST setup properly the
essential and necessary tip details in HR Department 2 Tip
- Tip Scheme. Refer to chapter 1.6.1

If user inputs the employee’s job title (in Job page) but does
not specify the tip scheme code in Benefit page, the system
will still capture the related tip scheme based on the
employee’s job title, provided user had done setup in HR
Department - Tip = Default Tip Scheme.

If user defined the relevant tip scheme code in Benefit page
but does not specify the employee’s job title, the system will
process the tip calculation accordingly based on the tip
scheme code selected.

If both pages were inputted but there exists conflict of
information, e.g. user selecting a job title with scheme different
from the assigned tip scheme in Benefit page, the system will
follow tip scheme setting in the Benefit page.

In other words, Tip Scheme Code in Benefit page selected
will be privileged and on first priority.

Nevertheless, if user does not setup any specify tip scheme and assign it to the employees, user can
still create/maintain the tip structure individually. For instance, when a company introduces a special
tip only for a specify group of employees for a specified period of time.

In the following example, this company does not practising any tip benefit. Therefore, they do not
setup a tip scheme. Observe that the Tip Scheme Code is blank. But, the company may want to
implement a tip scheme for certain group of employees only on a period of time.

To add tip details

1. At the relevant employee’s record, click "Add” button to insert the tip detail.

** Employee Tip Maintenance

Employee Mo, ED0&

Mame ROEERT LIM HUI MUN

Tip Scheme Code

Apply Status Date Join 0170871994 | Date Confirm

Effective Date 0l/01/2003 Mo, of Point | Amount 0.00000

Remark.

Effective Date Mo, of Point,l;nmount Rema.rk

X

01/11/1994

0l/1z/2002 §.50000|SPECTAL INCENTIVE FOR DEC 2002

Save Cancel

v
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2. Enter the Effective Date when the tip scheme shall begin. Then, input the No. of

Point/Amount. Indicate the Remark (not more than 50 characters) for reason to implement
this special tip.

Click “Save” button to update the record.

If the tip is only for a specified period of time or temporary basis, it is advisable to insert another
ending record to terminate the tip calculation. For example, in the sample screen shown, the
special tip is only for the month of December 2002, therefore, user should insert another record

to terminate the tip calculation from 01/01/2003 onwards. Repeat step 1 to 3 to perform insert
action.

5. Click “Exit” button to quit this module.

To modify tip details

Use Edit mode to change or modify contents of the tip when the changes only affecting a particular
employee, without major reshuffle to the existing tip scheme. For instance, when an employee is
granted an additional increment in tip benefit other than the existing tip scheme he/she is entitled for.

1.

4.

5.

At the respective employee’s record, locate and point to the affected tip record to be modified
from the table. Click “Edit” button.

Specify the Effective Date and No. of Point/Amount. Enter the Remark to indicate the
reason for this tip benefit. In the sample screen shown, the existing effective tip point/amount
from 07/04/2004 is 25.00000, now, it will be changed to 27.00000

Click “Save” button to update the record.

** Employee Tip Maintenance gj
Employee Mo, E0D4
Marme TAN MING LING
Tip Scheme Code TCOZ FOR NON-MANAGEMENT LEVEL
Apply Status After Confirmation Date Join 07/04/2000 | Date Confirm | 01/07/2000 |
Effective Date 07/04/2004 Mo, of Paint § Amount 27.00000
Rermark ADDITIONAL 2% FOR EEST STAFF
Effective Da.te Mo, 6F Point,l’.\imouﬁt Remark ~ |
07/04/2000 5.00000
07/04/2001 10.00000
07/04/2002 15.00000
07/04/2003 Z0.00000
Li
07/07/2083 0.00000
v

If the tip benefit is to be applied for certain period of time, remember to insert another tip record
to terminate the tip calculation. Assuming this tip scheme is only applicable for 1 month period,
add another record effective from 07/05/2004 with 25.00000 point. So that the staff will revert
back to the old scheme from 07/05/2004 onwards.

Click “Exit’ button to quit this module.

To print tip listing

Click “Print” button to access to print option to list/print out the Employee Tip Listing.
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Summary report will list out the current effective tip point/amount. Detailed report will display all tip
point/amount from the first until the latest effective date in the employee history.

1.1.4 Experience

Menu Location: HR Department > Employee > Experience
Description: This option enables user to record the employee’s past working experience.

** Fmployee Experience Maintenance @

Employee Mo, E001
Marne AGNES TaN YING YING
Experience Details

| WORKED A5 GENERAL CLERK, SHIPPING CLERK, AND ACCOUNTS CLERK. VERY WELL

UNDERSTANDING IN COMPANY OVERALL FLOW. HAVE EXPERIENCE IN PROVIDING TRAINING TO

| HIGHER MANAGEMENT LEVEL.

mcarar

v

l Edit " Delete “ Search " rint ] l Exit ]

1. Search and select the particular employee that you want to update, by pressing “Search”
button or navigation buttons.

2. Click "Add” button to key in the employee’s past working experience. Click “Save” button
to store the record.

3. Select “Edit” button if you want to insert more details. Click “Save” button to update
details entered.

Note:

Whenever user has created a new employee, the record will
appear in this module. User then has to select the respective
employee and maintain his/her working experience.

Initially, use “Add” mode to insert new information.
If there are more details to be updated for subsequent times,
user has to use “Edit” mode.

“Delete” option will remove and clear details of the employee’s
working experience but the employee’s name remains in the
menu.

“Print” option will print out the Employee Working Experience

Report.

7

1.1.5 Club & Society

Menu Location: HR Department > Employee > Club & Society
Description: This option enables user to store information of the club and society participated
or taking part by the employees. It will have details of the club/society joined, duration of

membership and position held in the club/society.
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** Employee Society Maintenance

Employee Mo, E00Z
Marne | WILLIAM 00T SIH HUI
Society Mame PENANG SO0CCEE TEAM
Drate Join 0730432000 T Date Left | F
Position Held .CA.PTA.IN . o
Remark
i S-ociety,l’club,l’Team Tame Date Join Date Left Position Held Remark. ~

SELANGOR. SPORTH CLUE - TAB|02/02/1992 |09/03/2000 |SENIOR PLAYER DEPARTURE F|
M

sl

[P e (e . o ———— — f— E—

1. Select the respective employee by pressing “Search” button or navigation buttons.

2. Click "Add” button to insert new record. Enter the relevant information in Society Name,
Date Join, Date Leftand Position Held.

3. Click “"Save” button to update the details.

4. Select “"Add"” button again to add more records. Or, click “Exit” button to quit this module.

Note:

“Add” option is to insert a new record, whereas “Edit” option
is to update or modify the record, eg. when an employee has
left the club/society he/she joined. Search for the particular
employee and select the respective record to be amended,
click “Edit” button to perform the update. Click “Save” button
to store the amendment.

“Delete” option is to remove any irrelevant society/club/team
membership for the particular employee.

“Print” option will print out the Employee Society
Participating Report.

L

1.1.6 Reward & Disciplinary
Menu Location: HR Department > Employee > Reward & Disciplinary
Description: This option enables user to record and track reward granted to and disciplinary
action enforced on any particular employee.

Example of Reward
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** Employee Reward/Disciplinary Maintenance

Employee Mo, E0OL

Marme AGNES TAN YING YING

Type Reward Initiate Date 05/01/2004

Initiator's Employee Mo, | Eno6

Initiator's Marme .RDBERT LIM HUI MUN

Details

GOOD ATTENDANCE. NO SICE LEAVE, ABSENT, OR LATE FOR THE WHOLE YEAR OF 200Z. ~
v

Action Taken RM 100 CASH GIVEN EY COMPANY 435 REWARDING.

Action Taken Date 31/03/2004

| Add “ Edit " Delete " Search " Print ] I Exit ‘

1. Click “Search” button to locate a particular employee.

2. At the respective employee, click "Add” button to create a new action. Enter the relevant
information:-

Type : Reward or Disciplinary
Initiate Date: Date when case proposed or reported.

Initiator’s
Employee No. : The person who proposing or reporting the case.

Details : Remark or notes pertaining to the respective case.

Action Taken: Click on the arrow down button at the end of the field to select the
relevant action.

If Type selected is “Reward", actions available for selection are as per
maintenance in HR Department > Miscellaneous Files (2)>
Reward Action.

If Type selected is "Disciplinary”, actions available for selection are as
per maintenance in HR Department > Miscellaneous Files (2) >
Disciplinary Action.

3. Enter the Action Taken Date (dd/mm/yyyy) if the recommended / proposed action has
been or to be materialized.

4. Click “Save” button to update the record.

Note:
“Search” button is to search and locate one particular employee from the database.

“First”, “Previous”, “Next” and “Last” buttons are to navigate all related available
records (Reward or Disciplinary) for individual employee, eg. when the same
employee has more than one action record in history.

To change view to another employee, user must use “Search” button.

“Edit” button is to modify or update the relevant record for the particular employee,
ea. enter date of action taken.
[
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- continue -

“Delete” button is to remove one at a time any particular action record from the
employee’s history. The employee’s name remains in the menu but the action record
will be deleted.

“Print” option will print out the Employee Reward /Disciplinary Report.

Example of Disciplinary

** Employee Reward/Disciplinary Maintenance

Employee Mo, .EDDS

Marme :AN'DY LO0 CHIN .SIH ) l
Type 5__Disc:iplinar Initiate Date [ 07/04/2003 :
Initiator's Employes Mo, E006 : .
Initiator's Mame RDBERT LIM HUI MUN

Details

| COMPLAINED EY THE MOST IMPORTANT CUSTOMEE, SHOWED TEMPER TO THE CUSTOMEE. VEREAL A
| WARNING HAS BEEN GIVEN. IN ADDITION, COUNSELLING HAS BEEN CONDUCTED EY HR
| MANAGEE..

Action Taken : VERBAL WARNING

Action Taken Date [ 14/04/2003

add il Edt " Delete " Search " Print ] [ Exit ]

Note:

If Action Taken Date is a future date, you may setup reminder at
Housekeeping = Setup = Enquiry Setting and make inquiry at Enquiry =
Reward or Enauirv = Disciplinarv.

1.1.7 Accident

Menu Location: HR Department > Employee - Accident
Description: This option enables user recording cases of accident details incurred and
corrective or preventive action taken during employment.

** Employee Accident Maintenance E|
Emploves Mo, E001
Mame ;AGN'ES TAN YING YING
Accident Date [0z/07/2003 |

Accident Details

| 0N 01/07/2003 MON 2:30PM, FALL DOWN FROM THE STAIRCASE AT 15T FLOOR. SECURITY 5
GUARD SENT HEE TO THE GENERAL HOSPITAL AT 3:00PH.

Effect | SPRATH HER LEG. SICK LEAVE 1 WEEK.
Corrective | Preventive Action

| THE SLIPPERY FLOOR MAT HAS BEEN REMOVED. NO FLOOER MAT CAN BE PUT AT THE ~
STATRCASE. THE CLEANER HA3 TO CLEAN THE STAIRCASE EVERY DAY.

v

[ Add " Edit " Delete " Search " Print ] l Exit ]
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1. Click “Search” button to locate a particular employee.

2. Select "Add” button to insert a new record. Enter the relevant information:-
Accident Date : Date when accident incurred.
Accident Details : Information details of the accident.
Effect : Influence or end result of the accident.

Corrective / Preventive
Action : measure/action taken to rectify or prevent the incident from recurring.

3. Click “"Save” button to store the record into the employee history.

Note:

Use “Search” to locate a particular employee from the database.

Use “First”, “Previous”, “Next” and “Last” buttons to navigate through all
records for the individual employee, if the respective employee has more than

one accident record in history.

Use “Edit” button to modify the existing accident record for the particular
employee.

Use “Delete” button to remove irrelevant accident record from the employee
history. But the employee’s name remains in the menu.

Use “Print” button to print out the Employee Accident Report.

7

1.1.8 Career Movement

Menu Location: HR Department > Employee > Career Movement
Description: This option enables user to maintain and tracking the employee’s career
advancement during his/her employment in the organization.

** Employee Career Movement Maintenance @
Employee Mo, E004
Narne TAN MING LING

Effective Change Date [ 0l/08/2002

From Branch |BREL || PENANG BRANCH

To Branch v

Current Job Title . RDO3 Al PROGRAMMER.

Mew Job Title RDOZ ¥ || SYSTEM ANALYST

From Department RslD RESEARCH & DEVELOPMENT

To Department v. |

Recommended By E00G V._ ROBERT LIM HUI MIUN

Approved By .EDDG V ROBERT LIM HUI MIN

Reason/Remark

| EXCELLENT ACHIEVEMENT IN PROJECT DEVELOFMENT AND IMPLEMENTATION La

M

Save Cancel
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1. Click “Search” button to locate a particular employee.

2. Click "Add” button to insert a new record for the particular employee.

3. Enter effective date for the new career advancement in Effective Change Date.

4. The system will show history record in From Branch, Current Job Title and From
Department. These fields were disabled for user input as they are retrieved from the

database and updated when user maintaining the employee personnel file.
5. Enter the relevant selection in the following fields:-

To Branch : Select the new branch where the employee will be transferred to.
(New branch can be created in HR Department > Miscellaneous

Files > Branch)

New Job Title : Select the employee’s newly appointed job title.
(New job title can be created in HR Department >
Miscellaneous Files > Job Function)

To Department : Select the new department where the employee will be relocated to.

(New department can be created in HR Department >
Miscellaneous File > Department)

Recommended By : Select the proposer’s name from
the list of employees.

Approved By : Select the authorizer’s name
from the list of employees.

Reason/Remark : Input the reason for such career
advancement.

6. Click "Save” button to update the record.

1.1.9 Skill

Note:
1. As the result of the update process, information maintained will be updated to
module HR Department > Employee 2 Personnel File

“Search” button is to locate a particular employee from the database.
“First”, “Previous”, “Next” and “Last” buttons is to navigate through all records for
the individual employee, if the respective employee has more than one career

movement record in history.

“Edit” button is to modify the existing career movement record of the respective
employee.

“Delete” button is to remove irrelevant career movement record from the employee
history. But the employee’s hame still remains in the menu.

“Print” button is to print out the Employee Career Movement Report.

=

This menu is divided into two sub-modules:-

(i) Employee Skill Requirement Maintenance is to assign the necessary required skills to

the respective employees.
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(i Employee Actual Skill Maintenance is to update the respective employee’s existing
actual skill and its rating.

Process Workflow

1. create various categories of skill
(HR Department > Miscellaneous Files > Skill Category)

2. assign skill code into the related skill category
(HR Department > Miscellaneous Files > Skill Code)

3. setup group of required skills with multiple skill codes and rating
(HR Department > Miscellaneous Files > Skill Requirement)

4. identify skill requirements for each employee group
(HR Department > Employee > Skill > Employee Skill Requirement)

5. update actual skill possessed by the employee
(HR Department > Employee > Skill > Employee Actual Skill)

After setup the necessary skill requirements and then update the actual skill possessed by the
employees, user can view the comparison and analysis report in Report > Skill >
Employee Training Needs Analysis Report. This report assists users to compare and
evaluate expected and existing skills of the employees.

1.1.9.1 Employee Skill Requirement

Menu Location: HR Department > Employee > Skill > Employee Skill
Requirement

Description: This option enables user to identify the necessary and expected
knowledge and skill required by the Management, in order for the employees to
perform their job responsibilities.

** Employee Skill Requirement Maintenance

Emploves Mo, EOOL
ame AGNES TAN YING YING
Skill Requirement. Code 5601
Diescription FOR ALL MANAGERS
Ekill Requirement Code  Description A
308 FOR FEOJECT MANAGERZ
G610 FOR. LEADERS
G611 FOR ALL STAFF
v
l Mext " Last l l Add ” Edit " Delete “ Search " Print l l Exit l

1. Click “Search” button to locate and select the particular employee from the employees
list; or, navigate through the list by pressing “First”, “Previous”, "Next” and “Last”
buttons to find the employee.
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2. At a particular employee’s record, click “*Add” button to assign a new skill group id.

3. At Skill Requirement Code field, select the relevant item and click "Save” button to
update the information.

4. Select “"Add” button again if there are more requirements to be fulfilled by the respective
employee. Repeat step 3.

5. Click “Exit” button at the end of the setup process.

1.1.9.2Employee Actual Skill

Menu Location: HR Department > Employee > Skill > Employee Actual Skill
Description: This option enables user to record and update existing knowledge and
actual skill possessed by the employees from past experience.

** Employee Actual Skill Maintenance @
Employes Mo, E00L
Hame .AGNES TAN ¥ING ¥ING
Skil Code [ arnz 1 Attention: Skill rate From O (lowest) ko 9 (highest)
Description [ TYPING
Skill Rate {Actual) [ g 1
mEkiII Code Description Skill Rate (Actual) | .;
| |sco3 ENGLISH LANGUAGE 7
| |sco4 MANDARIN LANGUAGE g
|_|gcos JAPANESE LANGUAGE Z
| |gcos SAFETY GUIDE 9
| |gcos INDUSTRIAL BELATION REGULATIONS 7
| |5C1l PROJECT MANAGEMENT 3
| |scl1z2 MANAGEMENT SEILL 5
| |5c14 ENHANCE COMMUNICATION SKILL g
[ [sc1s HUMAN FESOURCE MANAGEMENT 4| ¥/
l Mext " Last l l Add " Edit " Delete " Search " Print: l l Exit l

1. Click “Search” button to locate and select the particular employee from the employees
list; or, navigate through the list by pressing “First”, “Previous”, "Next"” and "Last”
buttons to find the employee.

2. At a particular employee’s record, click “"Add” button to update the skill code possessed
by the respective employee.

3. At Skill Codefield, select the relevant item and update the actual skill rating achieved
by the employee in Skill Rate (Actual) field.

4. Click “Save” button to store the information.

5. Select "Add” button again if there are more skill details owned by the respective
employee. Repeat step 3.

6. Click “Exit” button at the end of the maintenance process.

MESSAGE

Jj) Cannok delete! Training has been conducked!
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If the above message prompted when user attempts to perform deletion of employee skill
record, it means that this employee has attended training for the related skill. User must go
to HR Department > Training > Training Program, select the related skill code, click
on “Add/View Trainee"” and then delete the respective employee training record.

Human Resource Management User Manual

Please refer to chapter 1.2.2 for more details.

1.2 Training

There are two options under this module, allowing user to setup the trainer’s information and

training programs conducted within the organization.

1.2.1 Trainer

Menu Location: HR Department > Training > Trainer

Description: There are two types of trainers, whether they are internal or external. Internal
trainers are employees come from the organization or based in the company’s training
department. Whereas external trainers are expert personnel come from outsource.

Internal Trainer

8-

'i'rainer Code

Trainer Maintenance

Skakus Interhal

Trainer Code E002
Marme WILLTAM 00T 3IM HUI
Centre Code

Centre Mame

To add or view the skill code, click Addiew Skill Code button

Marne

Addview Skill Code

Skatus |

E00L

AGNES TAN YING ¥ING

Internal

E004

TAN MING LING

Internal

E00&

ROEERT LIM HUT MUN

Internal

EX01 CHAN BENG BENG External
ExozZ ANGIE 001 External
EXD3 JACKEY LOOT External
3 |
I« >
(e JLon ] oo ]

1. Select "Add” button.

2. Click on the Status arrow down button to select “Internal’.

3. Click on the Trainer Code arrow down button to select the related employee.

Note:

there is nothing

For internal trainers maintenance screen, users can only
Add/Delete/Print the record but cannot edit the data because

to be modified since the Trainer Code is

based on employee number and the Name, Centre Code and
Centre Name are all disabled for user input.
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4, Click “Save” button to store the trainer’s record.

5. Then, in the same particular record, click "Add/View Skill Code” button. You will be prompted
with another menu screen.

** Trainer Skill Maintenance @
Trainer Code E00Z
Trainger Mame WILLIAM 00T SIM HUT
Skill Code sCz25 bt
Description | PC AND HARDWARE MAINTENANCE
Fee u.nn-:
Remark IT SUPPORT AND SPECIALIST
| Pkl Code Description Fee Cadl
aC19 NETWORKING 0.00
M
Bl
I« 2

6. In Trainer Skill Maintenance menu, click "Add” button to insert new skill code for the
particular trainer.

Skill Code : Click on the arrow down button to select the related skill code for the
particular internal trainer.

Description : Definition of the related skill code as per maintained in HR Department
> Miscellaneous Files > Skill Code

Fee : Zero amount; input field not applicable for internal trainer as normally
there will not be any fee charged.

Remark : Any additional note pertaining to the respective trainer’s particular skill.
7. Click “"Save” button to update the trainer’s expertise skill code.

8. If there are more skills possess by the internal trainer, click "Add” button again to insert another

skill code. Otherwise, select “Exit” button to quit the Trainer Skill Maintenance menu.

9. Repeat step 1 to maintain another new internal trainer’s record or proceed to the next section for

the steps to maintain external trainer, or select “Exit” button to quit this module.

External Trainer
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** Trainer Maintenance [g|
Skatus . External
Trainer Code | Ex03
Name | 7acky LooT
Centre Code '-ccuz |
Centre Name . CL EDTCATION CENTEE
To add or view the skill code, click AddfView Skil Code button Addfview skil Code
Trainer Code Mame Status ~ |
| [E001 AGNES TAN YING YING Internal
| |E002 WILLIAM 00I 5IM HUI Internal
| |E004 TAN MING LING Internal
| |ED0& ROBERT LIM HUI MUN Internal
| |E®OL CHAN BENG EENG External
| |EXDZ ANGIE 00T External
M |
| 1|
E3 - B |
l Add “ Edit: ” Delete H Print l l Exit l

1. Select "Add” button and enter the relevant information.
Status : Select “External’

Trainer Code : Enter identification code for the external trainer (maximum 6

characters). It is advisable to use other unique code to differentiate
from the employee code.

Name : Enter the external trainer's name. (maximum 45 characters)

Centre Code : Click on the arrow down button to select the centre where this external
trainer comes from. (New centre code and location can be maintained
in HR Department > Miscellaneous Files > External Training
Centre)

Centre Name : The corresponding external training centre’s name.

2. After completed, click “Save” button to store the record.

3. Then, in the same particular record, click "Add/View Skill Code” button. You will be prompted
with another menu screen.

** Trainer, Skill Maintenance

Trainer Code [ EX03
Trainer Mame . JACKY LODI
Skl Code |sc11 v|
Descripkion PROJECT MANAGEMENT
Fee 3200.00 |
Remark PROJECT PLANNING, LEVELOPMENT & IMPLEMENTATION
5ki|| Code Description Fee ~
SCE7 SYSTEM TESTING METHODOLOGY 2500, 00
SC28 S0FTWARE DEVELOPFMENT 1800.00
SC29 S0FTWARE ENGINEERING 2000, 00
M
et ||
I : B
Save Cancel
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In Trainer Skill Maintenance menu, click "Add” button to insert new skill code for the

Skill Code : Click on the arrow down button to select the related skill code for the
particular external trainer.

Description : Definition of the related skill code as per maintained in HR Department
> Miscellaneous Files > Skill Code

Fee : Enter the course fee chargeable for the respective training.

Remark

Click “Save” button to update the trainer’s expertise skill code.

: Any additional note pertaining to the respective trainer’s particular skill.

If there are more skills possess by the external trainer, click "Add” button again to insert another

skill code. Otherwise, select “Exit” button to quit the Trainer Skill Maintenance menu.

this module completely.

1.2.2 Training Program

1.

Menu Location: HR Department > Training > Training Program

Repeat step 1 to maintain another new external trainer’s record or select “Exit” button to quit

Description: There are two types of training program, whether it is conducted internally or
externally. This option enables user to update the training program details and trainees’
record at the end of the training program.

** Training Program Maintenance

Program Code FCO3 Training Status External
Skill Code SCT12 | SOFTWARE ENGINEERING
Trainer Cade EX03 | TACKY L0OT
Start Date 01/04/2003 End Date 05/04/2003 |
Tatal Training 2 (days) | 2 {hours) a5 {mins)
Course Fee Z000.00 HRDF Claim 1000.00 Other Expenses 0.00
Evalustion on Trainet | yERY EXPERIENCE SFEAKER. PROVIDES MANY EXAMPLES AND QUOTE REAL A
LIFE EXAMPLES FOR EASE OF UNDERSTANDING. 3
Rermnark. .RECDHIIENDED BEY CHIEF ENGINEER
Frogran Cocie Training Status Skill Code Skill Description Al
PCOL |Internal SCGO035 SAFETY GUIDE
PCOZ Internal SCHOL PROJECT MANAGEMENT
PCO4 External SCGOL SHORT HAND
PCOS Internal SCGO0Z TYPING
PCOG Internal SCW0E INDUSTRIAL RELATION REGULATIONS
PCO7 External SCHOZ MANAGEMENT SKILL
PCOS Internal SCW0L LABOUE. LATWS
Sl
1< »
Addfview Trainee l Add " Edit " Delete " Search " Print l l Exit ]

Click “Add"” button and enter the relevant information.

Program Code : Assign abbreviation code for each training program (maximum 10
characters).

Training Status: Refers to the training location whether the training program was conducted
Internal or External site.
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Skill Code : Select type of skill taught in the training program. New skill code can be
created in HR Department > Miscellaneous Files > Skill Code.

Trainer Code : Select the trainer who has conducted the training program. New trainer
can be maintained in HR Department - Training > Trainer.

Start Date : Started date of the training program.

End Date : Ended date of the training program. If the training was conducted and
completed on the same day, this should be the same as the start date.

Total Training : Duration of the training program in days, hours and minutes.
Course Fee : The program’s claimable training fees.
HRDF Claim  : Amount for Human Resources Development Fund (HRDF), if applicable.

Other Expenses : Any miscellaneous expenses incurred during the course of training

program.
Evaluation
on Trainer : Comments and feedback received from the participants pertaining to the
performance of the respective trainer.
Remark : Any additional notes to indicate about the training program.
Note:

Course Fee, HRDF Claim and Other Expenses entered in this module will be
used for comparison in HR Department 2 Budget under training type.

2. Click “"Save” button to update the record.

3. To insert or modify the trainees who have attended the training program, select “Add/View
Trainee” button and you will be prompted with another menu.

4. In the Employee Training Record Maintenance menu, click "Add” button to include the

trainee who has participated in the particular program.

Program Code | FCO3 Attention: Skill rate from O {lawest) ko 9 (highest)

Skill Cade 3CT12 SO0FTWARE ENGINEERING

Trainer Code EX03 JACEY LOOI

Start Date 01/04/2003 End Date 05/04/2003

Employee Mo, E004 E]

Marme | TAN MING LING

Dept, Code :R&D RESEARCH & DEVELOPHMENT

Skill Rate 9 % | Current Rate 5 | Date Retraining ;o7

Remark. ACTIVE PARTICIPANT IN CASE STUDY DISCUSSION

Ermployves Mo, Mame Dept. Code Skill F

E002 WILLIAM 00T 5IM HUI ReD 7

b |

I« 8 |
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10.

11.

12.

13.

Click on the arrow down button of Employee No. to select the relevant trainee. The system will
display the corresponding Name and Dept. Code of the trainee.

Enter the Skill Rate result achieved by the trainee at the end of the training.

Current Rate refers to the existing achievement and past result for the related skill, if
applicable.

Current Rate s the actual skill rate originated from HR Department > Employee > Skill >
Employee Skill.

This figure will be replaced by the Skill Rate maintained in this menu option after user
confirmed to save the record. It will then update to the Skill Rate (Actual) in HR Department
> Employee > Skill > Employee Skill.

Enter the Date Retraining if the particular employee does not satisfy the necessary skill
requirement and shall be scheduled for another session of training.

Date Retraining maintained in this module will be shown in the Enquiry - Retraining and
also in Report > Training > Employee Retraining Report

Input Remark for matter related to this trainee/employee, if applicable.

Click “Save” button to update the record.

Select “"Add” button if you wants to include another trainee for the same training program.
Select “Edit” button if you wants to modify the existing records (Skill Rate, Date Retraining
and/or Remark). Select “"Print” button if you wants to print the Employee Training Records
Listing.

Select “"Exit” button to quit the Employee Training Record Maintenance menu.

Click “Exit” button one more time to exit this module completely.

** Employee Training Record Maintenance

Progran Code [ FCO3 Attention: Skill rate From O (owest) ta 9 (highest)
Skill Cade | 5CT12 SOFTWARE ENGINEERING

Trainer Cade E=03 | TACEY LOOI

Skart Date 01;04;2003; End Date 05/04/2003

Employee Mo, EO0R

bt | ROBERWIETN el Ed

Dept, Code HE

Skill Rake | 1 “**?r/ Ape you sure you want ko delste this record? | ¢

Remark,

I ‘es ] [ Mo

Employes Mo, [Mame He .S.lzill 1
EQ0Z WILLIAM TUT oI Ul Tor 78 |
EQ004 TAN MING LING Rzl ]
) |
el
I« >
l &dd H Edit ” Delste ” Prirt ] [ Exit I
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Note:
When user select “Delete” button, there are two phases of delete action.

1. First message “Are you sure want to delete this record?” is the confirmation
message whether user want to remove current data in Employee Training
Record Maintenance menu.

ST

-continue-

2. Second message “Delete employee skill record?” is the confirmation message
whether user would also like to remove the same related data in HR Department
- Employee - Skill > Employee Skill.

If user wants to retain the employee’s actual skill history, e.g. the knowledge the
employee obtained from previous training or employment, user must click “Yes” button
to acknowledge the first pop-out message but “No” in the second pop-out message.

If user wants to remove the entire skill history for the respective employee, then user

must click “Yes” twice to acknowledge both pop-out messages. As a result, you will
be deleting the skill code in Employee Training Record Maintenance menu as well

as Employee Skill Maintenance menu.

1.3 Loan

Menu Location: HR Department > Loan
Description: This option enables user to maintain loan details and repayment schedule.

** Fmployee Loan Maintenance

Emplovee Mo, E0OL

Mame AGNES TAN YING YING

Loan Policy Mo, EQ01HLO401

Loan Type | LHO3 | |HOUSING LOAN |

Loan Amiount 50000.00 Loan Active Date 01/01/2004

Interest Rate (%) . g.00 Pay Methad 2nd Half Payroll

Repayment Amount 1100.00 Loan Period (Mo, of Installment) 55

First Instaliment Crake | 31/01/2004 Installment Completed Date PR

oan Policy Mo, Loan Type Description Loan Amount  Loan Active Date Ink, Rate (%R A
| |EDDLLCOL LNol CAR LOAN - MGMT Z0000.00)01/12/2002 5.00
| v
I« ¥

[ Text H Last l [ Add H Edit ” Delete " Search “ Print l [ Exit l

1. Search and locate the employee by clicking “Search” button or navigate through “First”,
“Previous”, Next" or “Last” buttons.

2. Click “Add” button to create a new loan account.
3. Enter the relevant information:-

Loan Policy : Loan policy reference number (maximum 10 characters)
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Loan Type : Select the related loan type (New loan type can be created in HR
Department > Miscellaneous Files »> Loan Type).

Loan Amount : The loan’s principal value.

Loan Active Date : Effective date of the loan financing.

Interest Rate (%) : Effective interest rate imposed on the respective loan type (as per
maintenance in HR Department > Miscellaneous Files > Loan Type)
User may change the interest rate if it is different from the default rate.

Pay Method : Specify the loan repayment method, whether it is to be deducted from
payroll (7 Half Payroll, 2 Half Payroll, 1°* & 2™ Half Payroll) or direct
Payment.

Repayment Amount : Enter the scheduled loan repayment amount.

Loan Period (No.

of Instalment) : This represents the number of installments to fully settle the loan, based
on the repayment amount given.

First Installment Date: The first installment’s payment date.

Remark : Additional notes in explaining the loan.

4. Click “Save” button to update the loan information.

Note:

1. In order to enable the system to generate the loan schedule, user must enter
Loan Amount, Repayment Amount or Loan Period, Pay Method and First
Installment Date.

2. If the employee is going to settle the loan with a fixed Repayment Amount,
the system will calculate the corresponding loan period (number of
installment) accordingly, taking consideration of the interest charged.

If the employee intends to settle the loan for an approximate Loan Period
(No. of Installment), the system will calculate the corresponding repayment
amount by adjusting to the appropriate loan period accordingly, after take into
account the interest charged.

3. If Pay Method is to be processed through Payroll, HRMS will retrieve the
loan repayment amount and transfer it into Deduction Table (on the 12
column) in UBS Payroll System, after user had performed export process in
HRMS and import process at Payroll.

4. If Pay Method is Payment (Not Thru Payroll), repayment is done with
immediate payment, without going through Payroll processing for salary
deduction.

F

1. To update loan details, select the particular loan policy and click “Link” button.

2. Formula for the monthly Interest Charged,

loan balance x interest rate

12 months
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®

Yiear zuu.q. Month il
Payment Date :31,-’01;“2004 Pay Method znd Half Payroll
Scheduled Amount 1100.00 | Pay Amount 1100.00
Tokal Paid 2200.00 Balance 65518.95 |
Eear IMth Payment Date Pay Method Scheduled Amt, Pay Amt, Interest ChargeBalance ” |
z00d| z|29/02/2004|2nd Half 1100.00 1100.00 328,22 45461, 55
2004| 3|/ 4 Znd Half 1100.00 323.08 4587584, 63
zood| 4|/ J Znd Half 1100.00 325.23 49109, 86
2004| s/ F Znd Half 1100.00 327.40 49437, 26
zood| al/ J Znd Half 1100.00 329,58 49766, 64
2004 7/ 4 Znd Half 1100.00 331.78 L0098, 62
zood| g/ J Znd Half 1100.00 333.99 L0432.61
2004 9|/ / Znd Half 1100.00 336.22 L0768, 83
zood| 10|/ J Znd Half 1100.00 336,46 51107.29 |
[lzopal12ls Znd Halfl  1100,00  zan.72l  s144s.01]Y)
[ Add “ Edit H Celete “ Prink I l Exit: ]
Assume that, Loan Amount = 50,000, Interest Rate = 8%
and Pay Amount = 1,100
Month/Year Interest Charged Balance
01/2004 50000 x 8% 50000 + 333.33-1100
---------------- 333.33 = 49233.33
12
02/2004 49233.33 x 8% 49233.33 + 328.22 - 1100
= 328.22 = 48461.55
12

If the loan is to be settled through payroll processing, Payment Date will be updated automatically

after user performed HRMS export process at Housekeeping - Import and Export. This

Payment Date will be the same date as user input in Loan Payment Date (in Loan section while

exporting).

And, after HRMS export process, Pay Amount will also be updated according to the repayment

amount scheduled.

Therefore, any changes should be done before HRMS export process, for instance,

(i) skip payment for particular month,

or,

(ii) change the loan repayment scheduled amount.

1. To skip a scheduled payment, in Loan Details sub-menu, at the related scheduled loan record,

click “Edit” button

2. Click at the Pay Method arrow down button and select skip statement.
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3.

** | pan Details

Year [ 2004 : Month . 3 |
Payment Date | /7 | Pay Method kip Znd Half Payroll hd
scheduled Amount | 1100.00 | Pay Amount Znd Half Payroll
Total Paid 2200.00 | Balance g b i hayt ol RS |
.ear Mth Payment Date Pay Method Scheduled Amt, Pay Amk, Interest ChargeBalance A‘
2004 1{31/01/2004|Znd Half 1100.00 1100.00 335,33 49233, 335
2004| 2|129/02/2004|2nd Half 1100.00 1100.00 325,22 45461, 55
2004 41/ / 2nd Half 1100.00 0.00 325,23 49109, 86
z004] 514/ Znd Half 1100.00 327.40 49437, 26
2004 &/ / 2nd Half 1100.00 329, 55 49766, 54
004 74 S Znd Half 1100.00 331,76 500938, 62
2004 &)1/ / 2nd Half 1100.00 335,99 L0432.61
004 9/ f Znd Half 1100.00 TE6. 22 E0768.83
2004|101/ / 2nd Half 1100.00 335. 46 51107, 29 |
Llzoo4l 100/ / end Halfl  1100,00 E 340,721 51443, 010 ¥

Then, click “Save” button at the bottom of the sub-menu to update the revised loan details.

To change the scheduled loan repayment amount, in Loan Details sub-menu, at the affected
loan record, click “Edit” button.

Change the Scheduled Amount.

** | pan Details

Year [ 2004. fonth [ 4 |
Payment Date I £ [ Pay Method 2nd Half Payroll v |
Scheduled Amount 2000.00 | Pay Amount 0.o0
Total Paid | 2z200.00 | Balance £9375.41 |
ear Mth Payment Date Pay Method Scheduled Amt, Pay Amt, Interest ChargeBalance -
| [zoo4| 1f31/01/2004(2nd Half 1l00.00 1l00.00 33333 49255, 33 |
| [2004] Z|29/02/2004(2nd Half 1100.00 1100.00 F25. 22 45461.55
| |2o0d) 51/ 4 Skip Znd 1100.00 0.00 323.08 45754.63
| |2o004] 51/ 4 Znd Half 1100.00 327,40 49437, 26
| |enod] els Znd Half 1100.00 F29. 55 4976654
| |2o04] 7?1 4 Znd Half 1100.00 331.78 L0095, 62
| |Zood| &)1 F Znd Half 1l00.00 333.99 L0432.61
| |2004] 9l f Znd Half 1100.00 336,22 L0765.583
| |2o0d 10y, f Znd Half 1l00.00 F36. 40 51107.29 |
Llzoogl 111y s 2nd Half 1100, 00 : 340,721 51445010 %

Then, click “Save” button at the bottom of the sub-menu to update the revised loan details.

Alternatively, user may also add/include additional payment other than the scheduled payments.

1.

In Loan Details sub-menu, click “Add” button.
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** | oan Details E]
Year 2004 Month 5
Payment Date 1470572004 Pay Method Payment (Not Thru Payroll ¥
Scheduled Amount 1100.00 Pay Amount 500.00
Total Paid 4200.00 Balance 66112.23

ear  Mth Payment Date Pay Method Scheduled Amt, Pay Amk, Interest ChargeBalance ~

2004 1{31/01/2004|2nd Half 1100.00 1100.00 333,33 49233, 33
2004) Z2|28/02/2004|2nd Half 1100.00 1100.00 25,22 45461, 55
2004 31/ / Skip Znd 1100.00 0.00 323.08 45754, 63
Z004) 4|30/04/2004|2nd Half 2000.00 2000.00 S25.23 47109, 86
2004 51/ / 2nd Half 1100.00 314.07 47423.93
2004 &/ Znd Half 1100.00 316,16 47740,09
2004 715/ 2nd Half 1100.00 315.27 45058, 36
z004) &1/ / Znd Half 1100.00 320.39 48378.78
2004 91/ / 2nd Half 1100.00 322,53 45701, 25
2004) 1ols ¢ 1Znd Halfl 1100, 00 324,68 40025, 95| ™|

2. Enter the Yearand Month. Specify the Payment Date.

3. Assuming that the employee is making an immediate payment, select Pay Method as * Payment
(Not Thru Payroll)'. Enter the Pay Amount.

4. If the additional payment is supposedly to be processed through Payroll, enter the relevant Year
and Month. Select the Pay Method either 1 Half Payroll or 2" Half Payroll. (These steps
should be performed before HRMS export process and then UBS Payroll System import process.)

5. Lastly, click “Save” button to update the revised loan details.

Note:
1. Action of skip/change/add payment will directly affecting the length of Loan Period
(No. of Installment) and the scheduled final installment amount.

2.  When the loan was fully paid, the system will auto update the last installment date
to Installment Completed Date. Once this relevant date is filled, users will be
prohibited to modify the loan details. Users can only view and print the loan details.

If any modification to a completed loan is authorized and deemed necessary, user
must clear the Installment Completed Date so that to enable editing the loan
details.

3. If a payment was skipped, the interest will be accumulated into the monthly
balance.

4. If loan repayment is scheduled on 1% & 2" half of payroll processing, the interest
will be charged into the 1% half payroll.

5. As the interest is charged on monthly basis, the employees still need to pay the full
interest charged for that month, even though the settlement is to be done on the
beginning of each month.

7

1.4 Manpower
Menu Location: HR Department > Manpower

Description: This option facilitates user planning manpower employment and then compare with the
actual resources utilization.
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** Manpower Maintenance

Branch

EFD1

Cepartment . MOET

Job Title

| 5102

Total Mo, of Person Required

Plan

KEDAH ERANCH

MARFETING

GALES EXECUTIVE

2

Actual

1

Page 42 of 223

B

ranch Granch Desc,  Dept, Code  Depk, Desc, Job Job Title Plan  Actual Different |
BEL1l [MATN BRANCH/ACCT ACCOUNTS ACOLl [ACCOTUNTS M 1 1 1]
EKL1 [MAIN ERANCH|CS CUSTOMEER. SURCE02 [CUSTOMER 307 3 0 -3
EFL1 [MATN EFRANCH/HE HUMAN RFEZ0URHROL (HUMAN REZ0U] 1 1 1]
EPG1l |FENANG BEAN|RE:D RESEARCH & IRDOZ |S¥STEM ANAL 2 1 -1
EPG1 |PENANG EEAN|R:D RESEARCH & IRDO3 |PROGRAMMEE 4 2 -2
EPR1 |PERAK ERANCIMEET HMARKETING SLOZ |3ALES EXECT] 1] 1 1
v
Generate Actual l fdd " Edit H Delete H Print I [

Exit Il

Add a new ent

1.

rojection

Click “Add"” button and enter the relevant information:-

Branch

Department : Compulsory entry. Identify the department for the recruitment. (New
department data can be created in HR Department > Miscellaneous Files
-2 Department)

Job Title

Plan

: Compulsory entry. Select the destination branch in planning the manpower.
(New branch data can be created in HR Department > Miscellaneous Files

- Branch)

: Compulsory entry. Specify the job title or position proposed for the branch and
department. (New job title data can be created in HR Department >

Miscellaneous Files > Job Function)

: Specify the number of job allocation planned.

2. Click “Save” button to store the details.

To assess and compare the manpower utilization

1.

Click “"Generate Actual” button to retrieve the existing available manpower. Headcount of
existing employee in the particular job title under the respective branch and related department

will be shown in the column labeled “Actual’.

Difference = Actual - Plan

If Difference = 0, the actual number of employee is equal the planned figure, neither exceed

manpower projection nor under-resourced.

If Difference = +ve, the actual number of employee is more than the planned figure, which is a

case of resources surplus.

If Difference = -ve, the actual number of employee is less than the planned figure, which is a

case of resources shortage.
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2. Select “"Print” button to print out the Manpower Plan vs Actual Report.

3. Otherwise, click “Exit” button to quit this module.

Note:
1. Staffs who resigned from the company will not be calculated as actual number of
employee.

2. Branch and Department are compulsory input fields. Therefore, it is advisable for user
to create a branch and department code even though the company is a small size
organization which does not has branches or multiple departments.

3. If user is planning new recruitment for an existing department, select “Generate Actual”
button first to retrieve current available manpower data, then click “Edit” button to make

the necessary planning.

1.5 Budget

Menu Location: HR Department > Budget

Description: This option facilitates user to estimate and project budget of employees’ salary and
training cost for every department within the year. There are two types of budget plan, one is salary
plan and another one is training plan.

Salary Budget Plan

** Budget Plan Maintenance @

Year | zond | Type SALARY

Department HE HUMAN RESOURCE

Total Amount @ Plan | 4000. 00

Total Amount @ Actual 3100.00

Tvpe Year Dept, Code Depk. Description Plan Actual Actual - HRDF |

SALARY  |2003|ADMIN ADMINISTRATION 1000.00 720.00 0.00

SALARY 2003 |HE HUMAN REZO0UERCE 3500.00 2800.00 0.00

SALARY 2003 |MRET MARKETING 10000, 00 2000, 00 0.00

SALARY  |2003|RsD REZEARCH & DEVE] 5000.00 4000.00 0.00

SALARY Z004(ACCT ACCOUNTS 3500.00 4000, 00 0.00

SALARY  |2004|MRKT MARFETING 5000.00 3700.00 0.00

SALARY 2004|RsD REZEARCH &« DEVE] L000.00 4400, 00 0.00

TEATNTNG (2003|ACCT ACCOUNTS 500.00 50.00 0.00

TRAINING |2003|ADMIN ADMINISTRATION 500.00 g67. 50 130.00

TEAINING (2003 |HE HUMAN REZO0UERCE 1500.00 0.00 0.00 w
[ add ” Edit " Celete “ Prink ] [ Exit ]

1. Click “"Add"” button to insert new budget projection item. Enter the relevant information:-

Year : Year for the budget plan.
Type : Select SALARY.
Department : Specify the targeted department for salary budget projection.

Total Amount: Plan : Estimate the salary cost in planning.

2. Click “Save" button to update the details.
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Whenever there is new employee recruited by the particular department or salary adjustment
within the year, the system will update the overall effective salary figure in the column labeled
“Actual'. The column labeled “Actual — HRDF' is always zero because it is not applicable for

salary plan.

Training Budget Plan

1.

Page 44 of 223

** Budget Plan Maintenance E

Year , 2004 | Tvpe TRAINING

Departrment HR HUMAN RES0URCE
Total Amount @ Plan | lz00.00
Total Amount : Ackual 310.00 Training- HRDF Deducted 210.00
Type ¥ear Dept, Code Dept, Description Plan Actual Actual - HRDF ~
TRATNING |2003 (MEET MARFETING Z000. 00 §7.50 §7.50
TRATNING [2003|RsD RESEARCH & DEVE] 3000. 00 2175.00 1175.00
TRATNING [Z2004|ACCT ACCOUNTS 500. 00 2910.00 1310.00
TRATNING | 2002 ADMIN ADMINTATRATION 1000, 00 Q.00 0.00
TRATNING
TRATNING [Z004|MRET MAREETING 500. 00 250.00 250.00
TRATNING [2004|RsD REZEARCH & DEWVEI] 3000. 00 2910.00 1310.00

»

l Add " Edit " Delete " Print l ’ Exit Il

Click “"Add"” button to insert new budget projection item. Enter the relevant information:-

Year : Year for the budget plan.
Type : Select TRAINING.
Department : Specify the targeted department for training budget projection.

Total Amount: Plan : Estimate the training cost in planning.

2. Click “Save" button to update the details.

3.

“Actual’' column will display the proportional cost of training incurred by each department.

“Actual — HRDF' column will display the proportion amount contributed by Human Resources

Development Fund for individual department.

Actual = Course Fee + Other Expenses
Actual — HRDF = Actual — HRDF Claim

Remark:

- Training - Training Program

Course Fee, Other Expenses and HRDF Claim are extracted from module HR Department
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Note:
1. For “Actual’,
i. if amountis zero,
- budget planned but no training; or

ii. if amountis not zero,
- training conducted and expenses incurred

2. For “Actual — HRDF,
i. if amountis zero,
- training expenses contributed from HRDF

ii. if amountis not zero,

HRDF

- budget planned, training conducted but no expenses incurred

- actual training expenses paid by company after deduction from

7

1.6 Tip

This module consists of 3 sub-menus.

To create and setup the tip scheme details, go to HR Department 2> Tip > Tip Scheme,

explanation notes as per chapter 1.6.1

To assign each job title with different tip scheme, go to HR Department > Tip > Default Tip

Scheme, explanation notes as per chapter 1.6.2

To determine total value for tip distribution and recipient groups of employees, go to HR

Department > Tip > Tip Value, explanation notes as per chapter 1.6.3

1.6.1 Tip Scheme

Menu Location: HR Department > Tip > Tip Scheme

Description: This option enables users to create/setup different tip scheme with a detailed tip
scheme structure to apply to different group of employees. Users may define to apply each tip

scheme before or after the employee’s confirmation.

** Tip Scheme Code Maintenance @

Scheme Code [ TCOL
Description | FOR MANAGEMENT LEVEL
Apply Skatus Eefore Confirmation
Remark [
cheme Code Description Apply Status | #
TEOz FOFR. NON-MANAGEMENT LEVEL After

w

T

1. Click “"Add” button to create a new scheme.
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2.

6.

8.

Enter the relevant information:-

Scheme Code : Create an abbreviation code for each scheme (not more than 4 characters)

Description : Define the scheme code with details not more than 50 characters.

Apply Status : Specify the scheme is to be applied before or after the employees’
confirmation to the job (select either Before Confirmation or After
Confirmation).
Status selected will affect the effective date to calculate the tip
point/amount for the respective employees. Please refer to explanation in
chapter 1.1.3

Remark : Any additional notes or explanation pertaining to the scheme’s status.

Click “Save" button to store the information.

Point to the newly created scheme code, select "Add/View Detail” button on the left of the
module.

At Tip Scheme Detail Maintenance sub-menu, click "Add” button.

** Tip Scheme Detail Maintenance g|

Scheme Code TCOL

Description | FOR. MANAGEMENT LEVEL

Length of Service in Mankh From . 12 To < | 24
Ma, of Paint [ Amount [ 15.00000

onth From Manth Ta < Paint [ Armount ~|
o] 12 10. 00000

b

Then, classify the category by entering number of months in both fields Length of Service in
Month From and To. And, specify the number of point or amount for each range of months.
This will determine the default value earned by each employee based on their length of service
with the company.

In the example screen shown, the employees who have joined the company up to the 11 month
period, he/she will be entitled for 10.00000 tip point/amount. From 12 to 24 months length of
service, he/she will be entitled for 15.00000 tip point/amount.

Next, click “Save” button to update the details. Click *"Add” button again if there are more
details to be maintained. Repeat step 5 to 7.

If there are no more details to define, select “Exit” button to quit this sub-menu.
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1.6.2 Default Tip Scheme

Menu Location: HR Department > Tip - Default Tip Scheme

Description: This option facilitates users to setup tip scheme by assigning different scheme to
different job title. By doing so, the system will recognize the tip scheme entitlement for the
particular employee based on the job title appointed to him/her during employee’s personnel
file maintenance.

** Default Tip Scheme @
Job Code ACO1
Job Title ACCOUNTS MANAGER
Tip Scheme :-
Code TCOL
Description FOR MANAGEMENT LEVEL
ﬁob Code  (Job Title Scheme Code Ll
ACOZ ACCOUNTS OFFICER TCOZ
ACO3 ACCOUNTS CLERE TCOZ
ADOL ADMINISTRATION MaNAGER TCOLl
AD0Z GENERAL CLERE TCOZ
AD03 RECEPTIONIST TCOZ
Canl CUSTOMER SUPPORT MANAGEER TCO1
Canz CUSTOMER SUPPORT OFFICER TCOZ
HEO1 HIMAN REIZ0URCE MaNAGER TCOLl
HROZ HUMaN FEZ0URCE OFFICER TCOZ
MEOL MARFETING MANAGER TCOL
PRO1 PURCHASTING MANAGER TCO1
PROZ PURCHASEE. TCOZ b
[ Edit ” Prink ] [ Exit ]

All job titles created in HR Department > Miscellaneous Files > Job Function will be listed in
this module. To assign a specify job title with a particular tip scheme,

1. Select a particular Job Code from the table. Click “Edit” button.

2. Atthe field Tip Scheme Code, click the arrow down button to select the relevant tip scheme.
This code selected refers to the detailed tip scheme created in HR Department > Tip > Tip
Scheme (refer chapter 1.6.1)

3. Click "Save"” button to confirm the scheme assigned for the particular job title.

4. Proceed to the next job title record and complete the scheme assignment process. Repeat step 1
to 3.

5. Click “Exit” button to quit this module.

1.6.3 Tip Value

Menu Location: HR Department >Tip > Tip Value

Description: This option facilitates users to define total value to be distributed among groups of
employees. The system will calculate the employees’ tip amount based on the value and criteria
defined by user in this module.
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** Tip Value Maintenance g]
Date From 01/06/2004 Date To | a0/05/2004
Total Yalue 2600, 00000 Total Yalue Per Point Z0.00000
Mo, of Paint: 130.00000
Payroll Type lat & 2nd Half Payroll
Remark
Applicable to :-
| ip gcheme. Code Descriptiﬁn .T.ick, if applicable A
R |
TCOZ FOR. NON-MANAGEMENT LEVEL
| v
Date From Date To Total Yalue Mo, of Point Remark S

01/01/2004|31/01/2004 1500. 00000 Accumulated
0l/02/2004|29/02/2004 1200.00000Accumulated
01/03/2004|31/05/2004 1500.00000Accumulated
01/04/2004|30/04/2004 1550. 00000 Adccumulated
01/05/2004|31/05/2004 1300.00000 Accumulated

01/07/2004|31/07/2004 Z0. 00000 1.00000

N L ke
I Add " Edit " Delete " Print ] I Exit ]
1. Click “Add” button to define a new formula.
2. Specify the tip utilization period Date From and Date To.
3. Enter the tip’s Total Value.
Date From 0l/06/2004 Date To 3070672004
Total Yalue 2600, 00000 Total Yalue Per Point Z0. 00000
Mo, of Point 130.00000 | [¥] Tatal accumulated employees points
Payroll Type lat & 2Znd Half Payroll hd
Remark
Applicable to - Employess withaut tip scheme assigned Tick &ll
Tip Scheme Code Description Tick, if applicable |
v |
TCOZ FOR NON-MANAGEMENT LEVEL v
v

4. Tick the checkbox labeled * Total accumulated employees points'.

Tokal accumulated employees points

5. Then, user must specify the source of employees’ points by ticking the relevant group(s) listed in

the table.
Mip Scheme Code Description Tick, if applicable =
TCOL FOR MANAGEMENT LEVEL W
" v |

6. If user wants to include those employees without any tip scheme assigned at respective
Employee Personnel File Maintenance, tick the checkbox labeled “ Employees without tip
scheme assigned’.

Emplovees withouk tip scheme assigned

In the sample shown above, 130 points is accumulated from three categories of employees,
including those employees classified under tip scheme code TC01 and TC02, as well as other
employees without any particular tip scheme assigned.

7. The formula for value per point is:
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Total Value
Total Value Per Point = ---------------------
No. of Point

8. Next, specify the Payroll Type of salary processing method as 1 Half Payrol, 2" Half Payroll or
1t & 2 Half Payroll.

9. Enter Remark for any additional note, if any.

10. Click “Save” button to update the details.

Alternatively, if users are using fixed value to calculate, follow these steps:-
1. Click "Add” button to create the formula setup.

2. Specify the tip utilization period Date From and Date To.

Date From 01/07/2004 Date To 3170772004

Total value 10. 00000 Tokal Yalue Per Point 10. 00000

Ma. of Poink 1.00000 | []Tokal accumulated employvees poinks

Payraoll Type lst & 2Znd Half Payroll v

Remark

Applicable o :- Employees without: tip scheme assigned
Mip Scheme Code Description Tick, if applicable |

v |

TCOZ FOF. NON-MANAGEMENT LEVEL v

3. Enter the Total Value and No. of Point.
In the sample shown above, under the fixed value method, 1 point is equal to a value of 10.
For instance, if an employee is entitled 20 point for the month of July 2004, this employee will
earned 200 in value. If another employee is entitled 35 points for the period, he/she will has 350
in value, and so on.

4. DO NOT tick the checkbox labeled * Total accumulated employees points".

5. But, user must specify the calculation is to be applied to which group of employees. Tick the
checkboxes listed below column named " Tick, if applicable’ for the relevant tip scheme code
or include those employees without tip scheme assigned.

6. Specify the Payroll Type.

7. Enter Remark if necessary.

8. Click “Save” button to update the details.

Note:

1. To view and verify the employees’ tip amount, go to Report 2 Tip > Employee Tip
Amount Report. This report will display tip amount earned by each employees for a
specified period of time.

2. UBS HRMS allows users to define the tip calculation method. Go to Housekeeping >
Setup > General Setup - Tip (2) to perform the necessary setup. Please refer to
chapter 6.1.1 for more details and examples of calculations.
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1.7 Miscellaneous Files

It is advisable to begin the operation of the system by creating the necessary prerequisite data
before proceed to manage the human resources and other activities.

There are 5 typical button operations that can be performed for maintenance of miscellaneous files.

| add || Edit ” Delete || Prink || Ezxit |

Select “"Add” button when user wants to create a new record.

Select “Edit” button when user wants to modify description, content or details of the existing records,
except the data code itself.

Select "Delete” button when user wants to remove or delete the entire data records. However,
records used in another table will not be allowed to delete from the system.

Select "Print” button when user wants to preview or print out the record listing.

Select “Exit” button to quit the particular module.

= g

’ Print ] [ Presiew ] l Eile ]

’Cgstnmize] [ Printer ]

Default Printer: %4UBS-SER¥ER'HP LASERJET 1100 {MS)

Print options

Print : send the file to printer to make a printout
Preview : view the actual report on screen

File ! generate a text file

Customize: open to view or customize report format
Printer : select the name of the printer to be used

1.7.1 State

Menu Location: HR Department > Miscellaneous Files > State
Description: This option enables user to maintain the state of a country.
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** State Table X
Stake Code | JH |
Description | JOHOR |
Etate Code Descripkion 4‘_\
KD KEDAH
KL KUALL LUMPIR
KN KUANTAN
KT EELANTAN
ME MELAKA
PE PERLAE,
PG PENALNG
PH PAHLNG
FE. PERLIS b
| add ” Edit || Delete ” Prink | | Exit
State Code : Specify the state with an abbreviation

code not more than 4 characters.

Description : Define the state code
(maximum 15 characters)

1.7.2 Race

Menu Location: HR Department > Miscellaneous Files > Race

Description: This option enables user to maintain different races exist in a nation, other than
Chinese, Indian or Malay.

** Race Table &|

Race Code i C |

Description | CHINESE |

Eace Code Descripkion e I

I INDIAN
i) MALAY
] OTHEER

| add ” Edit || Delete ” Erint || Exit l

Race Code : Specify the race with one single character.

Description : Define each race with not more than 15
characters.
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1.7.3 Religion
Menu Location: HR Department > Miscellaneous Files > Religion

Description: This option enables user to define types of religion for the employees, other than
the existing religion record in the database such as Buddhism, Christianity, Hindu or Islam.

** Religion Table

Religion Code 'B
Description |BUDDHISH
?"E’éi{g’{an Code  Description A
| |t CHRISTIANITY
| |1 HINDUISH
| I I5LAM
0 OTHEE
v 1|
| add || Edit ” Delete || Print ] [ Exit |
Religion Code : Specify the new religion type with an
abbreviation code not more than 2
characters.
Description : Define each religion with not more than 15 characters.

1.7.4 Transport

Menu Location: HR Department > Miscellaneous Files > Transport

Description: This option enables user to classify mode of transport possess by the employees.
Certain company provides transportation benefit for their staffs, such as car, bus or
motorcycle. This option enables user keeping track of employees who are entitled for these
benefits and thus making the necessary arrangement like issue of car sticker or vehicle pas to
the employees concerned.

** Transport Table

Transport Code I Es

Descripkion . EUS

ransport Code  Description sl |

e CAR
eSS MOTORCYCLE
E VAN

|

T T T
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Transport Code : Specify the mode of transport with not
more 2 characters.

Description : Define each transport mode with not more
than 15 characters.

1.7.5 Branch

Menu Location: HR Department > Miscellaneous Files > Branch
Description: This option enables user to maintain numerous company locations for
organization with network of branches.

** Branch Table g]
Branch Code |BaHL
Descripkion JOHOR. BRANCH
- Eranch- C-oEle ; Déscr-iﬁtinn |
EED1 FEDAH BRANCH
EEL1 MAIN ERANCH EL
EELZ EL-TUE3 BRANCH
BEL3 EL-PJ EBRANCH
EET1 FELATAN ERANCH
EME1 MELAKAL EBRANCH
EPG1 PENANG EFANCH
EFH1 PAHANG BRANCH
| [BPR1 |PERAK BRANCH ~|
[ Add H Edit H Delete ” Prink I [ Exit: ]

Branch Code : Assign each branch with an abbreviation
code not more than 4 characters.

Description : Define the branch code with its name.
(maximum 15 characters)
1.7.6 Department
Menu Location: HR Department > Miscellaneous Files > Department

Description: This option enables user to classify the functional departments available in the
organization.

** Department Table

Deparkment Code . ACCT
Depattrnent Marne | accounTs
[ epk, Code Dept, Mame A';
| |ADMIN ADMINISTRATION
| |cs COSTOMER SUPFPORT
| |HR HUMAN RESOURLCE
| |MRET MARFETING
| |PURC PURCHASTING
| |ac QUALITY CONTROL
| |R&D FEZELRCH & DEVELOPMENT
|
[ add " Edit “ Delete ” Erint ] [ Exit ]
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Department Code : Assigh each department with different
identity code not more than 10
characters.

Department Name : Define the name of each department.
(maximum 30 characters)
1.7.7 Line No.
Menu Location: HR Department > Miscellaneous Files > Line No.

Description: This option enables user to setup, extend and segregate large operational area
into smaller functional units, especially in a production environment.

** | ine Mo. Tahle

Line Mo | PRODL
Descripkion ;PRI:IDT.TCTIEIH LINE 1
. Line Mo, Descripkion /_\ |
Csl CUSTOMEE. SUPPORT GROUP 1
Cs2 CUSTOMEE. SUPPORT GROUP 2
PRODZ PRODUCTION LINE 2
Qcl QUALITY CONTROL GROTE 1
Qce QUALITY CONTEOL GROUE 2
ED1 BsD GROUP 1
ED2 BsD GROUP 2
S4LES1 SALES GROUP 1
| |SALESZ |SALES GROUP Z |
[ Add " Edit " Delete " Prink ] l Exit ]
Line No. : Assign different line with an unique

number not more than 10 characters.

Description : Define each line number with details
not more than 40 characters.

Note:
Records maintained in this module will be shared with UBS
Payroll System if there is integration between both systems.

1.7.8 Category

Menu Location: HR Department > Miscellaneous Files > Category

Description: This option enables user to setup, classify, divide or differentiate multiple sections
into group of its own. For example, categorization based on product type or range, working
shift, factory plant, line position or operation level.
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** Category Table

Category Code | C31CUR
Descripkion ;CT.TSTEII'IER SUPPORT GEOUP 1 CURRENT PRODUCT
E;ategcury tuﬂé .Déscriﬁtiun |
C3LNEW CIOSTOMEER, SUPPORT GROUP 1 NEW PERODUCT
C3ZCUR CUOSTOMEER, SUPPORT GROUP 2 CURFENT PRODUCT
CA3ZNEW CUOSTOMEER, SUPPORT GROUP 2 NEW PRODUCT
QCLCUER QUALITY CONTEOL GEOUP 1 CURRENT PREODUCT
QCLNEW QUALITY CONTEOL GROUP 1 NEW PRODUCT
QCZCUER QUALITY CONTEOL GEOUP 2 CURRENT PRODUCT
QCZNEW QUALITY CONTEOL GROUP 2 NEW PRODUCT
EDICTER F&D GROUP 1 CURRENT PRODUCT

| |RD1NEW |RsD GROUP 1 NEW PRODUCT ~||

l Add " Edit " Delete " Prink l I Ezxit l

Category Code : Assign each category with an abbreviation
code not more than 10 characters.

Description : Define the category with detail not more
than 40 characters.

Note:
Records maintained in this module will be shared with UBS
Payroll System if there is integration between both systems.

1.7.9 Job Status

Menu Location: HR Department > Miscellaneous Files - Job Status
Description: This option enables user to identify and indicate the employees’ job status as part
time or contractual basis; management, executive or clerical group level, etc.

= Job Status Table X
Job Status Code . CL
Description | CLERICAL
| Fob Status Code Déscriptinn -
CT CONTEACT
Ex EXECUTIVE
ME MANAGEMENT
aT OTHER.
PR PROFESATONAL
PT PART TIME
bt )
[ Add ][ Edit ][ Delete ][ Print ] [ Exit I

Job Status Code : Assign each status with an abbreviation
code not more than 2 characters.

Description : Define the job status with detail not more
than 20 characters.
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1.7.10 Job Function

Menu Location: HR Department > Miscellaneous Files > Job Function
Description: This option enables user to specify job description and identify its main duties
and responsibilities assigned by the management for particular job title or position.

** Joh Function Table EI
Job Code ACOL
Job Title ACCOUNTS MANAGER
Job Function
1. FESPONSIBLE FOR ALL FUNCTIONS IN ACCOUNTS 4
| DEPARTHENT.
2. FEPORT TO MANAGING DIRECTOR.
W
i'-:.b Code  Jab Title A
ACDZ ACCOUNTS OFFICER
ACO3 ACCOUNTS CLEEK
ADD1 ADMINISTRATION MANAGER
ADDZ GENEEAL CLERE
ADO3 RECEPTIONIST
£501 CUSTOMER SUPFORT MANAGER
£s02 CUSTOMER SUPPORT OFFICER
HRO1 HUMAN FESOURCE MANAGER
BETE HUMAN RESOURCE OFFICER b
’ Add H Edit ” Delete Search H Print I ’ Exit ]
Job Code : Assign each job with an abbreviation code

not more than 4 characters.

Job Title : Identify the job code with full title not more
than 30 characters.

Job Function : Define the job title’s duties and
responsibilities.

1.7.11 Skill Category
Menu Location: HR Department > Miscellaneous Files > Skill Category

Description: This option enables user to setup different skills and classify them according to
same genre or characteristics in functional and operational mean.
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** Skill Category Maintenance

Skill Categary Code ol

Description GENERAL

i kill Category Code Description -‘\:

|02 GOVERNMENT LAWS

|03 INFORMATION TECHNOLOGY

|04 LANGITAGE

| |05 MANAGEMENT

| |06 MARFETING

[ o7 OTHER

|05 QUALTTY ASSURANCE

| |09 SAFETY & HEALTH

| ol
’ Add ][ Edit ” Delete ” Print I[ Exit l

Skill Category Code: Define type of skill subject group with
detail not more than 25 characters.

Note:

Skill Category created and defined in this module will be used in
HR Department > Miscellaneous Files - Skill Code (will be
discussed in next chapter 1.7.12)

1.7.12 Skill Code

Menu Location: HR Department > Miscellaneous Files > Skill Code
Description: This option enables user to define different levels of skill or intelligence, capability
and ability for the employees according to the same related category group.

** Skill Code Maintenance g]
skill Code 5C0L
Descripkion :SHDRT HAND
Skill Cateqgary | GENERAL
[ -kiII Code  Description Skill Zategory |
SC02 TYPING GENEEAL
SC03 ENGLISH LANGUAGE LANGULGE
SC04 MANDARIN LANGUAGE LANGULGE
SCO5 JAPANESE LAWGUAGE LANGULGE
SCO6 SAFETY GUIDE SAFETY & HEJ]
SC07 LABOUE. LANS GOVEENMENT 1
SC085 INDUSTRIAL RELATION REGULATIONS FOVEENMENT 1
SC09 OCCUPATIONAL SAFETY AND HEALTH GOVERNMENT 1
_|#Cla MARFETING SEILL MARKETING ]|
[ add " Edit " Delete ” Print ] [ Exit l
Skill Code : Assign each skill with an identification

code not more than 5 characters.

Description : Define the skill code with detail not more
than 50 characters.
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Skill Category : Click on the arrow down button to allocate
the particular skill item into the appropriate
skill category.

Note:

Skill Code created in this module will be used directly in HR
Department - Employee - Skill > Employee Actual Skill, as
per chapter 1.1.9.2

Skill Code is also the requirement data for maintenance setup in
HR Department > Miscellaneous Files > Skill Requirement - -
> Add/View Skill Code, which will be discussed in next chapter

17.13
[~

1.7.13 Skill Requirement
Menu Location: HR Department > Miscellaneous Files > Skill Requirement
Description: This option enables user to assign and assemble various skills required for
respective group of employees or job title.

Firstly, identity the group of employees, eg. managers, unit leaders, clerical clerks, officer etc.

Then, setup the required skill code. For instance, what are the knowledge, experience and skill
requirement for each group of employees. It can be multiple choices of skill required.

Next, assign the required skill rating for all the skills, whether they are of high priority or least
important rating.

Information setup in this module will be applied in HR Department > Employee > Skill >
Employee Skill Requirement.

Please refer to chapter 1.1.9 for more details.

** Skill Requirement Maintenance

Skill Requirement Coda 3606

Description FOR HE MANAGER
Skill Requirement Code Description A
SG0OL FOF. ALL MANAGERS
SG0Z FOR. FOXPRO PROGERAMMERS IN RsD
5G03 FOF. Y& PROGRAMMERS IN RsD DEPT
5604 FOR ALL RsD 3TAFF
5605 FOR. ALL CLERKS
5607 FOR. BRANCH MANAGER & SALES ExE
5608 FOR. FEOJECT MANAGERS
5609 FOR. RsD MANAGER
_[s610 FOR LEADERS v

l Add ” Edit “ Delete " PBrint ]l Exit l

1. Click on the “Add” button and enter the relevant information.

Skill Requirement

Code : Identify employee group with an
abbreviation code not more than 5
characters.
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Description : Define the group with description not
more than 50 characters.

Click “Save” to store the record created.

At the same record, select and click “"Add/View Skill Code” button and you will be

prompted with another menu.

In Skill Requirement Detail Maintenance menu, click on the “"Add” button to insert

new skill code for the particular group.

Skill Code : Click on the arrow down button to
select the necessary skill.
(New skill code can be maintained in
HR Department > Miscellaneous
Files > Skill Code)

Description : Definition of the skill code selected.

Skill Category : The related skill category group.

Skill Rate : Determine the required rating for
(Required) each specific skill, eg. 0=lowest and

least demanded, 9=highest and
compulsory.

** Skill Requirement Detail Maintenance

Page 59 of 223

Skill Fequirement Code | 3606

Attention: Skill rate from O [lowest] to 3 [highest]

M

Description FOR. HE MANAGER

Skill Code §C15 v

Description HUMAN FESOURCE MANAGEMENT

Skill Category MANAGEMENT

Skill Rate [Requied) g

Skill Code Description Skill Category Skill Rate
3C07 LAEOUR LAWE GOVERNMENT LAWS b
SCO05 INDUSTRIAL RELATION REGULATIONS GOVERNMENT LAIS 7
3C09 OCCUPATIONAL 3AFETY AND HEALTH GOYERNMENT LAWS 7
SC12 MANAGEMENT SEILL MANAGEMENT G

Save LCancel

b

Then, click “Save” button to update the skill code into the requirement group.

Click “Add"” button again to insert new skill or “Exit” button to quit Skill Requirement

Detail Maintenance menu.

Lastly, click “Exit” to quit the module.
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1.7.14 Leave Type

Menu Location: HR Department > Miscellaneous Files - Leave Type
Description: This option shows the default 14 leave types available in the system. They are all
not editable.

** | eawe Type Listing

eave Code Description
h |
ATy Advance Leawve
AL Annual Leave
CL Compassionate Leawve
CP Compensation Leawve
EN Emergency Leawve
EX Examination Leawe
HL Hoszpitalisation
julls Gick Leawe
MR Marriage Leawe
uT Maternity Leawve
HF Non Pay Leawe
PT Paternity Leawve
D Ghut Dowm
| Prink |[ Exit l

1) Absent (AB)
- where an employee did not turn up to work & without any reason

2) Advance Leave (AD)
- where an employee has no more claimable or entitled Annual Leave but still want to apply
leave utilizing his next year’s Annual Leave

3) Annual Leave (AL)
- paid leave that an employee is entitled

4) Compassionate Leave (CL)
- type of leave granted such as funeral attendance upon death of parents, wife or husband,
grandfather/mother, children or other immediate family

5) Compensation Leave (CP)
- type of leave granted as substitution, eg. when someone has worked on his rest day

6) Emergency Leave (EM)

- when employee has to take in a short notice, eg. taking leave on the day which he could not
come to work

7) Examination Leave (EX)
- type of leave granted for employee who is going to sit for an examination (academy)

8) Hospitalisation (HL)
- type of leave for those who has been hospitalized for medical treatment

9) Sick Leave (MC)
- leave entitled after examination done by a registered medical practitioner where no
hospitalisation is necessary

10) Marriage Leave (MR)
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- type of leave granted for those who has just being married

11) Maternity Leave (MT)
- type of leave for female employee who temporarily leaves her job upon confinement (giving
birth)

12) Non Pay Leave (NP)
- type of leave to be applied when an employee has fully utilized his/her paid leave entitlement

13) Paternity Leave (PT)
- type of leave for male employee who temporarily leaves his job upon his wife’s confinement
(giving birth)

14) Shut Down (SD)
- number of days whereby the factory/plant stop production/operation for maintenance work due
to some specific reason, eg. natural disaster

User may print the Leave Type Listing by clicking on the “Print” button.

1.7.15 Leave Scheme

Menu Location: HR Department > Miscellaneous Files > Leave Scheme

Description: This option enables user to setup and maintain the leave scheme for different
group of employees. The scheme can be sat based on different category of job position, level
or department. User may setup multiple leave schemes to define total number of leave days
entitled for different range of employment service years for various leave types.

** | eave Scheme Code Maintenance E|
Scheme Code L3501
Dezcription FOR MANAGEMENT LEVEL
b aw. AL CAF 5.0
Scheme Code  Description kaw. Al CAF -
| [L302 FOR. NON-MANAGEMENT LEVEL 3.0
| |L303 FOR CONTRACT & PART TIME STAFF 0.0

W

T (T T T T

1. Click “"Add” button and enter the relevant information.

Scheme Code : Assign each scheme with an unique
code not more than 4 characters.

Description : Define the scheme with detail not
more than 50 characters.

Max. AL C/F : Specify the maximum annual leave
in number of days(can be a half day)
allowed to be carried forward to the
following year for the particular
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scheme.
2. Click “"Save"” button to store the record created.

3. Under the particular scheme code, click on the “"Add/View Detail” button and you will
be prompted with another menu.

** | pave Scheme Detail Maintenance

Scheme Code 'LSDl || FOR MANAGEMENT LEVEL
Leave Code jAL Annual Leawve
Apply Status | ot
Frorata for Mewly Join Employes | ez
Length of Service in Year Day Entitled
R EY
Z.0 to < 5.0 15.0
5.0 to < 99.0 22.0
|
Leave Code |Deszcription Apply Statuz Frorata ||
AF Ahzent Eefore Confirm |No
AD Advatice Leawe Eefore Confirm |No
|
CL Conpaszsionate Leave Eefore Confirm |No
CP Compensation Leawe Eefore Confirm |No
EN Emergency Leawe After Confirm |Yes
Ex Examinaticn Leawe After Confirm |No
HL Hospitalisation Before Confirm |No
HC 3ick Leawe Eefore Confirm |Yes
HE. HMarriage Leawe Eefore Confirm |No w
I« >
[ Add ” Edit “ Delete ” Frrint ] l E it l

4. Notice that the Leave Scheme Detail Maintenance menu has a default template with
all predefined leave codes and suggested values.

5. Scrolling upward and downward using the side scroll bar will reveal the details of the leave
scheme, such as apply status, prorated or not, number of leave days entitled for different
length of service in year.

6. To modify the existing leave details, select the respective leave code and click Edit”
button.
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2 | eave Scheme Detail Maintenance

Scheme Code | L0l FOR MAMNAGEMENT LEVEL
Leave Code | AL |Anrmmal Leawe

Apply Status After Confirmation
Prarata far Mewly Join Employee Yesz w

Length of Service in Year Day Entitled

III {

|“- Inzert
2.0 to < 7.0 12.0
7.0 to € 5.0 15.0 Madify
3 Remaove
Leave Code Description Apply Status Prarata. |
AF Ahzent Eefore Confirm (HNo
AT Advance Leawve Before Confirm (No
v |
CL Conpassionate Leave Eefore Confirm (Ho
CP Conpensation Leawve Before Confirm (No
EM Emergency Leawe After Confirm |Yes
HL Hospitalisation Eefore Confirm (Ho
MC Sick Leawe Before Confirm |[Yes
ME. Marriage Leawe Eefore Confirm (No
T Maternity Leawe Eefore Confirm (Ho “
< »

LCancel

Specify Apply Status of the particular leave code whether the leave is to be applied
Before Confirmation or After Confirmation.

Specify the Prorata for Newly Join Employee. Select * Yes” if the number of leave day
is to be calculated in proportion to 12 months period for newly recruited staffs. Select
“No" if the number of leave day (in a year) for particular type of leave entitled for new
employees are the same, regardless when was the month he/she joined the company.

To insert another additional leave details, select “Insert” button. Enter the relevant
number of years in service and number of leave days entitled. Click "OK" button to save
the record.

** | eave Entitled Day

Length of Service in Year Day Entitled
lS.D. ko < 99.0 24.0)|
Ok ][ Cancel

Click “Save” button to update the record into the particular leave scheme.

If you want to amend any record in the leave scheme details, select the affected leave
code and click “Edit” and then “"Modify” or "Remove” button to make the changes.
Remember to confirm the amendment done by selecting "OK” and then “Save” button at
the end of process.

After confirmed all details are correct and in proper order, click “Exit” button to quit the
leave scheme detail maintenance menu.

Lastly, click “Exit” to quit this module.
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Based on the system default 14 types of leave codes (as per section 1.6.14 HR Department >
Miscellaneous Files - Leave Type), the following is the summary table of initial setup status for each
leave code. User may use this table as a guideline to modify and change the content of the respective
leave code to accommodate their needs with regard to the company’s practice as well as the related
legislation.

Template/Default value preset in the System

Leave Code AB | AD |AL [CL |[CP | EM | EX
User Editable

System Recommended
Value *

N
N
Unlimited Value Y
B
N

Apply Status (on
Confirmation)

Prorata for New Employee

2 © |<| 2 |<
2 © |<| 2 |<
<| » |2 < |2
2 ©m |<| 2 |<

Leave Code HL|  MC | MR |MT | NP | PT | SD
User Editable

System Recommended
Value *

Y
Y
Unlimited Value N
B
Y

Apply Status (on
Confirmation)

Prorata for New Employee

<l w |z < |=<
<| m |zZ] < |=<
z| w |[<| =z |z
z| m |<| =z |<
z|l w |<| =z |z

Legend:
Y = Yes A = After Confirmation
N = No B = Before Confirmation

Remark:
* If yes, the value (in number of days) is provided by the Employment Act and Regulations as per
note no. 2 & 3

Note:
1. Absent (AB), Emergency Leave (EM), Non Pay Leave (NP) and Shut Down (SD) are not editable.

2.  Annual Leave (AL), Emergency Leave (EM) and Sick Leave (MC) are categorized and assigned

accordingly with the appropriate number of leave days based on the length of service in year.
[Employment Act 1955 (Act 265) Part XIl Section 60E (1) & Section 60F (1)]

3. Hospitalisation (HL) and Maternity Leave (MT) was assigned with a maximum 60 leave days,
regardless the length of service in employment.
[Employment Act 1955 (Act 265) Part Xll Section 60F (bb) & Part IX Section 37]

4. Inthe table illustrated earlier, if the column for Unlimited Value is “Yes”, it means that the system is
using the greatest possible figure of 99 years in employment and 999 leave days entitlement. In other
words, there is no restriction in number of leave days entitled for all levels of employment service year.

5. As recommendation, Annual Leave (AL) and Emergency Leave (EM) are to be applied “After
Confirmation”.

6. As an exceptional case, Advance Leave (AD)’s Apply Status is fixed as “Before Confirmation” and
does not allow user modification.

7. Annual Leave (AL), Emergency Leave (EM), Hospitalisation (HL), Sick Leave (MC) and Maternity
Leave (MT) are initially set as “Yes” status in Prorata for Newly Join Employee.
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1.7.16 Claim Code

Menu Location: HR Department > Miscellaneous Files > Claim Code

Description: This option enables user to maintain different categories of claim type. It provides
the mechanism to integrate the database with UBS Payroll System. Total claim amount for
each claim type will be total up and updated to the Payroll System when user performed
import/export function. User must specify the link number to be grouped into the UBS Payroll
System. There are total of 17 columns in the UBS Payroll System'’s allowance table.

** (laim Code Maintenance

Claim Code (o1
Dezcription MEDICAL .
Claim Link Ma. 1 [Mate: Link to Payroll Allowance Table]
Ele;im Code Descrii:utiuﬁn Link Nu:u. -
0z DENTAL 1
03 PETROL 2
04 CAR MAINTENANCE 3
05 OUTSTATION 4
oG PHONE 5
07 PARKING FEE 6
0g MEAL 7
e ENTERTAINMENT g
| |10 |BRIDGE TaG/HIGHWAY 9 v
l Add " Edit " Delete " Prrirt ] I E uit ]
1. Click “"Add” button and enter the relevant information.
Claim Code : Assign each claim code with an identification code not more

than 4 characters.

Description : Define the claim code with detail not
more than 30 characters.

Claim Link No. : Specify the column number for amount to be allocated in UBS Payroll
System. Select “"NIL" if the specific claim type will not be exported to
Payroll System. There could also be a same link no. when multiple
claims are to be grouped under the same allowance column.

2. Click “Save” button to update the record.

3. Lastly, click “Exit” button to quit this module.

1.7.17 Claim Scheme

Menu Location: HR Department > Miscellaneous Files > Claim Scheme

Description: This option enables user to setup the claim schemes and then maintain the
necessary claim codes in the respective scheme. The scheme can be categorized based on
level of position (eg. managerial or clerical) or departmental personnel (marketing and sales
or others).
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** ([ laim Scheme Code Maintenance

Scheme Code I-CSIIIl

Description FOE SALES STAFF

To add or view the claim code, click AddYiew Code Add)view Code l
“Echeme Code "bescriptiun /_\'
| |C302 FOE. NON-3ALES 3TAFF

|

[aaa || et || odes || oe | [ ewt |

1. Click “Add"” button and enter the relevant information.
Scheme Code : Assign each scheme with an unique code not more than 4 characters.
Description : Define the scheme code with detail not more than 30 characters.

2. Click “Save” button to store the record created.

3. Under the particular scheme code, click on the “"Add/View Detail” button and you will
be prompted with another menu.

4. In the Claim Scheme Detail Maintenance menu, click "Add"” button to insert a new
claim detail.

** (Claim Scheme Detail Maintenance

Scheme Code |czo1 || FOR SALES STAFF

Claim Code |03 v | ENTERTATHMENT

Max. Per Receipt _. 250, UU

Mazx. Per Year 3000.00

Remark. |ELIGIELE FOR GRADE 3 & AEOVE EXECUTIVES
:“El.ai-n.'l (EDCI; ”Ii)escr-iat_i-o.n mr-\;'iax.-l-:'er-' ﬁéc;i&"ﬂ’lak.he—r .‘."ear _J\
| |03 PETROL 200,00 2400.00 |
| |04 CAR MAINTENANCE 300,00 3600.00
| |os OUTSTATION 500,00 5000.00
| |08 PHONE 200.00 2400.00
| |07 PARKING FEE 100. 00 1200.00
| |na MEAL 50.00 £00. 00
| |10 BRIDGE TLG/HIGHUAY 200,00 2400.00
1M | |
| bl
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Claim Code : Click on the arrow down button to select the appropriate claim code.
(New claim code can be maintained in HR Department >
Miscellaneous Files > Claim Code)

Max. : Enter the maximum amount claimable
Per Receipt for each single receipt, if applicable.

Max. Per Year: Enter the maximum grand total amount claimable for one calendar
year.

Remark : Any additional note pertaining to the claim details.
5. Click "Save” button to update the claim detail into the respective scheme code.

6. If you want to insert another new claim detail, select “*Add” button again. Otherwise,
select “"Exit” button to quit the claim scheme detail maintenance menu.

7. Lastly, click “"Exit” button to quit this module. Otherwise, repeat step 3 again to input
details for another scheme code.

1.7.18 Loan Type

Menu Location: HR Department > Miscellaneous Files > Loan Type

Description: This option enables user to maintain types of loan available in the organization
and setup the default interest rate to be applied in each loan type. The interest rate will be
calculated on monthly basis.

** | pan Type Maintenance

Loan Type | LNO1

Drescription CAR LOAN - MGHT

Interast Rate [%)] L.00

Fiemark. | FOR. MANAGEMENT LEWVEL

Link Ma. 1 [Mote: Link ta Payroll Deduction T able]

Loan Tupe Descriﬁtinn Rate [%] Remark Lirk |~
L0z CAR LOAN 7.00|FOF. NON-MANAGEMENT LE|

LNO3 HOT3ING LOAN 5.00|FOFE ALL 3TAFF

Lu04 EDUCATION LOAN 3.00|FOF. ALL 5TAFF

by

T P T T P

1. Click “"Add” button to create a new loan type. Enter the relevant information.

Loan Type : Assign each type of loan with an identification code not more than 4
characters.

Description : Define the loan type with detail not more than 30 characters.
Interest Rate (% ). Specify the interest rate to be applied for the particular loan type.

Remark : Enter any additional note pertaining to the particular loan type
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Link No. : Specify the column number for amount to be posted into UBS Payroll
System. Select “N/L" if the loan type will not be exported to Payroll
System.

2. Click “Save” button to store the record.

3. Click “Exit” button to quit this module.

1.7.19 External Training Centre

Menu Location: HR Department > Miscellaneous Files > External Training Centre
Description: This option enables user to maintain information of external training centres for
ease of future reference in the event outsource training services required from the same
training centre.

** Training Centre Maintenance

Centre Code CCcol
Marme MCEE
Contack Person M, TaN
Address 32, JALAN TANJUNG EUNGAH,
10500
| PENANG.
Phone Mo, | 04-8531564
Fax Na. | 04-8979999
Email Address . MCSERHOTMATL. COM
j entre Code Mame Contact Person | A |
CCOZ CL EDUCATION CENTEE ME. CHAN
CCO3 PUTRA COLLEGE MER. 00I MENC
w
I« _ . B n
l Add " Edit " Delete ” Print: ] [ Exit ]

Centre Code : Assign an abbreviation code not more than 10 characters for each external
training centre

Name : Enter the training centre’s name.
(maximum 50 characters)

Contact Person: Enter the contact person for the training centre.

Address : Enter full address of the training centre.
Phone No. : The centre’s telephone number.
Fax No. : The centre’s facsimile number.

Email Address : Email address of the contact person or homepage of the training centre.
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1.7.20 Resource Code

Menu Location: HR Department > Miscellaneous Files > Resource Code
Description: This option enables user to setup and maintain different types of resource
materials provided by the company as a benefit to the staffs.

**> Resource Code Maintenance @

Resource Code E=01

Description HAND PHONE

Return Status TES

Remark SALES AND MAREETING STAFFS

Eesource Code  Description Return Status ~

R302 NOTEEOOE Yes

R303 LOCEER Tes

B304 UNIFORM Ho

R305 SAFETY SHOES Ho

RE06 COMPANY CAR Tes

R307 COMPANY BADGE Yes

R305 SAFETY EOOKLET Ho
| b
1< | ] >

[ add ][ Edit ][ Delete “ Prink I [ Exit l

Resource Code : Assign identification code not more than 4 characters for each resource
type.

Description : Define the resource with detail not more than 50 characters.
Return Status : Specify whether the resource is returnable to the organization.

Remark : Can be used to further describe the return status of the resource, eg. upon
employee’s resignation or under stipulated terms.
Alternatively, this column can be used to state the possible beneficiary of a
particular resource, eg. entitled specifically for sales and marketing staffs
only or all employees.

1.8 Miscellaneous Files (2)

Extended from the previous modules, these miscellaneous files facilitate users to maintain more
prerequisite data pertaining to reward, disciplinary and appraisal.

The system has default data and sample value predefined in the appraisal’s miscellaneous files (as
per chapter 1.8.3, 1.8.4 & 1.8.5). Nevertheless, users can still create new items and modify or
remove the exiting records to accommodate their own needs.

1.8.1 Reward Action

Menu Location: HR Department > Miscellaneous Files (2) > Reward Action
Description: This option enables user to maintain all possible reward actions available in the
organization. Items created will be used in HR Department > Employee - Reward &
Disciplinary (refer to chapter 1.1.6)
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** Reward Action Table

Action Code :.RDDZ

D escription

[ -.;’-‘«c:ti-:n Code |Description

iGIV’E 1 Da¥ OF COMPENSATION LEAVE

| [ronz

| [roo1 GIVE CAZH RM10O0

GIVE APPRECIATION LETTER

| [rong

INCREAZE SALARY BY 5%

| |rons

GIVE ATTENDANCE ALLOWARNCE

v

l &dd H Edit " Delete H Pririt ll E xit ]

Action Code : Assign an abbreviation code not more than 4 characters for each reward
action.

Description : Define each reward code with details of action.

1.8.2 Disciplinary Action

Menu Location: HR Department > Miscellaneous Files (2) > Disciplinary Action
Description: This option enables user to maintain all disciplinary actions practiced by the

organization. Items created will be used in HR Department > Employee > Reward &
Disciplinary (refer to chapter 1.1.6).

** Disciplinary Action Table

fAction Code

Description

Dooz

| -ctinn Code Description

|DooL

| VEREAL WARNING

ISSUE 13T WARNING LETTER

D003

I33UE ZND WARNING LETTER

Doo4

DEMOTION

Doos

DEPARTMENT TRANSFER

el

[ add ” Edit ” Delste l[ Brint l [ Exit ]

Action Code : Assign an abbreviation code not more than 4 characters for each
disciplinary action.

Description : Define each disciplinary code with details of action.

1.8.3 Areas of Appraisal

Menu Location: HR Department > Miscellaneous Files (2) > Areas of Appraisal
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Description: This option enables user to setup the employee’s performance evaluation criteria
or areas of appraisal.

** Areas of Appraisal g|
Sequence Mo, 10
Title | ATTENDANCE & DEPENDABILITY
Dietails EFrequencY of ahsences/lateness and reliability in ~|
|meeting commitments.
[ v
[ Eeq.No. Title A
z0 JOE FHNOWLEDGE & SKILLS
30 WORE ATTITUDE
40 CO-0PERATIVENESS
50 INITIATIVE
50 COMMUNICATION SEILLS
70 QUANTITY & QUALITY OF WORE
50 PLANNING & ORGANIZATION SEILLS
90 ANALYTICAL SEILLS
-
[ Add ” Edit ” Delete ” Print ] [ Exit ]

Sequence No. : Segregate different areas of appraisal into proper numbering system.
(maximum 2 characters)

Title : Enter the appraisal title.
(maximum 50 characters)

Details : Define each title with details.

1.8.4 Appraisal Rating

Menu Location: HR Department > Miscellaneous Files (2) > Appraisal Rating
Description: This option enables user to setup the grading points and rating groups for the

appraisal.
** Appraisal Rating g]
Faink [ 10 [
Rate Group |Excellent
Explanation B
Consistently far exceed expectation and performance 5|
is superior to majority of staff
!- Foint Rate Group 6
| G|(Very Good
6| Fond
dlhdverage
Z|Poor
|
[ Aadd H Edit H Delete H Prink I l Exit ]
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Point : Enter the appraisal’s rating point (2 digits).
Rate Group : Allocate the rating point to the appropriate rate group (maximum 20
characters).
Explanation : Explain the rating with details.

1.8.5 Appraisal Result

Menu Location: HR Department > Miscellaneous Files (2) > Appraisal Result
Description: This option enables user to setup and categorise result of the appraisal into
different groups according to the range of percentage.

** Appraisal Result @
Percentage From ' a0 | Percentage To . 100 .
Fesult Group Excellent '

E xplanation
|Excellent performance, exceed expectation and A:
| fulfill remquirements ol
Fram To Rezult Group Cadlll
1] 39|Poor

40 49| Average

50 6d|Good

65 79| Very Good

b

I &dd " Edit " Delete " Erint ] [ E zit l

Percentage From,
Percentage To : Enter the range of percentage to cover into the same result grouping.

Result Group : Assign the particular range of percentage into a result group (maximum 20
characters).

Explanation : Explain the result group with details.

Note:

Data items created in these three maintenance modules (1.8.3 Areas of Appraisal,
1.8.4 Appraisal Rating & 1.8.5 Appraisal Result) will be used in
Application/Approval 2> Performance Appraisal (refer to chapter 2.4).

1.9 Standard Documents
Menu Location: HR Department > Standard Documents

Description: This option facilitates user to utilize the existing employee database and apply into the
default standard documents/templates of letter format in the system so that to reduce time spent on
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user input and letter preparation. There are a total of 9 predefined standard document samples in
the system, including company policy, appointment letter, confirmation letter, promotion letter,
salary increment letter, retrenchment notice, retirement letter, warning letter and termination letter.

** Standard Documents gj

Document Ma,

1 Company Policy

File Location

|C:NTES SOFTWARE\UBSHREME\ LETTERSY POLICY.DOC

Eoc. Mao. Doc. Name File Location

Appointment Letter ZUES SOFTWAREYUBSHREMSY LETTERS\APPOINTHENT. DOC
Confirmation Letter STES S0FTWARENUESHEMS LETTERS CONFIRMATION. DOC
Promotion Letter ZUES SOFTWAREY,UBSHREMSY LETTERSY PEOMOTION.DOC
Salary Increment Letter SWUES SO0FTWAREUBSHRMEY LETTERS, SALARYINCEEMENT. DOC
Retrenchment Notice WUES SOFTWAREY,UBSHREMSY, LETTERSYEETEENCHMENT. D OC
Retirement Letter YTES S0FTWARENUESHEMS LETTERZ\RETIREMENT.DOC
Warning Letter YUES SOFTWAREY,UBSHEMSY, LETTERS WARNING.DOC
Termination Letter YB3 S0FTWAREN\UBSHEME LETTERZ\ TERMINATION. DOC

w oo o] o]
FIEEEEEEE

(e | oo | [ = |

To locate the standard documents’ file location

** Standard Documents g]

Document Ma,

| 5] Confirmation Letter

File: Lacation

| C:A\UBS SOFTWARE®UBSHRMSY LETTERSY CONFIRMATION. DOC

[ ac. No. Dac. Name File Location
1 Company Policy C:\UBS SOFTWARE\UESHEMSY LETTERS POLICY.DOC
Z Appointment Letter C:4IES SOFTWARE'UESHEMIY LETTERS\AFFOINTMENT. DOC

Promotion Letter
Salary Increment Letter
Retrenchment Notice
Retirement Letter
Warning Letter
Termination Letter

FEIEICAEIES

Save Cancel

1. Point to the particular document name, eg. Confirmation Letter.
2. Click “Edit” button and the cursor will prompt at the field File Location.

3. Select "Directory” button. Locate the directory path of UBSHRMS installation and search for
folder labeled “Letters”. Select the corresponding document title, eg. CONFIRMATION.DOC.

4. Click “Save” button to setup the corresponding path.

To retrieve the standard document

1. At the Standard Document main menu, select the particular document to be printed, eg.
Confirmation Letter.
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2. Click “"Open” button and you will be prompted with the next option.

** Print Confirmation Letter

Print Confirmation Letter

Emplayes Mo, Fram

Letter Date | 12/05/2004

Dept, Code From |
Line Mo Fram

Job Code From

EBranch Code From

Active Employes Only

id

Diate Confirm From | 01/04/2004 |

DI

To

To

To

To

To

To

| zzezes E]
| 12/05/2004 |
:zzzzzzzzzz E]
EEEEEEEEEE E]
| zzzz E]
EEEE E]
| o] 4 l [ Cancel |

3. Specify the range of Employee No. to be accessed to.

4. The default Letter Dateis set as the current system date. Change it to the appropriate date if

the letter is not going to be dated today.

5. Specify the range of date to be included, eg. confirmation date from and to specific dates, if

applicable.

6. Specify the range of records to be listed categorizing from Dept. Code, Line No, Job Code
and/or Branch Code. Skip this step if user wants to include all aspects of data.

7. Tick the checkbox Active Employee Only if user wants to view and print only active

employees’ records.

8. Click "OK" button to retrieve the data and execute the mail merge process.

Note:

standard letter.

As an exceptional case, the document titted Company Policy
does not utilize the employee database. Users can select the
document from the list and click “Open” to access directly to the

To setup Mail Merge in Microsoft Word

Before you can link data to Microsoft Word, make sure that you have keyed in the necessary data, eg.
Employee No., Department, Job Title and Salary (required fields in the content of letter).

Microsoft Word 2002.-
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1) Select Tools > Letters and Mailings > Show Mail Merge Toolbar.
2) Goto Tools > Letters and Mailings > Mail Merge Wizard.

3) In the Mail Merge Wizard, tick the option button “Letters” as the document type. Then click
“Next” (at the bottom right of screen) to continue.

4) Tick option button “"Use the current document”, then click "Next".
5) Click on "Browse...".
6) In the Select Data Source screen, click on "New Source...” button (next to the “File Name").

7) Inthe Data Connection Wizard screen, select “"Other/Advanced”, then click on "Next”
button.

8) Select "Microsoft OLE DB Provider for Visual Foxpro” in the Data Link Properties screen
under Providerindex page. Then click “Next” button.

9) In Connection index page, click on the “..."” button in point no. 1. “Select or enter a database
name.”.

10) In Configure Connection screen, choose “Free Table Directory”. Then, click on "Browse”
button next to the “Path” column. Double-click on “c:|temp|” folder in the Select Directory
Containing Free Tables screen. Then, click "OK” to return to the Configure Connection
screen. Then, click "OK".

11) In the Connection index page, click the “Test Connection” button. The message of * 7est
connection succeeded’ should be displayed. Then, click "OK".

12) In the Data Connection Wizard — Choose Data screen, click on the table name ->
prtdoc5.doc. Then, click “Finish”.

13) In the Mail Merge Recipients screen, click "OK" button.
14) Now, the mail merge toolbar is activated. You can close the mail merge wizard.
15) Go to “File” menu, click “Save”.

16) At the mail merge toolbar, click on * View Merged Data’ icon to view the actual data (employee
no., name, address, etc.) in the letter.

17) Click “Next Record' icon at the mail merge toolbar to view next record.
18) You can print the letter from Microsoft Word, choose “Print” in “File” menu.
19) Do not overwrite the letter with actual data in the original file name.

20) Repeat all steps above for the other letters.

Microsoft Word 2000.-

1) Select Tool > Mail Merge.

2) In Mail Merge Helper screen, under “1. Main Document”, click "Create”, then choose
“Active window".

3) In Mail Merge Helper screen, under “2. Data Source”, click “"Get Data”, then “open data
source”.
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4) Change Files of Type to “All Files". Select “c:|temp” folder, then choose “prtdoc5.doc”, click

“Open” button.

5) In Confirm Data Source screen, choose “Foxpro Files — Word via ODBC (*.dbf)". Then,

click "OK".

6) In Mail Merge Helper screen, click “Cancel”.

7) In File menu, click “Save”.

8) Mail merge toolbar should automatically be activated, if not, go to Too/ - Toolbars > Mail

Merge.

9) At the mail merge toolbar, click on * View Merged Data’ icon to view the actual data (employee

no., name, address, etc.) in the letter.

10) Click “ Mext Record’ icon at the mail merge toolbar to view next record.

11) You can print the letter from Microsoft Word, choose “Print” in “File” menu.

12) Do not overwrite the letter with actual data in the original file name.

13) Repeat all steps above for the other letters.

Doc. No. Doc. Name Default Document Temporary Table
File Name (in c:\temp)

1 Company Policy POLICY.DOC -

2 Appointment Letter APPOINTMENT.DOC prtdoc2.dbf
3 Confirmation Letter CONFIRMATION.DOC prtdoc3.dbf
4 Promotion Letter PROMOTION.DOC prtdoc4.dbf
5 Salary Increment Letter |SALARYINCREMENT.DOC |prtdoc5.dbf
6 Retrenchment Notice RETRENCHMENT.DOC prtdoc6.dbf
7 Retirement Letter RETIREMENT.DOC prtdoc7.dbf
8 Warning Letter WARNING.DOC prtdoc8.dbf
9 Termination Letter TERMINATION.DOC prtdoc9.dbf

When user attempts to merge the document, the system will transfer and save the necessary HRMS data
files into a temporary file on the hard disk. The temp file will then acts as the intermediate to correspond

for the data mail merge process.

Note:

All the default documents are stored in the folder
“..\UBSHRMS\Letters". Please be reminded that this “Letters” folder
will be removed when user uninstall UBSHRMS. And, these documents
do not included automatically in the system data files backup process.

Data Merged in Microsoft Word

There are a total of 44 common data being utilized in the data merge process, including company name,
company address, company tel, company fax, company ROC, letter date, employee no., name, initial,
badge no., address1, address2, postcode, town, state, country, phone, phone2, email, date of birth, new
ic no., old ic no., EPF no., SOCSO no., income tax no., Tabung Haji no., ASN no., work permit no., work
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permit valid date from, work permit expire date, passport no., passport expire date, branch, job status,
job title, job function, special job function, department, line no., category, date join, date confirm, date

promote and date terminate.

Other than these general details, each type of letter will has its own specific data included in the merge

process.

Document Name Additional Data

Remark

Company Policy -

No merge data

Appointment Letter confirmation month, salary

System will extract salary amount with
the effective date same as date join.

Confirmation Letter salary

System will extract salary amount with
the effective date same as date confirm.
If not exist, system will use the previous
salary amount effective earlier than the
date confirm.

For instance, employee has obtained
confirmation without new salary
adjustment.

Promotion Letter salary

System will extract salary amount with
the effective date same as date
promote. If not exist, system will use the
previous salary amount effective earlier
than the date promote.

Such as in the case an employee being
granted promotion but without new
salary adjustment.

Salary Increment old salary, new salary,
Letter increment amount, increment
effective date

Increment effective date is the latest
date in salary history.

Retrenchment Notice terminate remark

Only print selected termination reason
with “Retrenchment”’ (in HR
Department > Employee >
Personnel File - -> Job).

Retirement Letter terminate remark, service year,
service month, service day

Only print selected termination reason
with “Retirement” (in HR Department
> Employee > Personnel File - ->
Job).

Warning Letter -

Only merging common data listed
above.

Termination Letter terminate status, remark

Print all with valid termination reason.

How to modify standard document

If user would like to customize their own defined letter format out from the existing standard
document, using the existing data fields provided, follow the steps:-

1. Select and open a standard document from HR Department > Standard Documents.

2. In Microsoft Word 2002, enable toolbar in Tools > Letters and Mailings > Show Mail

Merge Toolbar
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il CONFIRMATION.DOC - Microsoft Word =3
Fil= Edit Wew Insett Format  Tools Table ‘Window Help - X
Bedd FRE @R e, LR
L-g-‘-I---IL---I‘-‘Z---I---E- L e 1 EE II&IZ'
«compname»
compaddis
i ccompadd2s
ccompadd3s
- zcompaddds  (zcomprocs)
E Tel: zcomptels
” Fax: soompfaxs
E «letterd ates
™ «BIMPp o
& &Nnames
gaddl »
- gadd2s
«postcodes etowns
«states

Dear gnames

RE., CONFIRMATION OF APPOINTWMENT

| refar to your terms of employment with this Company and in particular to the three months'
probationary period you were required to serve hefore you could be confirmed in your
positian

The report submitted by your immediate superdsor states that you have performed your
duties satisfactonly well.  You are therefore, hersby confirmed in your appointment as
«jobtitles with effect from «DATECERMs.

Upon this confirmation, your basic salary will be adjusted to RMesalarys. In addition, you are

=
z
e}

View Merged Data

=a g FEE

'

Highlight Merge Fields

l

“ [E By M 4 3 P M

Insert Merge Fields

3.
will be prompted.

Insert Merge Field

Insert:

" Address Fields {* Database Fields

Figlds:

COmMprame
compaddl
compaddz
compadd3
compadd4
comptel
compFax
Comproc
EMpno
narme
initial
badgeno
addi
addz
postoode
Fawin
stake
counktry

=i

Cancel |

Insert |

Match Figlds. .. |
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4. Determine and point to the data field to be inserted into the document and click “Insert’ button.

5. Save the file accordingly.

Saving amended standard document

If user has modified the content of the original document template, it is advisable to create a new
folder (eg. Company Letter) inside “...\UBSHRMS\Data" folder and save the amended document
(eg. Confirmation2) into this new folder. As such the original standard documents remain unchanged
and the newly created folder will always be included in the system backup. Do not overwrite the
system’s default documents.

However, user must remember to reset the link path to the appropriate new directory so that the
system will link to the user-defined letter in future access.

Summary:-

1. Select the particular document and click "Open” button to retrieve the standard
document.

2. After successful mail merge in Microsoft Word, make the necessary changes to the letter
content.

3. After complete, in Microsoft Word, select File 2 Save As option, store the amended
document with a new File name and Save in a new folder created inside

“...\UBSHRMS\Data".
Save in: |J Company Letter | & - @ x % ~ Tools +
ﬂé Desktop
ﬁ] _é My Computer

|[C3) CELok' = Documents
I2) Shared Documents
3% Floppy (A2)
< Local Disk (C:)
) UBS Seoftware
) UBSHEMS

O data
? [=§C
i CD Driwe (D:)

“g Backllp (E:)
‘_.j My Hetwork Flaces

Hiskory

B

My Documents

o
o
2
=
o
=l

* u My Documents
Favorites '_—EE FTF Locations
Add/Modi £y FTF Locations
=
== Fiensme:  [CONFIRMATIONZ.DOC =] o
Iy Metwork 3
Places Save as bype: |W0rd Document (*,doc) j cancel
Note:

The above example illustrates how user attempt to save a newly
amended letter named “Confirmation2” into a new folder labeled
“Company Letter’, created inside UBSHRMS\data folder.
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** Standard Documents

Document Mo,

|3 Confirmation Letter

File: Location

;C:\U’BS SOFTWARE\UBSHEMS, DATAY COMPANY LETTER\CONFIRMATIONZ.DOC

Directory ...

[Coc, Mo, Doc, Marme File Location

1 Company Policy C:\UE3 S0FTWARE:UESHEMSY LETTERSYPOLICY.DOC

2 Appointment Letter C:\UES SOFTWARE\UESHEMSY LETTERSYAPFOINTHENT. DOC
Li

4 Promotion Letter C:\UES SOFTWARE'\UESHRMSY LETTERSY PROMOTION. DOC

5 Salary Increment Letter |C:VUB3S SO0FTWARENUESHEMSY LETTERS SALARYINCREMENT.DOC
[ Retrenchment Notice C:\UE3 S0FTWARE:UESHEMSY LETTERS\RETRENCHMENT.DOC
7 Retirement Letter C:\UES SOFTWARE'\UESHRMSY LETTERSYRETIREMENT. DOC

g Warning Letter C:\UE3 S0FTWARE:UESHEMSY LETTERS\ARNING.DOC

) Termination Letter C:\UES SOFTWARE\UESHRMSY LETTERSY TERMINATION. DOC

Save Cancel

4. Lastly, in the Standard Documents module, select “"Edit” and then “Directory”
button to reset the new path of the amended document link to the new folder inside
“...\UBSHRMS\Data" folder. Click “Save” to confirm the new path link.
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Chapter 2 APPLICATION/APPROVAL
Overview:

This module consists of four major functions, which are leave, claim, resource and performance appraisal.
It facilitates users to apply leave, submit claim, request resources and process performance appraisal.
And, it is also the menu whereby the authorizer will approve submission including leave, claim,

requisition and appraisal.

2.1 Leave
This menu options enable users to apply, approve and view leave applications.

As we mentioned earlier, there are 14 types of leave setup as default by the system (in HR
Department > Miscellaneous Files > Leave Type).

Prior to this, users must setup multiple leave schemes at HR Department > Miscellaneous Files
-2 Leave Scheme. Then, assign the relevant leave scheme to individual employee at HR
Department > Employee - Personnel File - -> Benefit

2.1.1 Leave Application/Approval

Menu Location: Application/Approval > Leave > Leave Application/Approval
Description: This option enables users to apply, approve, modify, cancel or delete leave
application as well as print out the leave application form. User’s functions are depending on
the access rights assigned to individual user at User Manager.

** | eave Pending for Approval E]
Emplayes Mo, FO0Z
Marme WILLIAM 00 5IM HUI
Department RsD FESEARCH & DEVELOPMENT
Scheme Code 1302
Annual Leave Balance 21.00
Compensation Leave Balance i)
Ho Appraoval Final Approval Cancel Status Leave Code Date From DateTa Session Apply Date Al
EM 29/06/2004 |29/06/2004|FULL 29/06/2004
Pending EM 30/06/2004 |30/06/2004(1st Half |30/06/2004
Pending Pending uc 01/07/2004 |01,/07/2004|FULL 01/07/2004

hi

oo e s ) e ] [ ] e J e J oo | o ] [0 ]

The main screen will display the Employee No., Name, Department and Leave Scheme
Code.

Annual Leave Balance indicates the outstanding annual leave as at current date. Whereas,
Compensation Leave Balance indicates number of days accumulated and classified as
compensational leave, if any.

The table will list details of the leave applications cancelled or pending approval. There are

two levels of authorization, indicated by head of department or final approval. Leave
applications once completely approved will not be shown in this menu.
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An employee can only view his/her own leave applications pending for approval. A head of
department can view his/her own leave application and also his/her subordinates’ submission.
The system administrator can view all.

To apply leave

1. At the respective employee’s record, click “*Add” button.
** [eave Application gj
Emploves Mo, |E00z |
Tame WILLIAM 00I 3IM HUI
Schems Code . L5302 .
Department ReD _RESEARCH & DEVELOPMENT
Leave Code AL || Amrual Leawe
Drate From 12,-’0’?;’_2004 Drate To 160742004
Session Full ¥ Total Day 5.0
Remark _VACATIDN TO OVERSEAS
Apply Date 30/06/2004
Deduct Mode AL w
[JHoD Approvalfacknowledgement [ Einal Approvalfacknowledaement
Approved Date T Approved Date P
Approved By Approved By
2. Inthe Leave Application sub-menu, enter the following relevant information:-
Leave Code : Select the appropriate type of leave to apply.
Date From : Enter the starting date for leave to be taken.
Date To : Change the leave ending date if it is more than one day or not same as
the leave’s starting date.
If the employee is applying continuous leave days, do not include non-
working days or public holiday.
Session : Specify the leave session, whether it is full day leave or half day (1%
half of morning period or 2" half of afternoon period).
Total Day : System showing total number of days for leave application based on
the leave starting and ending date.
Remark : Reason or purpose of the leave (maximum 50 characters).
Apply Date : Leave application’s date as at current system date.
Deduct Mode : Specify from which leave type to be deducted; if selection is available.
Leave Code Deduct Mode
Absent (AB) Absent (AB)
Annual Leave (AL)
Annual Leave (AL) Annual Leave (AL)
Compensation Leave (CP)
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Examination Leave (EX) Annual Leave (AL)

Examination Leave (EX)

Shut Down (SD) Annual Leave (AL)

Shut Down (SD)

For instance, if an employee is applying an annual leave, he/she may choose to off-set
from Annual Leave or Compensation Leave entitlement.

If a company has the Examination Leave benefits, then the employee has the option to
apply such leave and utilize it either on examination or annual leave balance.

If deduct mode selection is not available, leave code applied will deduct from the
respective leave code itself. For example, employee who applies Sick Leave will deduct
from the entitled sick leave balance.

Note:
1.

All types of leaves can only be applied if user has maintained the appropriate number of
leave day’s entitlement in HR Department > Miscellaneous Files > Leave Scheme - -
> Add/View Detail.

And, the employees must also fulfill the relevant requirements for related Apply Status
and Prorata for Newly Join Employee conditions.

Advance Leave cannot be applied if annual or compensation leave is still available.
Please refer to Note 2 for other examples.

Compensation Leave can be carried forward to the following year as annual leave when
performing year end process, provided that the total number of days (including annual
leave balance) is not exceeding maximum annual leave allowed to be carried forward (as
per setup in HR Department - Miscellaneous Files - Leave Scheme).

Maternity Leave only applicable for female employees, whereas, Paternity Leave only
applicable for male employees.

Non Pay Leave will be posted to “No Pay NPL” in UBS Payroll System for salary
calculation after processes of export from HRMS and import to Payroll.

3. Click "Save” button to submit the leave application.

Note 2: Advance Leave (AD)

1.

For non-confirmed employees, they cannot apply annual leave (AL). An error message
“This type of leave can only be applied after the company confirm the employee!”
will be prompted.

If a company allows non-confirmed employees to apply for advance leave, the particular
leave (AD) will automatically deduct from annual leave (AL) entitlement during year-end.

When the particular employee obtains confirmation, user must enter the relevant Date
Confirm in HR Department > Employee 2 Personnel File - -> Job. Therefore, the
employee can now apply annual leave.

Notice that the annual leave balance will only be deducted (for advance leave applied)
after year-end processing.

For instance, a non-confirmed employee has applied one advance leave. Assuming after
confirmation, the respective employee is entitled for 5 days of annual leave. This
employee will be restricted to apply for another 4 days leave only, taking consideration of
1 advance leave applied earlier.

When the employee’s current year annual leave entitlement had been fully utilized, the
employee must apply advance leave (AD) so that to deduct next year annual leave
entitlement.

Leave applied (AD) will automatically deducting annual leave (AL) for next year during
year-end processing.

7
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lication

1. At the particular employee’s record, locate and select the relevant leave application to be
modified. Click “Edit” button.

Leave Code

AL Armmal Leawve
Date From 12/07/2004 Date To lz/0%/2004
Session Full w Taokal Day 1.0
Remark FERSONAL MATTERS |
Apply Date 05/07/2004

Deduck Maode

AL

2. Users are only allowed to change the Date From, Date To, Session and/or Remark
field.

3. Click “Save” button to update the modification.

To cancel leave application

1. Select the particular leave application, click “Edit” button.

Cancel Application Cancelled By TUES

Reason REEQUEST TO FELIEF OPERATIONS DEPARTMENT

2. Tick the checkbox Cancel Application. The system will indicate the application is
Cancelled By which login user.

3. Enter valid Reason for rejecting the leave application. The length of field is 50 characters.

4. Click “Save” button to update the information.

To delete leave application

1. At the respective employee’s record, select the particular unwanted leave application to be
deleted.

2. Click “Delete” button.

?/ Are vou sure vau want to delete this record?
\-".

[ Yes ] [ Mo ]

3. Click “Yes” to confirm deletion of this leave application. Otherwise, click *No” to disapprove
deletion.

To approve leave application
1. Click at Shortcut To Approve Leave link at the front page or go to

Application/Approval > Leave > Leave Application/Approval, select the particular
leave application and click “Edit” button.
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HOD Approvalfacknowledgement [#]Final approvaliacknowledgement
Approved Date 01/07 /2004 Approved Date 0z/07 /2004
Approved By E004 Approved By UES

2. Tick the respective checkbox (HOD and/or Final Approval/Acknowledgement) to
approve the leave application. The system will display Approved Date and Approved
By, according to current system date and login user.

3. Click “"Save” button to acknowledge the leave application.

Note:
1. For leave applied but not yet approved, staffs can modify the details, cancel or delete
the leave application.

However, if a staff cancels his/her leave application, the reversal of cancellation can
only be performed by the staff himself/herself or by the system administrator.

On the other hand, if a superior cancels a staff’s leave application, the reversal of
cancellation can only be performed by the superior or the system administrator, but
not by the staff.

2. Leave once cancelled does not allow further approval.

3. For leave applied and HOD approval obtained, staffs will be restricted to modify the
application, but still able to cancel it. However, delete action will be totally prohibited.

4. For leave applied, HOD and Final approval obtained, staffs will be prohibited to
modify, cancel or delete the application. They can only view the approved leave
application in Application/Approval > Leave - Leave Approved.

It is advisable to restrict full authorities to modify, cancel or delete a complete
approved leave application only to the system administrator.

5. Do not delete leave approved. It is advisable to cancel the leave application so that to
keep the leave record in history.

To print leave application form

By default, staffs and HOD are not allowed to access the print function in this module. HR Officer,
HR Manager and System Administrator have the access right to print out the leave application
forms.

1. Select “"Print” button and you will be prompted with the following pop-out menu.

** Employee Leave Details (Pending For Approval) Report g]

Employee Leave Details (Pending For Approval) Report

Employes Mo, From E00Z E] To | EQ0Z E] Tine
- L () Details Repart

Leave Code From E] To | zzz E] @-Leave Application Farm
Leave Date From 12/07/2004 | To i Group By
Session 4 - ALL M
Skatus Non-Cancelled Only
Dept. Code From E] o) zzzzzz2z22 E] Shaow Active Only
Line No From E] To |ZZEZZZEEEEE E]
Job Code From E] To |zzzz E]
Branch Code From E] To |zzzz E]
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2. Specify the Employee No if user wants to print the leave application form for a particular

employee.

3. Specify the Leave Date taken.

4. Tick the option box Leave Application Form.

5. Click "OK" button to preview or print out the leave application form.

UBS CORPORATION BERHAD

Euwployee Mo, - EOOZ

MNaume : WILLIAM 00I SIM HUI

Leave Application Form

Printed Date : 20/06/Z004

Department : PRESEARCH & DEVELOPMENT

Jrwmal Leswve Balance (Day) 13,00

2/No. leawe Code & Descriptiom Date From

Date To

Sessimn  Dedurt Mode & Description ipply Dats

1 AL
Deuwark

Arraaal Leawe
: VACATION TO OVERSEAS

Applicant Signature HOD Approval

1z/07/2004 16/07/2004 Fall AL

Anrazl Leawe 20/06 2004

Final hpproval

Name -

Date :

Mame -
Date :

This is the actual unapproved leave application form printed for the particular employee. It
stated type of leave applied, date of the leave, leave session and deduct mode.

Annual Leave Balance (Day) indicates the current outstanding balance of the annual leave

excluding this unapproved application.

2.1.2 Leave Approved

Menu Location: Application/Approval > Leave > Leave Application/Approval
Description: This option enables staffs to view the approved leave applications. And, it also
allows the superiors or system administrator to modify, cancel or delete the approved leave

applications, if necessary.

** Leave Approved [g]
Emplayes Mo, E002
Narne WILLIAM 00I SIM HUI
Department RsD | RESEARCH & DEVELOPMENT
Scheme Code 1302
K_ancel Status Leave Code Leave Date Session Deduct Mode Apply Date Remark. ~
Li
AL 097072004 |FULL AL 02/07/2004 |PERS0NAL MATTER
il |AL 19/07/2004 |FIULL AL 05/07/2004 |OVERSEAS VACATION
AL 20/07/2004 |FULL AL 05/07/2004 |0VERSEAS WACATION
AL 21/07/2004 |FIULL AL 05/07/2004 |OVERSEAS VACATION
el
< >
l First " Prewious " et " Last l l Edit H Delete ” Search " Print l l Exit l
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The table will list each leave day in details even though the leave application was applied only
one time on the same date but consist of several continuous leave days. For instance, in the
sample shown above, the employee has applied 3 days leave on the same apply date.

Scrolling to the right of the table will reveal more information for each application including
approval dates, authorizers, cancellation date and reason.

To modify approved leave application

1. Search and locate the employee. Select the leave record to be amended from the list shown
in the table.

2. Click “Edit” button.
3. Users are only allowed to change the Leave Date, Sessionand Remark.

4. Click “Save” button to update the amendment.

*~* Modify Leave Approved E]

Emploves Mo, |E00Z2

Mame |WILLIAM 00I SIN HUI

Scheme Code Ls0z ]

Department i:R*%D "'m:sgmc__ﬁ 5 DEVELOPHENT

Leave Code | AL | | Anmual Leawe

Leave Date

Sessian

Remark | PERSONAL MATTER
Apply Date | D2s07,/2004
Deduct Mode | AL l

[]cancel Leave

HOD Approved Date 03/07/2004 | Final spproved Date | 03/07/2004 |
Approved By .EDEML Approved By | UES .

Save Cancel

To cancel approved leave application

1. Search and locate the employee. Select the leave record to be cancelled from the list shown
in the table.

2. Click “Edit” button.

3. Tick the checkbox Cancel Leave. The system will display current login user in the field
Cancelled By.

4. Enter Reason for the leave cancellation.

5. Click “"Save"” button to update the cancellation.
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** Modify Leave Approved

Emplowee Mo, I_Eutlz
Mame WILLIAM 0O0I SIM HUI |
Scheme Code L3502
Department ReD | RESEARCH & DEVELOPMENT |
Leave Code AL i |Jmnual Leawve |

Leave Date

-

Session | Full w |

Remark OVERIELS VACATION |

Apply Date | 0g/07/2004

Deduct Mode AL |

Cancel Leave Cancelled By | UBS |

Reason |STAFF MIST FELIEF OFERATIONS DEFT |

HOD Approved Date | 09/07/2004 | Final Approved Date | 09/07/2004
Approved By EO04 Approved By UES

Save Cancel

To delete approved leave application

1. Search and locate the employee. Select the leave record to be deleted from the list shown in
the table.

2. Click “Delete” button.

MESSAGE

.""'?w‘/ Are you sure wou wank to delete this record?

[ Ves ] [ Mo l

3. If confirmed want to remove the unwanted leave record, click “Yes" button. Otherwise, click
“No"” button to disapprove the deletion.

To print approved leave form

By default, staffs and HOD are not allowed to access the print function in this module. HR Officer,
HR Manager and System Administrator have the access right to print out the leave application
forms.

1. Select "Print” button and you will be prompted with the following pop-out menu.
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** Employee Approved Leave Details Report

Employee Approved Leave Details Report

Ermplavee Ma. From
Leave Code From
Leave Date From
Session

Stakus

Dept, Code From
Line Mo From
Job Code From

Branch Code From

E02 7] T

E] To
01/07/2004 | o
[4 - aLL v

Non-Cancelled Only

Ta

To

Ta

Ta

OOOm

EEEEZZEEEE

EEEZE

|Enoz | E] L
() Details Report
ZEE E] () Approved Leave Form
31/07/2004 Group By

ZEEEZEEEEE

ZEZEZE

OO

Show Active Only

2. Specify the Employee No if user wants to print the approved leave application for a

particular employee.

3. Specify the Leave Date taken.

4. Tick the option box Leave Application Form.

5. Click "OK" button to preview or print out the approved application form.

UBS CORPORATION BERHAD

Approved Leave Form

Printed Date :

Department -
tromial Leawve Balance (Day) -

RESEARCH & DEVELOPMENT

21/07/2004

1750

Leatre Date

Apply Date

Pemark

Jpplicart %immature

05,/07/2004

: DAUGHTER HOSPITALISED

08,/07/2004

Employee No. : EOOZ
Haue : WILLIEM 00T SIM HUT
S/No. Leawe Code & Description
1 EM  Emergency Lesve
Remarl
z MC Sick Leave
Pewsrk : FEVER
3 AL Anmal Leaws

12,/07/2004

PERS0ONAL MATTER

HOD Approval

Dediuct Made & Description
AL Arrpaal Leanre

MC Sick Leawe

AL Arnrmal Leawe

Final hpproval

05/0772004

02/07/2004

30/06/2004

Name
Date

Mame -

Date :

This is the approved leave application form printed for the particular employee. It stated type of

leave applied, date of the leave, leave session and deduct mode. It can summaries all leave
application approved for any specified period of time.

Annual Leave Balance (Day) indicates the latest outstanding balance of the annual leave for

the respective employee.

2.1.3 Leave Summary

Menu Location: Application/Approval > Leave > Leave Summary
Description: This option enables user to check the overall summary of the approved leave
application as at current date.
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** Employee Leave Summary g]
Emploves Mo, EO0D4
Mame TAN MING LING
Total Brought Forward Annual Leawe 3.0 | Annual Leave Balance 12.5
Total Annual Leave Entitled 14.0 | Compensation Leave Balance | 0.0
Eeave Code  Descripkion Deduct Mode Description Taokal Day
EM Emergency Leawve AL Anrmal Leawve 0.5
ExX Examination Leave AL Amrmal Leawe 2.0
HC Gick Leawve MC Jick Leawe 0.5
l First H Previous " Mexk " Last ] l Search H Print ] [ Exit l

Total Brought Forward Annual Leave indicates the number of leave days carried forward
from previous calendar year, if any. Whereas, Total Annual Leave Entitled refers to the
number of leave days entitled for the current year.

Annual Leave Balance shows the actual balance of leave days after deduction of leave
taken and approved, as at current date.

Compensation Leave Balance displays the available outstanding balance of compensation
leave, if any.

Go to Application/Approval > Leave > Leave Application/Approval - -> Add to grant
the particular staff a compensation leave.

Leave Code CP % || Compensation Leawve

Dake From 09/07/2004 Cate To 0970772004
Session Full v Total Day 1.0
Remark COMPENZATE FOR WORKING ON REST DAY

Apply Date 06/07/2004

So that the staff may apply an Annual Leave deducting from Compensation Leave entitlement.

Leave Code AL || Annual Leave

[rate From 0s/07/2004 Date Ta 090772004
Session Full v Total Day 1.0
Remark. REPLACEMENT LEAYE FOR WORKING ON 1/7/04

Apply Date 07/07/2004

Deduct Mode CP w

In Employee Leave Summary menu, the table will show a consolidated summary for each
leave type applied and deducted from respective leave code, with accumulated total number

COPYRIGHT © UBS CORPORATION SDN BHD



EZUBS

User Business System Human Resource Management User Manual Page 93 of 223
of days. For example, how many days of Annual Leave, Emergency Leave or Examination
Leave applied and deducted from Annual Leave.
2.2 Claim
This menu option enables users to submit, modify and approve various types of claims.
Prior to the operations of processing claims, users must setup the following:-

i) create a claim code and assign the link number to be posted to UBS Payroll system (HR
Department > Miscellaneous Files »> Claim Code)

i) setup the claim scheme by specifying the claim details including maximum amount per
receipt and per year (HR Department > Miscellaneous Files > Claim Scheme)

ii) assign the relevant claim scheme code to each individual employee (HR Department >
Employee > Personnel Files - -> Benefit)

2.2.1 Claim Submission

Menu Location: Application/Approval > Claim > Claim Submission
Description: This option enables users to submit, modify, approve or delete the allowance

claims.
** Claim Pending for Approval g]
Employee Mo, E004
Marmne TN MING LING
Department RslD | RESEARCH & DEVELOPMENT
Scheme Code Csoz |
| Hoo Approval Final Approval Claim Code Description Company Mame  Receipt Mo, Claim Amount (Claim Date I
Pending! |01 MEDICAL SRI PINANG CIMZ43 28.00/01/07/2004
Pending! Pending! |02 DENTAL FHOO DENTAL |KS50 50.00|05/07/2004
) |
v
I First " Previous ” et “ Last ] l Add " Edit " Delete " Search " Print ] l Exit ]

Header of the main screen will display the Employee No., Name, Department and Claim
Scheme Code.

An employee can only view his/her own claim submissions pending for approval. A head of
department can view his/her own claim submissions and also his/her subordinates’ submission.
The system administrator can view all.

The table will list out details of the claims that were pending approval. There are two levels of
authorization, indicated by head of department or final approval. Claims once completely
approved will not be shown in this menu.

To submit allowance claim

1. In the respective employee’s record, click “*Add” button.
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** (Claim Submission

Employee Mo, E0n4 |

MName TAN MING LING

Scheme Code C302 [

Department RsD RESEARCH & DEVELOFMENT

Mazx. Per Receipt 50.00 | Total Approved Claim 28.00
Mazx. Per Year £00.00 | Total Pending Claim 50.00
Balance Amount 572,00 Balance Amount (2) 52z2.00
Claim Code oL » | MEDICAL

Company Mame | TANJUNG BUNGAH CLINIC

Receipt Mo. T5380

Receipt Amourk | 62.00 Receipt Date 05/07/2004 |
Claim Amounk g0, 00 Claim Diate 07/07/2004
Remark . FEVER

[ 1HOD approval [IFinal approval

Approved Date o . Approved Date e
approved By . approved By [

Moke: Balance Amount = Max, Per Year - Total Approved Claim
Balance Amounk (23 = Max, Per Year - Total Approved & Pending Claim

2. In the Claim Submission sub-menu, enter the relevant information:-
Claim Code : Select the related allowance claim code from the list.

New claim codes can be created in HR Department >
Miscellaneous Files > Claim Code.

However, the claim codes shown in the list are according to the setup
in HR Department > Employee - Personnel File - -> Benefit
for each individual employee.

Company Name : Enter name of the company which issued the receipt.

Receipt No. : Reference number of the receipt.

Receipt Amount : Amount of the receipt.

Receipt Date : Issuing date of the receipt.

Claim Amount : Amount to be claimed.

Claim Date : Default current system date.
Remark : Additional notes pertaining to the claim request (maximum 50
characters).

3. Click "Save” button to submit the claim request.

Max. Per Receipt 50.00 Total Approved Claim 28.00
Max. Per Year 500,00 Total Pending Claim 50.00
Balance Amount 572.00 Balance Amount (2) 522 .00
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Details of amount only will be shown after user has selected the related Claim Code.

With reference to the relevant Claim Code, Max. Per Receiptis the maximum amount
claimable for each single receipt. Max. Per Yearis the overall accumulative amount claimable
for the whole calendar year. Both values are derived from maintenance setup in HR
Department > Miscellaneous Files > Claim Scheme.

Balance Amount = Max. Per Year — Total Approved Claim

Balance Amount indicates the existing remainder of claimable amount for the year, after
deducting the approved claim(s), as at current date.

Total Approved Claim shows the overall accumulated approved claim amount as at current
date.

Total Pending Claim shows the total outstanding claims pending for approval as at current
date.

Balance Amount (2) = Balance Amount — Total Pending Claim

Balance Amount (2) indicates the estimated remainder of claimable amount, if and only all
pending claims will be approved.

Note:

Claim Amount CANNOT MORE THAN Receipt Amount, Max. Per
Receipt or Balance Amount (2).

To modify claim submission

1. At the respective employee’s record, search and locate the claim to be modified. Click “Edit”
button.

Claim Code ol » | MEDICAL

Campany Marme

TANJUNG BUNGAH CLINIC

Receipk Mo, TS380
Receipt Amount &6z2.00 Receipt Date a5/07 /2004
Claim Amount 50,00 Claim Date 07/07/2004
Remark. FEVER

2. User can only modify the relevant fields as per shown.

3. Click "Save"” button to update the details.

Remark:

User is claiming 50-00 only even though the receipt amount is stated 62-00 because the

maximum claimable amount per receipt is preset as 50-00. Claim amount cannot be more than
maximum amount per receipt.

To delete claim submission
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At the respective employee’s record, select the unwanted claim request.

2. Click “Delete” button.

4 i

MESSAGE

?/ Are vou sure you wank bo delete this record?
\‘.

[ es ] [ Mo l

3. Select “Yes" button if confirmed to delete the particular claim item. Otherwise, select "No”

button to disapprove deletion.

To approve claim submission

At the respective employee’s record, locate and select the particular claim item to be
approved. Click “Edit” button.

Tick the respective checkbox (HOD Approval or Final Approval) to approve the leave
application. The system will display Approved Date and Approved By, according to

current system date and login user.

HOD Approval ;
Approved Date 07/07/2004 Approved Date 0s/07/2004
Approved By E004 Approved By UES

3. Click “"Save” button to acknowledge the leave application.

To print claim submission form

1. Select “Print” button.

** Employee Claim Details (Pending For Approval) Report [g|

Employee Claim Details (Pending For Approval) Report

Type
() Details Report (®) Claim Submissian Form

Graup By

Emploves Mo, From 'B To g-zzzzzz E]
Claim Code From I NB To glﬂzzzz ’E]
Diept, Code From E] Tn E}azzzzzzzzz B
Line Ma From E] Tn _zzzzz 22222 - E]
Job Code From B To 2222 E]
Branch Code From | B To ;zzzz E]
Claim Date From E:DS;"D'NZDDAIH_; To :HIIJS;“D?!ZDM -.
Receipt Date From ) Ta | s v

Active Employee Cnly
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2. Select Type as " Claim Submission Form'.

3. Specify the respective Employee No. and Claim Date if user wants to print any particular
record.

4. Click "OK” button to continue to the print option, whether to preview or print the form.

UBS CORPORATION BERHAD

Claim Submission Form

Printed Date : 08/07/2004

Euployee No. : E004 Department : RESEARCH & DEVELOPMENT
Heme : IAN MG LING
. o . | Aot [ Date ———— |
2/No. Claim Code & Descripricsn Receipt No. ) )
P B Teceipe Clain Deceipt Claim

1 o1 MEDICAL 713840 75.00 50 00 07/07/z004  08/07/2004
Comparry Name : SINCAPORE CLINIC
Remark : FLO

Jpplicant %ignature HOD Mpproval Pinal Approval

Hame Nane :
Date - Date :

This is the actual layout for the claim submission form with details of the claim.

Note:

1. Staffs can only modify or delete a claim submission if it is not approved yet. When one
approval has been processed, staffs can only view the contents of claim submission but
are not allowed to modify it any more.

2. When one approval has already granted, staffs will be totally restricted to delete the
particular claim submission.

3. If there is only one approval processed, a superior or system administrator can still
modify or delete the related claim submission in this module.

4.  When both approvals obtained, the superior or system administrator has to go to
Application/Approval 2 Claim 2 Claim Approved menu to modify or delete the
related claim submission. This will be discussed in the next chapter 2.2.2

7

2.2.2 Claim Approved
Menu Location: Application/Approval > Claim > Claim Approved

Description: This option enables the staffs to view the approved allowance claims. And, it also
allows the superiors or system administrator to edit or delete the approved claim, if necessary.
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** Claim Approved

Employes Mo, |E004 |

Marne | TAN MING LING

Department | RsD | RESEARCH & DEVELOPMENT

Scheme Code [ csoz |
tlaim Date Claim Amount Claim Code Description Company Mame 1]
| [o5/07/2004 §0. 00|02 DENTAL KHOO DENTAL
| [06/07 /2004 42,0001 MEDICAL TANJUNG BUNGAH CLINIC
| [o6/07/2004 100.00)07 PARKING FEE MENARA GREEN GARDEN
| |07/07 /2004 26.00(01 MEDICAL TANJUNG BUNGAH CLINIC
M
| v
s ” i ] _ . _ 8
l First " Previous " Mext “ Last ] I Edit " Delete " Search " Print ] I Exit ]

The table will list all approved claims in details including claim date, claim amount and claim
code. Scrolling to the right of the table will reveal more information for every claim request
such as receipt number, receipt date and receipt amount, as well as approval details.

To modify the approved claim

1. At the respective employee’s record, select the related claim to be amended. Click “Edit”

button.

2. User will be restricted to change the Claim Code.

** Modify Claim Approved

Emplowves ko,
Mame
Scheme Code

Department

Claim Code
Cornpanty Mame
Receipk Mo,
Receipk Arnount
Clairm Amaunt

Remark.

HOD Approved Date
Approwed By

| FEVER

|EDD4

TAN MING LING

| 502

T53801

42,00
42,00 |

| 08072004

| 1B

| RsD jRESEARCH & DEVELOPMENT
0l | MEDICAL

| TANJUNG BUNGAH CLINIC

Receipt Date 0370772004
Claim Date | 07/07/2004 :

Final Approved Date
Approwed By

K

| 08/07,/2004
UBS

Save Cancel

3. Modify the details of claim accordingly.

4. Click “Save” button to update the modification.

To delete the approved claim

1. At the respective employee’s record, locate and select the incorrect approved claim item.
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2. Click “Delete” button.

9

“'-.f} Are wou sure vou wank to delete this record?

[ Yes ] I Mo l

3. Select “Yes” button if confirmed to delete the unwanted claim. Otherwise, select "No” to
disapprove the deletion.

2.3 Resource

Certain companies provide resource materials, tools or equipments to their eligible staffs in need of
performing their daily duties or as a type of benefit. Some resources might need to be returned back
to the company when the staffs left, transferred or resigned, e.g. vehicle, note book, hand phone,
etc. Other resources can be owned by the employees until wear out or torn, e.g. uniform, shoe, etc.

Prior to the operations of this process, users have to setup the resource items available to be issued
or given out to the employees. Go to HR Department > Miscellaneous Files > Resource Code.

In order to request and approve resource requisition, go to Application/Approval > Resource >
Resource Requisition/Approval. Please refer to chapter 2.3.1 for further details.

And, when users want to record resource materials returned by the employees, go to

Application/Approval > Resource - Resource Approved. Please refer to chapter 2.3.2 for
further details.

There is no print function in this module. Users can print the related report in Report > Resource
> Employee Resources Report.
2.3.1 Resource Requisition/Approval

Menu Location: Application/Approval > Resource > Resource Requisition/Approval

Description: This option enables users to submit requisition for relevant resource item. And, it
also allows the authorizers to approve resource requisitions by the employees.

** Resource Requisition Pending for Approval g]

Emplavee Ma. E007
Narne LINDA 00T POH POH
Department MRKT | MARKETING
HOD Approval Final Approval Resource Code bescription Special ID Quantity Request Date | #
Pending! |R303 LOCEER CABINET NO. Z-34q 1{01/07/2004
Pending! |Pending! |R304 TNIFORH 3[{01/07/2004
Y |
Pending! |Pending! |R502 NOTEEOOE M253-547 1{05/07 /2004

A

Cow Jrome e Lo ) (o Lo Jomwe o] [ ]
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In this sub-menu, the footer is indicating the Employee No, Name and Department. The
table will list out all pending approval resource requisitions. It summarizes the resource item,

special id, quantity and request date.

To request resource

1.

A

At the respective employee’s record, click "Add” button.

Resource Requisition

Emplovee Mo, EODS

Marne ANDY LOO CHIN SIM

Department MEET || MARKETING

Resource Code RS0z b [ NOTEBOOK

Return Status YES Request Date

Special ID | IEM THINK PAD R51l (ZE87RAL)
Cuantkity 18 Size

Remark FRODUCTS DEMONSTRATION

[JHoD Approval [JFinal Approval

Approved Date Approved Date

Appraoved By Approved By

Issue Dake Expected Return Date

Remark (2}

05/07/2004

/

/

Save Cancel

2. Enter the relevant information:-

Resource Code : Select the necessary resource item from the list. New resource items
must be created in HR Department > Miscellaneous Files >

Return Status : Value (Yesor No) will be displayed based on the resource code selected
by user. It is predetermined according to the setup for respective
resource items in HR Department > Miscellaneous Files >
Resource Code.

Request Date : Current system date.

Special ID : Enter the identification code/ key of the product item, if applicable.

Quantity : Specify the number of item requested.

Size : Measurable resources item, e.g. X, L, M or S for uniform.

Remark : Any additional notes pertaining to the requisition e.g. purpose and

3. Click “Save

Resource Code.

reason. (Maximum 50 characters)

" to submit the request.

To modify resource requisition
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1. At the respective employee’s record, select the requisition to be amended. Click “Edit”

button.
Resource Code E304 * | UNIFORM
Reeturn Status NO Request Date 01/07/2004
Special ID E0QO7
Cuantity 18 Size 3
Remark NEW ZTAFF

2. Make the necessary amendment in the relevant field(s).

3. Click “Save” button to update the changes.

To delete resource requisition
1. At the respective employee’s record, select the unwanted requisition.
2. Click “"Delete” button.

MESSAGE X

P

i 7
“““‘:r/ Are wau sure you wank ko delete this recard?

[ es ] [ Mo l

3. Select “Yes” button if confirmed to delete the request item. Otherwise, select "No"” button to
disapprove the deletion.

To approve resource requisition

There are two levels of approval/authorization.
(i) HOD Approval

1. At the respective employee’s record, locate the particular resource requisition ready to
be approved. Click “Edit” button.

Approved Date 0&/07/2004 Approved Dake Y

Approved By FO0o4 Approved By
Issue Date Y Expected Return Date Y
Remark (2)

Save Cancel

2. Tick on the HOD Approval checkbox. The system will display the Approved Date and
Approved By according to current system date and login user.

3. Click "Save” button to update the approval.
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(ii) Final Approval

1. At the related employee’s record, select the particular resource requisition. Click “Edit”

button.
HOD Approval Final Approval
Approved Date 05/07 /2004 Approved Date 09/07/2004
Approved By E004 Approved By UBS
Issue Dake 09/07/2004 Expected Return Date 01/11/2004
Remark (2) ACCESS CODE EXPIRES

Save Cancel

2. Tick on the Final Approval checkbox. The system will display the Approved Date and
Approved By according to current system date and login user.
3. Then, enter the relevant information:-

Issue Date : Date when the particular resource item issued and handled over to the
respective employee.

Expected
Return Date : Date when the employee is expected to return the resource item back
to the employer.

Remark (2) : Enter additional notes if applicable (maximum 50 characters).

4. Click “Save” button to update the approval.

Note:

Expected Return Date only will be enabled for user input if the
resource’s Return Status was determined as Yes. If Return
Status is No, users do not need to enter the expected return date.

2.3.2 Resource Approved
Menu Location: Application/Approval > Resource - Resource Approved
Description: For a staff, this option enables user to view the approved resource items. For an
authorizer or system administrator, this option allows user to track and update return status
for the resource items.

We will review the authorizer/system administrator’s functions and screen menu.
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X

Employee Mo, EO007

Name | LINDA 00I POH POH

Department MEET | marrETIHG

Fequest Date  Resource Code Description Return Status Special ID ~

¥ |
| [01/07/2004 |R504 UNIFORH o
| [01/07/2004 |R307 COMPANY BADGE TES E007
| [05/07/2004 |RS02 NOTEEOOE TES M253-5<
| [06/07/2004 |R308 SAFETY BOOKLET o
| [15/07/2004 |RS01 HANDPHONE TES HOEIA £
I v
I 5 |
l First ” Prewvious " Text " Last ] l Edit " Delete H Search l

The footer of this sub-menu will show the Employee No, Name and Department.

The table will list out other information such as request date, resource item, return status and
its special id. Scrolling to the right of the table will reveal more details of each approved
resource requisition, including quantity, size, issue date, expected return date, return date and

return condition

To update returned resource

Users can only process updating for resources with Return Status" Yes".

1. At the respective employee’s record, select the resource item to update.

2. Click “Edit”

button.

Employee Ma. EOQ7

Marme -LIHDA 0oz PDH-PDH

Departrent .-I‘IRKT MRKETING

Resource Code -RSDZ -;-ﬁUTEBDDK

Return Status .-YES Request Date iILS;’U?‘;‘ZUU*I

Special ID :H253—54? . ”

Cuuantity | 1 3 Size

Remark COMPAQ IZ53

Issue Date 10;07;2004 - -_ Expected Return Date

Remark (2] PRODUCTS PRESENTATION

HOD Approved Date ;"DB,-’III'II‘,-’ZDD4 Final Approved Date 10/07,/2004
Appraved By EUU4 — ] Approved By U'BS D
Return Date : 03/10/2004 ] Return Condition _Gggd

Remark (3] |END OF PRESENTATION

Save Zancel

| 30/11/2004

** Modify Resource Approved g]

3. Enter the relevant information:-

Return Date

: Enter the date when resource item returned.

COPYRIGHT © UBS CORPORATION SDN BHD



[ |
L U§§ Human Resource Management User Manual Page 104 of 223
Return Condition. Good, Loss, Damage or Other.

Remark (3) : Enter notes pertaining to resource return matter (maximum 50
characters).

4. Click “Save” button to update the returned resource.

To delete approved resource requisition

Users are not allowed to delete resource requisitions that have been issued or returned.
(Requisition that has Issue Date and/or Return Date)

MESSAGE x|

\:!J) Cannot delete!Resource has been issued or return!

1. At the respective employee’s record, select the unwanted requisition.

2. Click “Delete” button.

MESSAGE

? e
\:/ Are wou sure you wank fo delete this recard?

[ Yes ] [ Mo l

3. Select “Yes"” button if user confirmed want to delete the requisition. Otherwise, select
“No" button to disapprove the deletion.

Note:
1. For resources requested but not yet approved, staffs can modify or delete the
requisition.

2. For requisitions with one approval granted, staffs will be restricted to edit the
requests but can view the contents. However, staffs will be totally prohibited to delete
the request any more.

3. After two approvals obtained, the staffs can only view the resource requisitions in
Application/Approval > Resource > Resource Approved.

2.4 Performance Appraisal

Performance appraisal/Job Assessment is to be conducted to evaluate the employees’ progress, aims
and needs at work.

By default, the system will provide sample values for appraisal’s selecting option, but users can add
or edit the existing data to suit their needs and requirements.
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Go to HR Department > Miscellaneous Files (2) - Areas of Appraisal to setup assessment

fields or evaluation subjects.

Go to HR Department > Miscellaneous Files (2) > Appraisal Rating to grade the rating point.

Go to HR Department > Miscellaneous Files (2) > Appraisal Resultto measure grading

result in range.

2.4.1 Appraisal Submission/Approval

Menu Location: Application/Approval > Performance Appraisal > Appraisal

Submission/Approval

Description: This option enables users to submit and approve the job performance

appraisal/assessment/evaluation.

&

** Appraisal Form Pending for, Submission
Employee MNo. E004
Mamne TAN MING LING
Department R&D RESEARCH & DEVELOPMENT
Jab Title RDOZ SYSTEM ANALYST
Date Join 07,/04/2000 Curtent Salary 2600.00
Emp. Agree HOD Approval Appraisal Mo.Review Type Assessed By Assess Date  Submit to HOD Date Approve Date | #
Pending!|Pending! |RDOS Tear End [E004 03/07/2004/ F ;4
Pending! EOOL Bonus E004 0l/07/200401/07/2004 03/07/2004
Pending! (FD1 Promotion (EO04 01/07/200401/07/2004 ;A
f |
l First " Previous " Text " Last ] l Add " Edit H Delete H Search ]

hd

The footer of the menu shows the employee’s details including the Employee No, Name,
Department, Job Title, Date Join and Current Salary.

Current Salary field will only be shown in superior or system administrator’s menu.

The table will indicate whether the particular appraisal has been submitted, agreed or
approved. Apart from that, it will indicate by whom and when the assessment was done.

To input appraisal items

1. At the respective employee’s record, click “*Add” button to create a new appraisal form.
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** Appraisal Submission EJ
Employes No, E00S ANDY LOO CHIN 3IN |
Department MEET [ MAREETING Date Join 01/07/200L
Job Title 5L02 | SALES EXECUTIVE |
Type of Review ..MID YEAR v Appraisal Ma. .MU4]_
Areaof Appraisal | ATTENDANCE & DEPENDAEILITY v| [¥] appiicable
Frequency of absences/lateness and reliability in meeting comnitments. "_
v
Performance Rate 5| Remark. | b
Percentage (%) 50,00 v
Recommendation
Proposed : Mew Salary ! ] Bonus [ . Comment . Al
Allowance | Effective Date P v
[Jsubmit taHOD | ;o [CJEmplavee Agree
Aissessed Date 08/07/2004 | Agreed Date @ o FEERESE: ‘s
assessed By .EDDS Agreed By | Approved By |
l Rating Table ” Result Table " Yiew Full List ]

2. In the Appraisal Submission sub-menu, enter the relevant information:-

Type of Review

Appraisal No

Select purpose of assessment, such as Bonus, Confirmation,
Promotion, Mid Year, Year End or Other.

: Specify each appraisal with an identical code not more than 4

characters.

Area of Appraisal : Click at the arrow down button to determine assessment field.

Applicable

(New area of appraisal other than the exiting data can be created in
HR Department > Miscellaneous Files (2) > Areas of
Appraisal.)

: Tick this checkbox to apply and include the selected Area of

Appraisal.

Performance Rate : This field will be enabled only after user has selected an Area

Remark

of Appraisal and tick Applicable checkbox. The figure enter must
be according to the setup in HR Department > Miscellaneous
Files (2) - Appraisal Rating. Alternatively, user may click
“Rating Table" button to access quick view of rating.

: Enter brief comment or explanation note pertaining to the appraisal

decision.

Press “Rating Table’ button at the bottom of the menu will display the rating point setup at
HR Department > Miscellaneous Files (2) > Appraisal Rating.

** Rating Table X
Foint Rate Group Explanation Al
§|Very Good Consistently exceed expectations and job requirements
6| Good Consistently meets expectations and job requirements
A|Average Meet minimum expectation and minimum requirements for job
2|Poor Failz to meet minimum expectations and minimum requirement:
|
I« >
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Total Performance Rate
Percentage (%) = x 100
Max Rating Point x Number of
Area of Appraisal

3. After completing the first item, select the next item in Area of Appraisal. Tick the
checkbox labeled Applicable. Enter the Performance Rate. Repeat this step until
evaluate all appraisal areas.

Based on the Rating Table of the system, example of calculation can be illustrated as below:-

Item | Performance Rate Calculation Percentage (%)
: 10 10 100
----------- x 100
10x1
5 8 10 + 8 90
----------- x 100
10x 2
3 7 10 + 8 +7 83
---------------- x 100
10x 3
4 5 10 + 8 +7+ 5 75
------------------- x 100
10 x4

4. Tick the checkbox labeled “Submit to HOD" (at the bottom left of the module) if user
confirmed correct. Assessed Date and Assessed By will display current system date
and login user.

[VISubmit ta HOD i | 09,/07/2004

Assessed Date na/07s2004
Assessed By E0O5

5. Click “"Save” button to submit the appraisal form.

Note:

1. If Submit to HOD checkbox was not tick, the superior
or system administrator will not be able to view and
access the particular appraisal form.

2. An appraisal form once submitted cannot be reversed.
In other words, the ticked checkbox cannot be
unmarking.

7

To verify/check appraisal form
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1. At the respective employee’s record, select the particular appraisal form.

2. Click “Edit’ button.

3. In the Appraisal Submission sub-menu, click the last button labeled * View Full List’
located at the bottom of the module. Users will be able to view the appraisal contents in
Employee Performance Appraisal Report.

Press “Result Table’ button at the bottom of the module will display segregation of result in
percentage range, as per setup in HR Department > Miscellaneous Files (2) >

Appraisal Result.

* Result Table (X
[ Percentage From Percentage To Resuit Group Expianation A
[ |
| 40 49 Average

50 64|Good

65 79(Very Good

a0 100|Excellent
| v
I«

To modify appraisal

A staff will be disabled to modify or change the contents of appraisal once it has submitted to
HOD (after staff tick the checkbox Submit to HOD). Only the superior or system
administrator is allowed to perform the modification of the contents.

1. At the respective employee’s record, select the particular appraisal form.

2. Click “Edit” button.

** Appraisal Submission EJ
Employesbo. | E00S ANDY 100 CHIN 5IM |
Department MRET | MARKETTNG Diate Jain 01/07/2001
Job Title: [ SLO2 I SALES EXECUTIVE [ Current Salary 2200, 00 [
Type of Review 'IMID TEAR “ | Appraisal Mo, .Mg4]_
Area of Appraisal ATTENDANCE & DEPENDABILITY | [¥] aipplicable
Frequency of absences/lateness and reliability in meeting commitments. ~
v
Performance Rate | ] Rematk |mo ;. b
Percentage (%) 45,00 1 Full attendances. b
Recammendation Highly rated to be promoted as unit leader for Chief Executiwve team &
Proposed : Mew Salary 0.00 | Bonus | 0.00 | Comment, A
Aloviance | 0. 00 | Effective Date P [ w
[03/07 /2004 | [emplayee Agree [1HoD Apprave
assessed Date [nssa77200a | Agreed Date 2 | Approved Date /o
fssessed By .EDDS Agreed By | Approved By

l Rating Table " Result Table ” Wiew Full List ]

The above screen shot is captured from the system administrator’s view. Observed that the Current
Salary is showing the salary figure of the particular employee (at the top right of the module). And,
at the bottom left of the module, the checkbox Submit to HOD was disabled for any change.
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3. Make the necessary amendment on the relevant fields. Users may input Remark for
individual appraisal item or Recommendation proposed for the particular employee.

4. Click “Save” button to update the modification.

To agree appraisal

This action is to be performed by the staffs after the appraisal was conducted and assessment
was duly evaluated.

1. Login as staff, select the evaluated appraisal form.
2. Click “Edit” button.
3. At the bottom of the module, find the section located at the center, tick the checkbox

labeled “ Employee Agree’. The system will display Agreed Date and Agreed By
according to current system date and login user id.

[VEmployee Agre
Agreed Date 13/07 /2004
Agreed By E005

4. Click “Save” button to agree/consent to the appraisal.

To approve appraisal

1. At the respective employee’s record, select the particular appraisal form.

2. Click “Edit” button.

** Appraisal Submission @
Employeeo.  |E00s muDY 100 CHIN SIH
Department MRET IMRRETING . Date Join 0170772001
Job Tide |s102 SALES EXECUTIVE Current Salary | 2200.00'_
Type of Review HID YEAR v Appraisal Mo, no4al
Area of Appraisal ATTENDANCE & DEPENDAEILITY v [¥] applicable
Frequency of absences/lateness and reliability in meeting conmitments. 8|
|
Performance Rate B | Rermark Ho HC. Aj
Percentage (%) Full attendances.

85.00 »

Recommendation Highly rated to be prowmoted as unit leader for Chief Executive teamw &

Proposed ! Mew Salary 2500, 00 | Bonus 0.00 | Caomment Propose to in charge for A
llbmante 0000 et Tt 01/08/2004 Northern Region Marketing team G
054072004 Employee Agree
e 09/07,/2004 Agreed Date 13/07/2004 fipproved Date 14/07/2004
Assessed By E00S Agreed By EO0G | Approved By ES

l Rating Table “ Resulk Table “ Yiew Full List ]

3. Enter the proposed New Salary, Allowance and Bonus, if applicable. Input the
Effective Date for the new adjustment. Key in Comment for the decision.

4. Next, tick the checkbox labeled “ HOD Approve’. The system will display Approved
Date and Approved By according to current system date and login user.
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5. Click "Save"” button to approve/complete the appraisal.

To delete appraisal

1. At the respective employee’s record, select the appraisal form to be deleted.

2. Click “Delete” button.

\;’:’) Are wou sure you want bo delete this record?

[ L= ] I Mo ]

3. Click “Yes” button if confirmed to delete the appraisal form. Otherwise, click "No” button
to deny deletion.

Note:
1. The appraisal form can only be deleted by whoever initiated or created the form.

2. As a staff, appraisal form once submitted cannot be deleted.

3. As a staff, appraisal form once approved will be strictly prohibited from deletion.

e

\1;) Zannot delete! The review is not assessed by woul

This error message indicates that users cannot delete the appraisal which was not
created/assessed by him/her.

\:!_') Cannot delete! The review has been submitted to HOD For approvall

This error message indicates that users cannot delete the appraisal which has been submitted to
HOD for approval.

1 ,} Cannot delete! The review has been approved by HOD!

This error message indicates that users cannot delete the approved appraisal.

COPYRIGHT © UBS CORPORATION SDN BHD



UBS

User Business System

2.4.2 Appraisal Submitted

Menu Location: Application/Approval
Submitted
Description: This option enables users to

Human Resource Management User Manual

Page 111 of 223

-2 Performance Appraisal > Appraisal

view appraisal forms submitted and approved by

HOD. It also allows the highest management to perform final review on the appraisals.

** Appraisal Submitted

Employee No. EO0S
Mame ANDY LOO CHIN 5IM
Department MEET | MARFETING
Job Title 5L02 | SALES EXECUTIVE
Date Join | 01/07/2001 Current Salary 2200, 00 Wien Full List
Finai Approvai Skatus P.ppraisai Mo, Review Type P.ssesseci By #Hssess Date SuEmit to HOD Date Percentz # ||
) |
Mo4l HMID YEAR E00S 09/07/2004 |09/07/2004 §5.00
b 1
I« 3 |
[ First ” Previous ” Mexk ” Last ] | Edit J[ Delete ” Search ]

The footer of module is showing Employee No, Name, Department, Job Title, Date Join
and Current Salary. However, Current Salary can only be seen in superior menu including

HOD and system administrator.

The table will summarise the assessment details. It will indicate the Final Approval Status
of all appraisals submitted. Scrolling towards the right of the scroll-bar will disclose more
information. Select and press “ View Full List’ button will preview contents of the appraisal.

As there is no user action can be performed by staffs, therefore, we shall look from the

highest management’s perspective.

** Modify Approved Appraisal

Emplayee Mo, E005 | ANDY LOO CHIN 3TM
Department | mrET MARKETING Date Jain | 0170742001
Jab Title sL02 [ SALES EXECUTIVE Current Salary 2z00.00
Type of Review | YEAR END v Appraisal Mo, Mmoo
Area of Appraisal | ATTENDANCE & DEPENDABILITY | [“] &pplicable
| Frequency of absences/lateness and reliability in meeting commitments. e
b
Performance Rate _. a Remark ~
Percentage (%) 80,00 »
Recommendation | Propose salary increment
Proposed : New Salary 2300.00 | Bonus 0.00 | Comment Highly rated staff. A
Allovwance 120,00 | Effective Date | 01/02/2004 v
Submitted ko HOD Date |01/01/2004 | Agreed Date :03/01/2004 | HOD Approved Date |03/01/2004
Assessed Date | 01/01/2004 Agreed By EDDS Approved By EOD4
Assessed By E00S
Final Review Final Approval Status .APPRUVE v |
Reviewed Date _.13/07/2004 | | Final Comment Candidate for prumutiun.. A
Reviewed By | UBS b
i Rating Table " Result Table " ‘igw Full List l

3

1.

At the respective employee’s record, select the appraisal form pending final approval.
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2. Click “Edit” button.
3. At the bottom of the module, tick the checkbox labeled “ Final Review'. The system will
display the Reviewed Date and Reviewed By according to current system date and

login user.

4. Then, select the Final Approval Status, whether it is Approve, Not Approve, Change &
Approve or Other.

5. Next, input Final Comment as the conclusion of the evaluation.

6. Lastly, click “Save” to completely approve the appraisal.

Note:
1. In this module, staffs can only view the status summary and the appraisal’s contents,
but are prohibited to edit or delete the appraisal form.

2. If final review has been authorized, HOD can still assess but cannot edit the appraisal
form.

3. Superior or system administrator can use this module to delete unwanted or error
appraisal form submission.
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Chapter 3 ENQUIRY
Overview:

The system facilitates users to perform database enquiries on certain areas for ease of reference and
tracking purposes. Important information in the form of reminder will prompt users to take action on it.

There are 8 types of reminder enquiries, including birthday, reward action, disciplinary action, employees’
confirmation, employees’ termination, retraining notice, work permit expire notice and passport expire
notice.

Users may setup the reminder notification pop-out menus to keep users well informed on matters that
need attention. Go to Housekeeping > Setup > Enquiry Setting to perform the setting. Users may
determine the reminder item(s) to alert them and define the number of days in advance to remind them.
Please refer to chapter 6.1.2 for more details.

The reminder menu(s) will pop out to prompt user for attention every times when user login UBS HRMS,
if the item(s) still outstanding and pending user’s action.

3.1 Birthday

Menu Location: Enquiry - Birthday
Description: This option will display list of employees who will be celebrating their next birthday in
the next couple of days, depends on the number of days in advance the users preset to remind them.

** Birthday Reminder. g|
Ernp. Mo, Mame Dept, Code Line Mo, Category Date of Birth  Day -
) [
E0O7 LINDA OO POH POH MRET 24/07/1980 1
E0D& ROBERT LIM HUI MIN HR 30/07/1968 7
E0O5 ANDY LOO CHIN 3IM MRET SALE3L SALESINEW [05/05/1973 13
EODZ WILLIAM 00T SIM HUI RsD RD'L RDICTUR 06/08/1975 14

Emp. HNo.

Users may determine the number of days in advance to notify them before the birthday is
approaching. Go to Housekeeping > Setup > Enquiry Setting

Users may choose to sort the listing in different format. Select the Order By arrow down button to
sort the data.

If the Day is indicating as zero, the employee’s birthday is today. If the Day shown as 1, it means
that the employee’s birthday is one day after today, which will be tomorrow.

3.2 Reward
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Menu Location: Enquiry > Reward
Description: The system will prompt users with a listing of defined number of days in advance for

reward action to be taken in favour of the employees.

Prior to this, users must maintain the employee’s reward action details in HR Department >
Employee > Reward & Disciplinary. In order to see the effect in this module, users must specify
the Action Taken Date in the Employee Reward/Disciplinary Maintenance menu.

** Reward Reminden @

mp. No, Mame Dept. Cm:ia Line Mo, Category Date Inikiate  Action Date Action Day |
E004 TAN MING LING RsD RD2 PDZNEW 30/06/2004 |GIVE ATTENDANCE ALLOW10/07/2004 9
E00L AGNES TAN ¥ING ¥INACCT 25/06/2004 |RM 100 CASH GIVEN BY |15/07/2004| 14

M d

Order BY | pate Action, Emp. No. hd

Based on the sample screen shown above, assume that current date is 01/07/2004.

The first reward record was initiated on 01/06/2004 and the planned date for action to be taken is
01/07/2004, which the current date, therefore, the system will indicate Day as zero.

The second reward record is planned on 10/07/2004, which is 9 days later after current date.

3.3 Disciplinary

Menu Location: Enquiry - Disciplinary
Description: The system will prompt users with a listing of defined number of days in advance for

disciplinary action to be taken against the employees.

Prior to this, users must maintain the employee’s disciplinary action details in HR Department >
Employee > Reward & Disciplinary. In order to see the effect in this module, users must specify
the Action Taken Date in the Employee Reward/Disciplinary Maintenance menu.

** Disciplinary Reminder

mp. Mo, Mame Dept, Code  Line Mo, Cateqgory Date Initiate  Action Date Action  Day |
E0DS ANDY LO0 CHIN SIM [MRET SALESL SALESINEW [25/06/2004 |ISSUE 13T WARNING LET[05/07/2004 4

-
Order By | pave Action, Enp. No. L
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3.4 Confirmation

Menu Location: Enquiry - Confirmation
Description: This reminder option will display summary of employees whom are yet to be confirmed

by the company.

** Confirmation Reminder @

i mp. Ko, Name Dept, Code  Line No, Categary Job Code Date Join Date bo be ConfirmedDay  Confirm Mty

E006  |ROBERT LIM HUI MUN  [HR ACD1  |15/01/2004(15707/2004 5 3

v
OrderBy | Date Confirm, Emp. No. by

Confirm Mth is the confirmation month according to the setting in Housekeeping > Setup >
General Setup - -> Others or Housekeeping > Setup > Default Setting > Confirmation

Month.

Date to be Confirmed is the suggested confirm date for the particular employee. Once a date had
been inputted in Date Confirm at Personnel File Maintenance, the respective record will be
removed from this reminder list.

Based on the sample screen shown above, assume that current date is 10/07/2004.

The first record indicates that this particular employee should be confirmed on 02/07/2004 but not
yet does so. Her confirmation was 8 days overdue.

The second record indicates that there is a forthcoming confirmation (6 days in counting) to be done
for the respective employee.

3.5 Termination

Menu Location: Enquiry - Termination
Description: This option enables users to check the employees who are leaving the company for
reason of service terminated due to resignation, retirement, retrenchment, dismissal or others.

** Termination Reminder g]

Erp. Mo, Mame Dept. Code Line Mo, Category Date Terminate Day -
EQ07 LINDA 00I POH POH MRET |Ulf’07/2004| 0

TEST3 [ALEX TEOH LAI HOCK PURC 0270772004 il
M

Order BY | pate Terminate, Emp. No. W
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Date Terminate is the date when termination of service takes effect (information as per Personnel/
File Maintenance module).

Based on the sample screen shown above, assume that current date is 01/07/2004.

The first record with the Day shown as zero, was the employee who left the company yesterday
(last working day on 30/06/2004 and termination of service takes effect 01/07/2004 today). User
must go to HR Department > Employee - Personnel File - -> Job to change the Pay Status
to “Non-Active'.

The second record with Day shown as one, is the employee who is on his final day in the company
(termination of service with effective from 02/07/2004 onwards).

The third record is the employee who will be leaving the company in the next 30 days (termination of
service takes effect 31/07/2004).
3.6 Retraining

Menu Location: Enquiry - Retraining
Description: This option enables users to check the planned retraining date for the employees.

** Retraining Reminder

Emp. Mo, Mame Dept. Code  Line Mo. Category Prog. Code Skill CD\:ie Skill Description Date Retrain  Day A
E00Z |WILLIAM 00T SIM HUJR&D RD1 RD1CIR PCOL SCO06 SAFETY GIUIDE 030642004 | -28

w

E0D4 |TAN MING LING RaD RD2 RDZNET PCOL 406 SAFETY GUIDE 03/08,2004] 33

»

Date Retrainis the same information extracted from HR Department > Training > Training
Program --> (Add/View Trainee).

All records will be listed as reminder items until the respective employees have attended the same
relevant skill code training again. For instance, record of employee E002 will be listed permanently
until he has attended skill code SCO06 retraining course again.

3.7 Work Permit Expire
Menu Location: Enquiry > Work Permit Expire

Description: This module reminds users of the employees’ work permits which are already or going
to be expired.
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** Work Permit Expire Reminder.

[ .kmp. No. .i\.léme Dei:ut. Codé Line No. .C.a.tegory Ex.ﬁi.re.DéEe Dray A
| [EO0S ANDY LOO CHIN SIM MRET SALES1 SALEJINEW (3070672004 -1 |

“

Crder BY | Expire Date, Emp. Nao. b

Expire Date shown in this module is the same related information maintained by user in HR
Department > Employee > Personnel File - -> Statutory.

The records will be shown permanently in this reminder until user has updated the new work permit
details into the Personnel File Maintenance.

Based on the sample screen shown above, assume that current date is 01/07/2004.
The work permit for employee EQ05 has already expired and overdue one day; whereas the work
permit for second employee will be expired on the next 42 days.

3.8 Passport Expire

Menu Location: Enquiry - Passport Expire
Description: This module reminds users of the employees’ passports which are already or going to

expire.

** Passport Expire Reminder

i—:mp. Mo, Mame Dept, Code Line Mo, Category Expire Date Day i
EO0S ANDY LOO CHIN SIM MEET SALESL SALESINEW (01/710/72003)-274

LS

Crder By | Expire Date, Emp. No. o5

Expire Date shown in this module is the same related information maintained by user in HR
Department > Employee »> Personnel File - -> Statutory.

The records will be shown permanently in this reminder until user has updated the new passport
details into the Personnel File Maintenance.
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Based on the sample screen shown above, assume that current date is 01/07/2004.

Employee E005’s passport has already expired or information never been updated again since the
last expire date.

The passport for the second employee will be expired in coming 25 days and it should be renewed.

COPYRIGHT © UBS CORPORATION SDN BHD



ssssssssssssssss n Human Resource Management User Manual Page 121 of 223

Human Resource Management

User Manual

(Reports)

COPYRIGHT © UBS CORPORATION SDN BHD



Human Resource Management User Manual

CONTENTS
Chapter4 Report
4.1 Country Listing
4.2 Employee
4.3 Employee Analysis
4.4 Leave
4.5 Claim
4.6 Loan
4.7 Skill
4.8 Training
4.9 Resource
4.10 Tip
4.11 Manpower Plan vs Actual Report
4.12 Budget Plan vs Actual Report

COPYRIGHT © UBS CORPORATION SDN BHD

Page 122 of 223



[ |
L U§=§ Human Resource Management User Manual Page 123 of 223
Chapter 4 REPORT

Overview:

There are 3 broad categories of reports available in the UBS HRMS. A listing report will summarise
and display records sorted by a particular order. A historical report will show database details and
history for ease of reference and checking. Another type of reports analyze and compare data to
produce more meaningful information to the users.

The following are the printing options available for user’s action after user has specified the sorting
parameters at each menu:-

= i e

[ Prirt ] ’ Previsw l l File: ]

[Cgstomize] ’ Printer l

Default Printer: ', UBS-SERYER'HP LASERJET 1100 {MS)

Print Option
Print : send the file to printer to produce a printout
Preview : view the actual report on screen
File : generate a text file

Customize : open and view the customized report format
Printer : select the name of the printer to be used
Close : exit this print option box

4.1 Country Listing
Menu Location: Report > Country Listing

Description: This report will list out all countries available in the system for user selection in the
employee personnel file maintenance.

** Country Listing

Country Listing

Order By
@ Country Code O Country Mame

There are a total 232 country names in the report, sorted according to country code. Countries
listed represent the nationality of the employees. Data is used in the employee’s personnel file
maintenance.

4.2 Employee
4.12.1 Employee Personal Details Report

Menu Location: Report > Employee > Employee Personal Details Report
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Description: This report consolidates information maintained in employee personnel file
maintenance module. It displays the employee’s personal particular, statutory records such
as EPF, Socso, passport/work permit details, job details, family summary and benefit
entitlement such as leave, claim and tip.

Tick on the checkbox to expand the menu for more specified selection and extraction of data
to be displayed.

Mare Filker Parameters

~* Employee Personal Details Report

Employee Personal Details

Employee Mo, From E] To |zzzazz E] Job Code From [ E] To |zzzz E]
Dept, Code From E] To | EEEEETEEET E] Job Status From E] To | zz E]
Line Mo, From E] To zzzzzzzzzz: E] Eranch Code From [ E] Ta ZZZZ E]
Cabegory Code From E] To | ;zwz.zz.zzzz.z' E] Leave Scheme From B Tao ZZEZZ B
Date: Join From 01/01/2004 To |31/12/2004 | Claim Scheme From B To |zzzz B
Mare Filter Parameters Date From -

Badge No. Fram B To |zzzzzzzzzz E] DOB /o To L
Mationality From B Ta ZE E] Passport Expire ,f s To ,f 7

Sex |aL1 v | werkPermit valid ;o To | 4o

R (a1 v Work Permit Expire ;s To | ;o4

Burniputra Ail w | Confirm ;F To /A

Pay Status ;Ml ~l| Promote / / To / /

Highest Education Qualification |all v. Terminate F To F

Tip Scheme Code From E] To i ZZEZ E]

4.12.2 Employees Personal Listing

Menu Location: Report > Employee > Employees Personal Listing
Description: This report summarise the employee database and listing the employee number,
name, badge number, department, job title and date join.

Users may sort the data by any of the 4 methods by selecting the respective option button.

Order By
@ Employes Mo, O Mame O Date Join O Departrment

In addition, users may also choose to filter the database by a specified option so that to list
only those data that is matched with the criteria defined. Tick on the checkbox labeled
“More Filter Parameters” to expand more selection options.

** Employees Personal Listing

Employees Personal Listing (Summary)
Order By Job Code From | E] To |zzzz E]
@ Employee Mo, () Name (O bate Join () Department et I E] . P E]
Emplayee Mo, From E] To zzzzzz E] Branch Code From | E] To EZZE B
Dent. Code From E] To | zzzzzzzzzzl B Leave Scheme From E] To | zzzz E]
Line No. From ] [ﬂ To |zzzzzzzzzz | [ﬂ Claim Scherme From E] To |zzzz E]
Category Code From B To |zzzzzzzzze E] Tip Scheme Code From | E] To EZEE E]
Date Join From 0170172004 | |31/12/2004 Date From:-
Mare Filter Parameters DCE ;oA Ta ;S
Badge Mo, From [ E] To | :4:4:4:44-4.4 444 E] Passport Expire 2 To i
Mationality Fram :E] To zz“ ) 'E] “wiork Permit Valid / - To P
Sext Aall v “wark Permit Expire R} To s
Race ALL v Corifirm ;od Ta o
Bumiputra All L3 Promote F To 2 r
Pay Status 311 . Terminate ,f ] ! To Fi
Highest Education Qualification :;All v
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4.12.3 Employees Children Listing
Menu Location: Report > Employee > Employees Children Listing
Description: This report will display the employee’s children’s name, new ic number, gender
and date of birth.

Tick this checkbox if users want to list out information of those active employees only.

Active Employee Only

** Employees Children Listing

Employee Mo, From . :E]
Employes Mo, To ZZEZEEZ B
Active Employves Only

4.12.4 Employee Education Background Report
Menu Location: Report > Employee > Employee Education Background Report

Description: This report will display the employee’s education background with details
including the course name, date begin, date complete and grade obtained.

** Employee Education Background Report E|

Employee Education Background Report

Employee Mo. From B
Employvee Mo, To . f:4:4:4:4:4:4 E]
Active Employes Only

4.12.5 Employee Employment History Report

Menu Location: Report > Employee > Employee Employment History Report
Description: This report will display the employee’s employment history including date join,
date left, previous company name and job title.

** Employee Employment History Report

Employee Employment History Report

Emnployee Mo, From [ E]
Emplaoyes Mo, To [ zzzzsz E]
Active Employes Only

T PR

4.12.6 Employees Salaries Listing

Menu Location: Report > Employee > Employees Salaries Listing
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Description: There are two types of listing reports. The summary report will display the
employee’s latest effective salary. The detailed report will display the employee’s all effective
salaries in his/her employment history.

Users may select to display different type of report by ticking the respective option button
“Summary' or " Details’.

** Employees Salaries Listing

Employees Salaries Listing

Type

{(*) Summary () Details
Employes Mo, From [
Employves Mo, To . EEEEEE

Dept. Code From

OEOE

Dept, Code To | zezzeEzEEE
Active Emploves Only

=

4.12.7 Employee Tip Listing

Menu Location: Report > Employee > Employee Tip Listing
Description: The summary report will display the employees’ latest effective tip point/amount.
The detailed report will display the employees’ tip point/amount history.

Users may choose to sort the database by order of employee number, department, job code
and scheme code.

And, users may also specify to list the employees with or without tip scheme or even both
categories. Without scheme refers to those employees who were not assigned with any
specify tip scheme and the tip details are maintained individually.

** Fmployee Tip Listing

Employee Tip Listing

Order By

'@ Employee Mo, O Department

) Job Code () scheme Code

Repart Type

(%) Summary () Details

Tip Scheme

(%) Both () With Scheme Only ) without Scheme Only

Emploves Mo, From | To | Z2ZZEE

Dept, Code From To |zzzzzzzzzz

Line Mo, From To | ZZZEZEEZEZEZEE

Job Cade Fram To | zzzz

MOOEE
OOOEM

Scheme Code From To |zzzz

Active Employves Only
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4.12.8 Employee Working Experience Report

Menu Location: Report > Employee > Employee Working Experience Report
Description: This report will list the employee’s working experience details as per
maintenance by user.

** Employee Working Experience Report

Employee YWorking Experience Report

Employee Mo, From E]
Emplovee Mo, To EEEZEZE E]
Active Employes Only

T

4.12.9 Employee Society Participating Report

Menu Location: Report > Employee > Employee Society Participating Report
Description: This report will display the employee’s participation history in society/club/team
with information such as date join, date left and position held.

** Employee Society Participating Report g‘

Employee Society Participating Report

Order By
(%) Employee Mo, () Society Name

Employes Mo, From

Employes MNo. To ZZZZZE
Dept. Code From .
Dept, Code To EEZEZZEZEE
Line Ma. Fram

Line Mo, To jzzzzzzzzzz
Cateqaory Code From o
Category Code Ta lzzzzzzzzzz

Society Marme From

< |2 OO

Society MName To

Active Employes Only

il

This menu enables users to classify the database by society’s name, if there are many
employees joining the same society/club/team.

4.12.10 Employee Reward/Disciplinary Report
Menu Location: Report > Employee - Employee Reward/Disciplinary Report
Description: There are two categories of reports, reward or disciplinary type. The summary
report will indicate the action taken, whereas the detailed report will indicate the action

details and also type of action taken.

Users may specify to list the data within certain period of initiate date and action taken date
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** Fmployee Reward/Disciplinary Report rg|

Employee Reward/Disciplinary Report

(%) Detail () Summary

Type
) preward () Disciplinary {*) Reward & Disciplinary

)
M
)
)

Employes Mo, From

Ernplayee Mo, To ZEEZZE
Dept. Code From

Cept. Code To ZEZEZEZEEE
Initiate Date Fram 0l/01/z004 |
Initiate Date To 3171272004 y
Action Taken Dake From N
Action Taken Date To [ J.f ,a'

Active Emploves Only

Cancel

4.12.11 Employee Accidents Report

Menu Location: Report > Employee - Employee Accidents Report
Description: This report will display the accident history recorded by user for their employees.
It includes the accident date, details, effect and correct/preventive action.

** Employee Accidents Report

Employee Accidents Report

Employee Mo, From [ E]
Employee Mo, To LEZELE

Dept, Code From

Dept, Code To LEZELEZEZDE

| o
Accident Date From 01/01/2004
Accident Date To |31/12/2004 |

Active Emploves Onky

ERrn

4.12.12 Employee Career Movement Report

Menu Location: Report > Employee > Employee Career Movement Report
Description: This report will display the employee’s career movement history with details
including date of transfer, original and new branch, department, job; person who
recommend and approve the transfer.

** Employee Career Movement Report §|

Employee Career Movement Report

Emplovee Mo. From | |E]
Employee Mo, To [ EZEEZE |E]
Date Change From |o1s01/2004 |

Date Change To
Active Employes Only
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4.12.13 Employee Birthday Listing

Menu Location: Report > Employee > Employee Birthday Listing

Description: By default, the system will display the employee’s hame whose birthday falling
on the next coming month. It will list the employee’s nhame, department, line number,
category, date of birth and age.

** Fmployee Birthday Listing

Employee Birthday Listing

Order By
() Emplavee Mo, (%) Birthday () Department

Employes Mo, From

Employes Mo. To ZEZZEZE
Dept. Code From :

Dept. Code To ZEZZEEZEEE
Lire Mo, Fram : l
Line Mo, To :zzzzzzzzzzl

Category Code From

KR KK

Cateqory Code To EEEEEEZEEE
Brithday From |01/08/2004 |
Birthday To | 31/08/2004 ;
Active Employes Only

ekl

4.12.14 Employee Age Report

Menu Location: Report > Employee > Employee Age Report
Description: This report will list the employees’ age as at current year. The report can be
sorted by employee number, age or department.

** Fmployee Age Report

Employee Age Report

Order By
@ Emplovee Mo, O Age C:} Department
Employee Mo, From
Employee Mo, To . ZZEZZZZ

Dept, Code From

OO0

Dept, Code To | EZEEEEEEEE
Active Employves Only

e e

4.12.15 Employee Resignation Report
Menu Location: Report > Employee > Employee Resignation Report

Description: This report will list name of the employee, department, job title, date terminate
and reason of leaving the company.
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Users may specify to list all records or only for a specified termination reason such as
resignation, retirement, retrenchment, dismissal or other.

** Fmployee Resignation Report

Employee Resignation Report
Order By
@ Employee Mo, O Drake Terminake O Deparkrment
Employes Mo, From E]
Emploves Mo, To EEEELE E]
Dept. Code From E]
Dept. Code To EZZEZZEZEEZE E]
Lire Mo, From E]
Line Mo, To ZEZEEEEZEE E]
Category Code From E]
Category Code To EEEEEEELEE E]
Date Resign From ols0l/2004 I
Crake Resign To 3171272004
Termination Reason ALL : V
Resignation o]
Retirement
Retrenchment
Dismissal
Other

4.12.16 Employee Length of Service Report

Menu Location: Report > Employee > Employee Length of Service Report
Description: This report will calculate the employee’s length of service in employment from
the date he/she joined the company until the current date. The length of service will be
segregated into years, months and days accordingly.

** Employee Length of Service Report

Employee Length of Service Report

Order By

() Emploves MNa, (%) Department ) Length of Service
Service Year and Month From a {yr) E 0| (mth)
Service Year and Month To . 9g | (v} | 1z {rnth)

Employves Mo, From To | zzzzez

Dept. Code From To |EZE2ZEEzzZes

OOEEE
OOOEE

Lire Ma From Ta 'zzzzzzzzzz |
Job Code From To |zzzz
Branch Code From To |zzzz

4.12.17 Non-Confirmed Employees Report

Menu Location: Report > Employee > Non-Confirmed Employees Report
Description: This report serves as the reminder summary to highlight to the users who are
the employees still not yet confirmed by the company. The report will indicate the
employee’s date of joining the company.
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*“* Non-Confirmed Employees Report

Non-Confirmed Employees Report

Emploves Mo, Ta ZEEZET

|8
Dept, Code From E]
:E]

Employes Mo, From

Dept, Code To | EEZEZZEZZZEE

[ o]

4.12.18 Employee Retirement Report

Menu Location: Report > Employee - Employee Retirement Report
Description: This report will display the employee who will be retired from employment on a
specified period of time.

Users may define the age of retirement.

** Fmployee Retirement Report

Employee Retirement Report

[Order By
@ Employee Mo, (:) Drate Retire O Department
Rekire Age . 5t 8 |

Employes Mo, From

| i[5
Employee Mo, To zzu:zzgz E]
&
1=

Dept, Code Fram

Dept, Code To ZZEZIZZEZEC
Dake Retire From :nunuznm |
Dake Retire To [ 3171272004

The report will show the employee’s birth date and date join. The employee’s age is
calculated as at current year. The date retire is an estimated date of retirement based on the
Retire Age margin defined by user.

4.3 Employee Analysis
4.3.1 Department Analysis Report

Menu Location: Report > Employee Analysis > Department Analysis Report
Description: There are two types of layout formats. Report grouped by race will categorise
each race (Chinese, Indian, Malay or Other) with breakdown of ethnic representative from all
departments and classify by gender (Female or Male). Report grouped by department will
segregate each department into 4 different ethnics and represented in percentage by two
genders.
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** Departmental Analysis Report @

Departmental Analysis Report

Group By
(JRace (%) Department

Active Employee Only

Cancel

4.3.2 Job Title Analysis Report

Menu Location: Report > Employee Analysis > Job Title Analysis Report
Description: Report grouped by race will compare four different races for all listed job titles
by breakdown into two genders of female and male. Report grouped by job title will list all
job titles with ethnic representation and breakdown of two genders.

* lob Title Analysis Report

Job Title Analysis Report

Group By
(%) Race ) Joh Title

Active Emploves Only

Cancel

4.3.3 Job Status Analysis Report

Menu Location: Report > Employee Analysis - Job Status Analysis Report
Description: Report grouped by race will compare four different races for all job status by
breakdown into two genders of female and male. Report grouped by job status will list all job
status with ethnic representation and breakdown of two genders.

** Job Status Analysis Report @

Job Status Analysis Report

Group By
(%) Race () Job Skatus

Active Employes Only

Cancel

4.3.4 Marital Status Analysis Report

Menu Location: Report > Employee Analysis > Marital Status Analysis Report
Description: Report grouped by race will display 4 categories of races (Chinese, Indian,

Malay, Other) with gender breakdown in different marital status. Report grouped by marital
status segregate 6 categories of status (single, married, divorced, widow, widower and other)
with breakdown of gender in different races.
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** Marital Status Analysis Report

Marital Status Analysis Report

Group By
(JRace (%) Marital Status

Active Employes Only

4.3.5 Age Analysis Report

Menu Location: Report > Employee Analysis > Age Analysis Report

Description: Report grouped by race will categorise different age ranges for different genders
according to 4 major races (Chinese, Indian, Malay and Other). Report grouped by age will
segregate different age ranges and breakdown into different races and genders.

** Ape Analysis Report

Age Analysis Report

Group By

@ Race O Age

Active Emploves Onlky

Cancel

4.3.6 Manpower and Salary Analysis Report

Menu Location: Report - Employee Analysis > Manpower and Salary Analysis
Report

Description: This analysis report will indicate the difference between planned and actual
manpower utilization in term of number of employee and total salary value in the company.

** Manpower. and Salary Analysis Report

Manpower and Salary Analysis Report
&
o
=
i

| o

Branch Code From
Branch Code To EZEE
Dept. Code From

Dept. Code To | zzzzzzzzIE

- ]

In this report, the number of Person (in column Plan) is extracted accordingly from HR
Department > Manpower.

Salary (in column Plan) is generated from Housekeeping - Setup > Default Setting
- Salary and based on the number of personnel for the particular job title.
4.4 Leave
4.4.1 Leave Scheme Details Report

Menu Location: Report > Leave - Leave Scheme Details Report
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Description: There are two types of layout formats, both will disclose the leave details
including number of service year, leave day entitled, apply status (before or after
confirmation) and prorata.

“* | eave Scheme Details Report

Leawve Scheme Details Report

Repoart Group By @ Leave Code
() Leave Scheme Code

Leave Code From LE E]
' &

Leave Code To | 2D

o | [cwen ]

Report grouped by Leave Code will categorise all 14 leave codes and segregate each into
different leave schemes.

** | eave Scheme Details Report

Leave Scheme Details Report

Repoart Group By {:} Leave Code
(%) Leave Scheme Code

Leave Scheme Code From LE0l E]
Leave Scheme Code To 1303 E]

e

Report grouped by Leave Scheme Code will list details of all 14 leave types for different
leave schemes. The number of leave scheme depends on the user-defined record.

4.4.2 Employee Leave Details (Pending For Approval) Report
Menu Location: Report > Leave > Employee Leave Details (Pending For Approval)
Report

Description: This option enables users to preview or print, a detailed listing report for
unapproved leave application, or, the particular leave application form.
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** Employee Leave Details (Pending For Approval) Report

Employee Leave Details (Pending For Approval) Report

= : - | Type

Emplovee Mo, From ] E] To %_zzzzzz E] @ypgetails Repart

Leave Code From | E] To Zzz E] O Leave Application Form
Leave Date From .__0_1_50?12_004”! To E_I_ISl_,f_D?,-’_ZDD_ZL_. Group By

Session A - ALL v _5 [] Employee Mo

Status ..ALL . > [ Leave Code

Dept. Code From | E] Ta E_ZZZZZZZZZZ E] [[] show active only
Line Mo From E] To ZEZZZZEEEEE E] |:| Show Approwal

Job Code From E] To _-zzzz E]

Eranch Code From E] To ZZZZ E]

If users want to verify the unapproved leave application listing, select “"Details Report” for
Type at the top right corner in the menu. User may choose to group the report by Employee
No, Leave Code, Show Active Only or Show Approval.

If users want to print any particular unapproved leave application form, select “"Leave
Application Form” under Type section.

4.4.3 Employee Approved Leave Details Report

Menu Location: Report > Leave > Employee Approved Leave Details Report
Description: This option enables users to preview or print, a detailed listing report for the
approved leave application, or, the particular approved leave application form.

*“* Employee Approved Leave Details Report

% Employee Approved Leave Details Report

: : : Tupe

Emploves Mo, From . : E] To |zzzzzz E] @H:I;_)etails Repart

Leave Code From E] To 227 E] (O Approved Leave Form
Leave Dake From :Dl;’U’?;’ZDUJII To ..31.-"]0?1"’2004 : Group By

Sessian ._.A - ALL b Employes Mo

Status .ALL - v|

Dept, Code From . E] Ta _:zzzzzzzzzz E] Show Active Only
Line Ma Fram E] Ta l:zzzzzzzzzz ._ |:| Show Approval
Job Code Fram E] To | .zzzz E]

Branch Code From E] To |zzzz E]

If users want to verify the approved leave application listing, select “Details Report” for
Type at the top right corner in the menu. User may choose to group the report by Employee
No, Leave Code, Show Active Only or Show Approval.

If users want to print any particular approved leave application form, select “Leave
Application Form” under Type section.

COPYRIGHT © UBS CORPORATION SDN BHD



EZUBS

User Business System Human Resource Management User Manual Page 136 of 223
4.4.4 Approved Leave (By Day) Report
Menu Location: Report > Leave > Approved Leave (By Day) Report

Description: This report will list out a summary of employees who are taking leave, from
which department and what type of leave taken, within a specified period of time.

** Approved Leave (By Day) Report

Approved Leave (By Day) Report

Leave From Date 01/07/2004

Leave To Date 14/07/2004
Active Employee Only

Cancel

Specify the range of leave dates to be included in the listing report.

4.4.5 Employee Leave Summary Report

Menu Location: Report > Leave - Employee Leave Summary Report

Description: This report summarise the total number of leave days taken for each leave code.
It also indicates leave days balance brought forward from previous year, total leave days
entitled for current year and the latest outstanding balance of annual leave and

compensation leave.

** Employee Leave Summary Report E|

Employee Leave Summary Report

Category Code From

Emploves Mo. Fram E]
Employee No, To | zzzEEE :E]
Dept. Code From :E]
Dept, Code To ZZEZZZZZZZE E]
Line Mo, Fram [ E]
Ling Ma, Ta | zzzzzzEzEE E]

|9

[\

Category Code To ZEZZZZIIEZE

Artive Employes Orly

4.4.6 Employee Leave Clearance Report

Menu Location: Report > Leave > Employee Leave Clearance Report

Description: This report shows the current outstanding balance of annual and compensation
leave, maximum number of annual leave allowed to carried forward and total number of
leave balance after deducting leave days carried forward to the following year.
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** Employee Leave Clearance Report @

Employee Leave Clearance Report

Employee Mo, Fram | !E] To i_zzzzzz 'E]

|&] 1o [zzzezezezz 7]
&) 1o |zzzzzzzzaz |[F]
&) 10 |[zzez \a!
I B EE N

Show Active Only OF Cancel

4.4.7 Employee AL/MC Entitled and Balance Report

Dept. Code From

Line Mo From

Job Code From

Branch Code From

Menu Location: Report > Leave > Employee AL/MC Entitled and Balance Report
Description: This report summarise number of days for annual and sick leave in term of
balance brought forward (only for annual leave), leave entitlement, leave taken and
outstanding balance.

**> Fmployee ALIMC Entitled and Balance Report Fg|

Employee AL{MC Entitled and Balance Report

Order By
(%) Employves Mo, () Department

Employee Mo, From ! E] To zZzzzE ] E]
Dept. Code From | [ 7o |zzzemzens [
Line Mo From i ) E] To EZZZZEZZZZZZ E]
Job Code From _. E] To | ZEZEZZ | E]
Branch Code From | E] To | f-4-4-4-1 ]E]

active Emploves Only

4.4.8 Employee Non-Taken Leave Report

Menu Location: Report > Leave > Employee Non-Taken Leave Report

Description: This report enables users to locate the employees who never utilize certain type
of leave. For instance, an employer might want to know the employees who does not apply
sick leave since the beginning of year until current date.

** Employee Non-Taken Leave Report

%E Employee Non-Taken Leave Report

Order By
(¥) Employee No. (O Department (O Dake Join

Emploves KNo, From To | zzzzzz

MOOOEOME

|
Dept. Code From To | ZEZEEZEEZEZE :

Ling Mo From : To I_zzzzzzzzzzA
Job Code From l Ta Lz_; 2
Branch Cade From [ | To | 14:4-4
Leave Code Fram HL | Ta | M !

MO@OOE

Active Employes Only
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By default, the system enables users to search for employees who did not apply
Hospitalisation (HL) and Sick Leave (MC) since 1% January until current date.

Select the Leave Code if user wants to check information for other type of leave.

4.5 Claim
4.5.1 Claim Scheme Details Report
Menu Location: Report > Claim > Claim Scheme Details Report

Description: This report will display maximum claim value per receipt and year, for different
claim codes and schemes.

** Claim Scheme Details Report

Claim Scheme Details Report

Report Group By (%) Claim Code

() Claim Scheme Code
Claim Code Fram B
Claim Code To ZZZZ E]

This type of report list the details of maximum claim amount for all available claim schemes
sorted under the same claim code.

** Claim Scheme Details Report

Claim Scheme Details Report

Report Group By () Claim Code

(%) Claim Scheme Code
Claim Scheme Code From . E]
Claim Scheme Code Ta zzrE 1 E]

This type of report list the details of maximum claim amount for all claim codes sorted under
the same claim scheme.

4.5.2 Employee Claim Details (Pending For Approval) Report

Menu Location: Report - Claim > Employee Claim Details (Pending For Approval)
Report

Description: This option enables user to preview or print, a detailed listing report of
unapproved claim, or, any particular actual claim submission form.
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** Employee Claim Details [Pending For Approval) Report gl

Employee Claim Details (Pending For Approval) Report

Type

(%) Details Report () claim Submission Farm

Group By

() Emplayee Mo, (%) Department () Claim Code
Emplovee Mo. From E] Ta . EEZEEE i E]
Claim Code From :E] T | ZZEZE E]
Dept. Code From E] To ZZEZZTZZE z E]
Line o From &) to |zzmzezezez ]
1ob Code From E] To ZZZZ E]
Branch Code From | E] To | zzzz . E]
Claim Date From :Dl,-"D?,.-"ZDUdl _. To ;31,.-"0?,-"2004-.
Receipt Date From | s | To Y

Ackive Employes Only

If users want to verify the claim submissions which are pending approval, select report Type
as “"Details Report”, at the top right corner in the menu. User may choose to group the
report by Employee No, Department or Claim Code.

If users want to print any particular claim form, select Type as “Claim Submission Form”.

4.5.3 Employee Approved Claim Details Report
Menu Location: Report > Claim > Employee Approved Claim Details Report

Description: This report will display the approved claim details with amount and date of claim
and receipt, grouped by Employee No., Department or Claim Code.

** Employee Approved Claim Details Report

Employee Approved Claim Details Report

Group By
(%) Employes Mo, () Departmertt () Claim Code

Ernployee Mo, From Ta ZZZEZEZE

Claim Code From To | zzzz

Cept, Code From To |ZZZEzZz2zzE

[ [ [ ([
IEOEEE

Line Mo From Ta | zzzzzzEZZE
Job Code From To |zzzz

Branch Code From To : ZZZZ

Claim Crate Fram ;l.Dl,-"D'?,-"ZUDJL To -31,-"0'?,-"2004
Receipt Date Fram i T To YA, l

Active Employee Only

o e

4.5.4 Employee Claim Balance Report

Menu Location: Report - Claim > Employee Claim Balance Report
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Description: This report compares the claim entitlement against the approved and pending
claim for a specified period.

*“* Employee Claim Balance Report

Employee Claim Balance Report

Order By

(%) Employee Mo, (O Department () Claim Code
Year | zoo4
Employee Mo, From B E] To |zzzzez E]
Claim Code From | E] Ta | zmoe :E]
Dept. Code From E] To |zzzzzzzzzz E]
Line Mo From | E] To | CEEZEZEELEEE E]
Job Code From | E] To | zzzz :E]
Branch Code From E] To f-4:4:4:1 E]
Active Employes COnly

4.5.5 Claim Summary Report

Menu Location: Report > Claim - Claim Summary Report
Description: This report summarise total claim approved and pending for a specified period.

2 Claim Summary Report

Claim Summary Report

Group By
() Claim Code (%) Department
() Job Code () Claim Scheme Code
Year . 20&4 1

Claim Code Fram

._ &

Claim Code To zzzz B
[

/&)

Dept. Code From
Dept, Code Ta | zzzzzzzzas

[ active Emplovee Only

Co Yo

Report grouped by Claim Code will display overall claim approved and pending for the
whole company.

Whereas, report grouped by Department, Job Code or Claim Scheme Code will compare
the claim details sorted by department, job code or claim scheme code respectively.

4.6 Loan
4.6.1 Loan Types Listing
Menu Location: Report - Loan - Loan Types Listing

Description: This report will list out types of loan provided to the employees, as per defined
in the maintenance module.
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** | oan Iypes Listing

Loan Types Listing

Order By
@i

O Loan Descripkion

[ o | coree |

4.6.2 Employee Loans Report

Menu Location: Report > Loan > Employee Loans Report

Page 141 of 223

Description: This report summarise the loan information including employee’s name and
department, loan amount, repayment amount and payment method, interest rate chargeable
and length of loan period, first installment date and installment completed date.

** Employee Loans Report

Employee Loans Report

Order By

Active Emploves Only
CQutstanding Loan Balance Only

G) Employes MNo. O Loan Type O Deparkrnent
(1 Pay Method (") Loan Active Date
FPap Method
1st Half Payroll 2nd Half Payroll
1st & Znd Half Payroll [#]Payment (Mot Thru Payrall)
Emploves Mo, Fram . i
Emplovee Mo, To Izzzzzz ] E]
Loan Type From |E]
Loan Type To f4:4:4:4 IE]
Loan Palicy No. Fram I T
Laan Palicy No. Ta Izzzzzzzzzz |
Loan Active Date From 010172004 i
Loan Active Date To 3l/lz2/2004 |

4.6.3 Employee Loans Details Report

Menu Location: Report - Loan > Employee Loan Details Report

Description: This report list out the loan schedule and details including the loan payment

date, payment method, scheduled and paid amount.

** Fmployee Loans Details Report

Employes Mo, From [ E]
Employes Mo, To | zzzzzz E]
Loan Code From | [

Loan Code To EEEEEEEIEE
Active Employes Only
Cutstanding Loan Balance Only

4.7 Skill
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4.7.1 Skills Codes Listing

Menu Location: Report > Skill > Skills Codes Listing

Description: This option enables users to list out all the skill codes defined by user in the
maintenance module. The listing report can be sorted according to skill code, description or
skill category group.

** Skills Codes Listing

Skills Codes Listing

Order Ey
(%) 5kill Code ) Descriptioh 1 Skill Categony

Skil Code From | 14
Skl Code To zzzzz [~

Skill Category |ALL X :

[ o [ coenl |

4.7.2 Skills Requirements Details Report

Menu Location: Report > Skill > Skill Requirements Details Report
Description: This report will display the required skill and rate assigned for different
requirement group.

SEkill Reguirernent Code From [ -. [E|
Skill Requirement Code To g-zzzzz E]
’ oK l [ LCancel l

4.7.3 Employee Skills Requirements Report

Menu Location: Report > Skill > Employee Skills Requirements Report
Description: This report classified the employees according to different requirement group.

*~* Employee Skills Requirements Report

Employee Skills Requirements Report

Employes Mo, From .- E] To Euzzzzzz E]
Skill Requirement Code From E] To ::zzzzz E]
Dept. Code From :B To ;:zzzzzzzzzz B
Lire Mo Fram IE] To é_._lzzzzzzzzzz E]
Job Code From IB To E:ZZZZ B
Branch Code From B To :“zzzz ' B

it
[#] Active Employes Orly

4.7.4 Employee Actual Skills Report

Menu Location: Report > Skill > Employee Actual Skills Report
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Description: This report categorized the employees according to different skill codes. It will
indicate the employees’ actual skill rate obtained. This report enables users to locate the
employee(s) who is having a specified skill/knowledge. For instance, an employer might want
to know who are the employees possessing a specified skill/knowledge, so that the employer
can assign a task to the respective employee.

** Employee Actual Skills Report

Employes Mo, From

Skill Code From

Dept. Code From
Line Mo From
Job Code From

Branch Code From

Active Employes Only

E] To |zzzzzz
E] To |zzzzz

E] To i”zzzzzzzzzz
E] To iézzzzzzzzz
:E] To ;ézzz
:E] To f”zzzz

(o ) (o)

DT  ©O

4.7.5 Employee Skills Requirements Details Report

Menu Location: Report > Skill > Employee Skills Requirements Details Report
Description: This report summarise the skills/ knowledge requirements defined by the
company and related to the employees.

** Employee Skills Requirements Details Report

Employee Skills Requirements Details Report

Employee MNo. From

Skill Code Fram

Dept. Code Fram
Line No From
Job Code Fram

Branch Code From

E] o
E] To

::IE] Te
.EE] i |
B
1B |

| 222285 g E] Group By
L5 E] (&) Employes No
() Skill Code

2222222222 E]

[¥] Active Employee Only
|zzzzzzzzze E]
z2ZZ E]
zz7Z E]

Report grouped by Employee No. will list the user-defined skills/knowledge requirements
expected to be possessed by the employees.

Report grouped by Skill Code will list the employees according to the skills/knowledge

requirements.

4.7.6 Employee Training Needs Analysis Report

Menu Location: Report > Skill > Employee Training Needs Analysis Report
Description: Applying the same format as the previous report module shown earlier, this
report summarises and compares the employee’s expected and actual skills/knowledge.
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** Employee Training Needs Analysis Report

Employee Training Needs Analysis Report
Employee Mo, From E] To | ZEEEIE ) |E] i
Skill Code From | E] To | ZEETT |E] @® Employes Na
O skill Code
Dept. Code From | E] Ta | ZEEZZEZEZZIEE ]E]
T = I = Show Active Only
Line Mo From | E] To |zzzzzzzzzz !E]
Job Code From [ E] To izzzz ]E]
Branch Code From E] To | zzzz | E]

Report grouped by Employee No. will list the user-defined skills/knowledge requirements
expected to be possessed by the employees and compare against the actual skill rate
obtained by the respective employees.

Report grouped by Skill Code will list the employees according to the skills/knowledge

requirements. It will also indicate the actual skill rate obtained by respective employees if
available.

4.8 Training
4.8.1 External Training Centres Report
Menu Location: Report - Training - External Training Centres Listing

Description: This report will list the information of the external training centres maintained by
users. Details included are centre name, contact person, address and phone number.

** Fxternal Training Centres Listing

Centre Code From -E]

Centre Code To —— E]

| ok [ coneal |

4.8.2 Trainer Skills Details Report

Menu Location: Report > Training > Trainer Skills Details Report
Description: This report will display the trainer’s name, skills, fee chargeable and department
(for internal trainers).

** Trainer Skills Details Report @

Trainer Skills Details Report

Trainer Code From IE]
Trainer Code To |zzzzzE IE]
Skatus ELL ~ |

1 show Centre Code External |
Internal
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4.8.3

4.8.4

Training Program Details Report

Menu Location: Report > Training - Training Program Details Report

Description: Summary report displays the training skill, number of trainee, total training time
(in days, hours and minutes) and total training expenditure (course fee plus other expenses).
Detailed report displays the program, skill and trainer’s code, training starting and ending
date, total training time (in days, hours and minutes) as well as breakdown of expenditure in
course fee, HRDF and other expenses.

** Training Program Details Report

NE| Training Program Details Report
(%) Detail ) summary
Program Code Fram . E]
Program Code To bttt AAAAAAA E]
Stark Date From . FE
End Date To . Y
Training Status j; ------- v |
Show Trainer Evaluation External ' Cancel
Internal .

Users may also choose to include the trainer’s evaluation in the detailed report. Tick the
checkbox labeled “Show Trainer Evaluation’ at the left bottom of the menu.

Employee Training Records Report

Menu Location: Report - Training - Employee Training Records Report
Description: This report is the summary of training program records indicating the
employees’ achieved skill rate and date of retraining if applicable.

“* Employee Training Records Listing

Employee Training Records Listing

Order By
(%) Program Code () gkill Code

Employee Mo, From To ZEEZEZEE

Dept. Code From To |zzzzzzzzzz

Lime Mo, From Ta ZEEZZZLZZEZ

Category Code From To |zzzzzzzzzz

Program Cade From To ZZZZZZEZZE

Skill Cade From |
Active Employes Only

OO
MOOOEOE

To | zzzzz

4.8.5

Employee Retraining Report
Menu Location: Report > Training - Employee Retraining Report

Description: This report enables users to verify the retraining date of the employees for a
particular skill program within a specified period of time.
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** Employee Retraining Report

Employee Retraining Report

Order By

(%) Employes Mo,
Emploves Mo, From
Employves Mo, To
Dept, Code From
Dept, Code Ta
Ling Ma, From
Ling Ma., Tao
Cateqary Code Fram
Cateqgory Code To
Pragram Code From
Pragram Code To
Date Retraining From

Date Retraining To

:.?..z_zz_z.?:.

;zzzzzzzzzz
Logpeacats
;zzzzzzzzzz

| zzzzzZEEZE |

() 5kill Code

OOOEOOEEE

|o1/01/2004 |
[31/12/2004 |

O Date Retraining
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4.8.6 Employee Training Analysis Report

Menu Location: Report > Training - Employee Training Analysis Report
Description: This report analyses and compares the necessary skills/knowledge required and
the related training program attended by the employees. If the employees have attended
any particular skill training, the report will indicate the training details including date begin,
date end, skill rate achieved as well as retraining date if applicable.

** Fmployee Training Analysis Report

Employee Training Analysis Report

Employee Mo, From B To rEEZEET . B
Dept, Code From B T ZEZZEZZZZEZ E]
Lime Mo From B To ZEZZEZZZZEZ El
Job Code From B To ZZEE El
Branch Code From B To ZZEZZ El

[#] Active Employee Cnly [ ik ] [ Cancel l

4.8.7 Employee Training Program Evaluation Report
Menu Location: Report - Training - Employee Training Program Evaluation Report

Description: This report evaluates the employees by his/her participation in training
programs, included with details of training’s date begin/end/retraining and skill rate achieved.
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** Employee Training Program Evaluation Report E]

Employee Training Program Evaluation Report
Emplovee Mo, From | IE] To | ZEEEEE |E]
Program Code From | 'E] To | ZEEEEZZEEE .E]
Skill Code From | |B To | ZZZZE iB
Dept. Code Fram I |E] To | ZZZZZZZEEZ E]
Line 1o From B
Job Code From l 'B To | ZZZZ iB
Branch Code From [ |B To | ZZZZ iB
Show Active Cnly

4.8.8 Trainer Training Program Evaluation Report

Menu Location: Report - Training - Trainer Training Program Evaluation Report

Description: This report evaluates involvement of trainers (internal and/or external trainers)
in all training programs. It indicates the trainer’s name, conducted skill programs, training’s
begin and end date, total training hours and incurred course fee.

** Trainer Training Program Evaluation Report @

Trainer Training Program Evaluation

Trainer Code From E]
Trainer Code To ZEZEZZE E]
Skatus ALL \:|

External
Cancel
Internal

4.8.9 Evaluation on Trainer Report

Menu Location: Report > Training - Evaluation on Trainer Report
Description: This option enables users to evaluate the trainer based on the
assessment/comment obtained after the training.

** Evaluation on Trainer Report

Ewaluation on Trainer Report

Repart Group By (:) Program Code
(%) Trainer Code

Trainer Code From | iE]
; !.'—|—I
Trainer Code To ! ZEEZEE |B
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Menu Location: Report > Resource - Employee Resources Report

Description: The detailed report list out all the resources items possessed by particular
employees, including information such as date of issue/return, quantity and size issued and
its return condition. The summary report enables users to verify the resources items issued
to employees and its return condition (good, damage or loss) if they had been returned.

** Employee Resources Report

Employee Resources Report

x)

Emploves Mo, From
Resource Code From
Issue Date Fram
Return Date Fram

Return Condition

Dept. Cade From

Line Mo From

Job Code From

Eranch Code From

E] 1 :_ﬂzzzzzz E] (3 Detail

Bel

|b1/01/2004 | To

| 2222

| 30,08 /2004 |

| zzzEzzzzzz E]
| zzzzzzzzzz |
| zzzz

ZZEZZ

Group By
Employes Mo

I

) summary

Show Active Only

i[xajxy

4.10 Tip

4.10.1

Tip Scheme Details Report

Menu Location: Report > Tip > Tip Scheme Details Report
Description: This report displays the details (range of months with assigned tip point/amount)
of tip scheme defined by users. It can be listed by details with only after confirmation or

before confirmation or both statuses.

** Tip Scheme

Details Report

% Tip Scheme Details Report

Order By
(%) 5cheme Code

Scheme Code To

Apply Skatus

Scheme Code From

() Scheme Description

After Confirmation
Before Confirmation

4.10.2

Default Tip Scheme Report

Menu Location: Report > Tip > Default Tip Scheme Report
Description: This report will list all user-defined job titles with its relevant assigned tip

scheme.
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** Default Tip Scheme Report §|

% Default Tip Scheme Report

Qrder By
() Job Code ) scheme Code

[
o

Scheme Code From

Scheme Code To ZZZZ

Cancel

4.10.3 Periodical Tip Value Report

Menu Location: Report > Tip > Periodical Tip Value Report

Description: This report enables users to keep track of the details of tip value maintained for
a specified period of time. Information includes effective date, total tip value, number of tip
point, total value per point and the applicable tip schemes.

This report module only visible if user has selected * Yes” to Enable “Tip Value
Maintenance” at Housekeeping > Setup »> General Setup - -> Tip (2)

** Periodical Tip Value Report

Periodical Tip Value Report

Date From |o1s01/z004 |
Date To |31/12/2004 |

4.10.4 Employee Tip Amount Report

Menu Location: Report > Tip > Employee Tip Amount Report

Description: This report list out the total tip amount earned by the employees within a
particular period of time. By default, the system will extract data for date effective within the
current month.

This report module only visible if user has selected * Yes” to Enable “Tip Value
Maintenance” at Housekeeping > Setup > General Setup - -> Tip (2)

** Employee Tip Amount Report

Employee Tip Amount Report

Order By
(®)Employves Mo, (O Department (O JobCode ) Tip Amount

Tip Scheme
(%) Bioth () with Scheme Cnly () Without Scheme Only

=
o

Emploves Mo, From ZEZEZZZ

=
(=)

Dept, Code From ZEZZZZZZZE

Ling Mo From ZEZZZEZETEE

p
o

Job Code From ZEZEZE

4
o

Branch Code From ZZZZ

o

To |zzez

=
o

Date Join From | i

0 OOOEOm
O OOOOE

Scheme Code From |
Date Effective From | 01,/08/2004 To | 31/08/2004 |

Payroll Type |&11 i
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Users may choose to display only employees with or without tip scheme assigned or both
categories altogether.

Sorting report by Tip Amount enables users to assess who is the highest achiever in tip
amount.

4.10.5 Employee Salary and Tip Summary Report
Menu Location: Report > Tip > Employee Salary and Tip Summary Report

Description: This report will segregate and compare the employees’ latest effective salary
and tip point/amount.

** Fmployee Salary and Tip Summary Report @

Employee Salary and Tip Summary Report

Order By

(*) Emplovee Mo, () Department

() Joh Code {1 Tip Scheme Code

Tip Scheme

(*)Both (ywith Scheme Only () without Scheme Only
Emplovee Mo, From .E] To |zzzzzz E]
Dept. Code From E] To ;zzzzzzzzzz [‘__']
Liree Ma. Fram : B To ;zzzzzzzzzz :8
Job Code From | B To |zzzz B
Scheme Code From _ E] To |zzzz B
Active Employves Only

4.11 Manpower Plan vs Actual Report
Menu Location: Report > Manpower Plan vs Actual Report

Description: This report compares the planned and actual manpower in branches and departments.
It will indicate the difference between planned manpower and actual utilization.

~* Manpower, Plan vs Actual Report

Manpower Flan vs Actual Report

Branch Code From E]
Branch Code To TEZT E]
Dept. Code From E]
Dept. Code To ; ZEEZZZZEZE [ﬂ

4.12 Budget Plan vs Actual Report

Menu Location: Report > Budget Plan vs Actual Report
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Description: This report compares the budget projection and actual expenditure for salary and/or
training. If it is training, it will indicate amount of HRDF deducted.

** Budget Plan vs Actual Report

Budget FPlan vs Actual Report

Type

() salary () Training (*) Salary & Training
‘fear From 2004
‘Year To 2004
Dept. Code From E]
Cept, Code To EEEEZEEEZEE E]
’ 8] 4 ][ Cancel ]
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Chapter 5 GRAPH
Overview:

This module consists of various comparison graphs to enable users evaluate the composition of
employees in the organization.

Steps to follow:-

1. Select the respective graph module, click "OK"” button to access to the Print Option box.

Print Option

EEETEEn

ngstomize] [ Printer l

Default Printer: \UBS-SERVER'HP LASERIET 1100 {MS)

2. Select and click on the “"Graph” button.

3. In the graph menu, user may tick the checkbox labeled “Insert Title" to include the graph title
in the graph layout.

Insert Title

\_Illl Column 4. Point the mouse cursor to the
Tow respective graph layout option
and left click mouse button once.

E = Select different graph design
either in Column, Bar, Pie or
= Line format, and the graph will
:Q Pie change accordingly.

4. Click on “Preview"” button at the bottom of the menu to preview the graph. The top section will
display the selected graph design, whereas the bottom section will show the summary of source
data.

5. Click on “Print” button to printout the actual graph and data chart.

5.1 Gender Comparison Graph

Menu Location: Graph - Gender Comparison Graph
Description: This graph illustrates the gender (female and male) composition percentage in the
company.
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** Gender Comparison Graph

Active Employee Only

Tick the checkbox “Active Employee Only’ if user want to view the active employees database
only.

5.2 Bumiputra Comparison Graph
Menu Location: Graph - Bumiputra Comparison Graph

Description: This graph illustrates the percentage between bumiputra and non-bumiputra status in
employee base.

** Bumiputra Comparison Graph

Active Emploves Only

==

5.3 Education Qualification Comparison Graph
Menu Location: Graph - Education Qualification Comparison Graph

Description: This graph illustrates percentage composition of employees’ education background
(PhD, Master, Degree, Higher Diploma, Diploma, Certificate, Secondary and Other).

** Fducation Qualification Comparison Graph @

% Education Qualification Comparison Graph

Active Emploves Only

5.4 Marital Status Comparison Graph

Menu Location: Graph = Marital Status Comparison Graph
Description: This graph illustrates the marital status (Single, Married, Divorced, Widow, Widower or
Other) of the employees, in percentage.

** Marital Status Comparison Graph

% Marital Status Comparison Graph

Active Employees Only

o] concel |
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5.5 Race Comparison Graph
Menu Location: Graph 2 Race Comparison Graph

Description: This graph illustrates races (Chinese, Indian, Malay and Other) composition percentage
of the employee base.

** Race Comparison Graph @

% Race Comparison Graph

Active Emploves Only

o o |

5.6 Religion Comparison Graph

Menu Location: Graph = Religion Comparison Graph
Description: This graph illustrates the religion (Buddhism, Christianity, Hinduism, Islam and Other)
percentage composition of the employees in the company.

** Religion Comparison Graph

E Religion Comparison Graph

Active Employee Onby

T

5.7 Job Status Comparison Graph

Menu Location: Graph = Job Status Comparison Graph
Description: This graph illustrates the job status (Clerical, Executive, Management, Professional or
Other) for the employees in the company, in percentage.

** Job Status Comparison Graph

Active Emplovee Only

5.8 Nationality Comparison Graph

Menu Location: Graph - Nationality Comparison Graph
Description: This graph illustrates the comparative percentage of the employee’s nationality.

** Nationality Comparison Graph

@ MNationality Comparison Graph

frctive Employes Only

ol o
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5.9 State Comparison Graph

Menu Location: Graph > State Comparison Graph
Description: This graph illustrates the state of origin for the employees, comparison in percentage.

** State Comparison Graph @

Active Employes Only

= o ]

5.10 Transport Comparison Graph
Menu Location: Graph - Transport Comparison Graph

Description: This graph illustrates mean of transport by the employees, whether it is by bus, car,
motorcycle or van.

** Transport Comparison Graph

@ Transport Comparison Graph

Active Employes Only

o cancel |

5.11 Branch Comparison Graph

Menu Location: Graph - Branch Comparison Graph
Description: This graph illustrates the branches where the employees were coming from.

** Branch Comparison Graph

fctive Employes Only

o]

5.12 Category Comparison Graph

Menu Location: Graph - Category Comparison Graph
Description: This graph illustrates the category of the employees.

** Category Comparison Graph

Category Comparison Graph

Active Employee Only

=1 o]
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5.13 Department Comparison Graph
Menu Location: Graph - Department Comparison Graph

Description: This graph illustrates the departmental composition of the employees in the company,
in percentage.

** Department Comparison Graph

% Department Comparison Graph

Active Employes Only

AT

5.14 Job Title Comparison Graph

Menu Location: Graph - Job Title Comparison Graph
Description: This graph illustrates the composition percentage for different job titles of the
employees in the company, defined by users.

** Job Title Comparison Graph

Active Employee Cnly

T

5.15 Line No. Comparison Graph
Menu Location: Graph = Line No. Comparison Graph

Description: This graph illustrates the percentage composition of the employees’ assigned line
number, if applicable.

** | ine No. Comparison Graph

Active Emploves Only

o |

5.16 Age Range Comparison Graph

Menu Location: Graph > Age Range Comparison Graph

Description: This graph illustrates the composition of the employees’ years of age in six different
ranges (20 and below, 21 to 30, 31 to 40, 41 to 50, 51 to 60, 61 and above), comparison by
percentage.
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** Ape Range Comparison Graph

E Age Range Comparison Graph

Active Employes Only

5.17 Resignation Comparison Graph

Menu Location: Graph = Resignation Comparison Graph
Description: This graph compares the number of resigned employees over the last eight years
(inclusive of current year).

** Resignation Comparison Graph

Resignation Comparison Graph

Year Fram !199? !Tu:u |2DD4 |

e |
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Chapter 6 HOUSEKEEPING
Overview:

This module enables you to maintain general setting and features of the system according to individual
company’s requirements, user’s access right and password maintenance, changing of font, indexing and
upgrading of database, backup and restore of data files. Besides, it also allows users to import and
export the data files from and to UBS Payroll system. And, it has the feature to perform year end
processing and re-calculation of leave balance.

6.1 Setup
It is advisable for users to maintain the initial setup before proceed to perform system processing.
6.1.1 General Setup

Menu Location: Housekeeping > Setup > General Setup
Description: This option enables users to maintain the general settings of the system and set
parameters that suit the company’s requirements.

Company

The company name that user entered here will be printed in all reports as the header at the
top left corner.

“* General Setup @

| Company | Leave || sharing || Tip || Tip (23 || others

Company Details :-

Comparry Marne UES CORPORATION EERHAD

e |LEVEL 5L TEVER 2, | SEYRONAS TWTH/TOUER;
|KUALA LUMFUR CITY CENTRE,
:snoaa KUALA LUMPUR, ’

| maLavsTa
Telephone Mo, :.037.2031.51?.8
Fax Mo, ﬁé—zhélﬁ-;éa-
R.O.C, Ref, Mo, :441339—1{
Counkry Malaysia v|

ol o il
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Leave

Company | | e ;| sharing || Tip || Tip(2) || Cthers

Cut Off Period for Leave Entitlement :-

From | 01/2004 To | 1z/2004

Leave Entitlement for New Join Prorata :-

Join Day Entitled For 1st Month
2| To <« W 1s FULL |
11| To < 2l % Is HALF w
z1| To = 3zlel| Is HNONE * | Mote:'<' = Less Than
First Day af the \Week, .Hgnday » |
[ (0] 4 ] [ Cancel l [ Apply l

Cut Off Period for Leave Entitlement:-

Enter the transactions cut-off period for HRMS. This period will determine and calculate the
number of leave days if the leave entitlement is to be proportional accordingly.

After year-end processing, the cut-off period will be updated automatically to the next 12
months.

Leave Entitlement for New Join Prorata:-

This is to assign the annual leave entitlement for those employees who joined the company
not on the 1% day of the month. The system will calculate the leave proportionally.

Based on the default setup value in the system, let us evaluate the following examples:

Assuming that the cut-off period is from 01/2004 to 12/2004 and annual leave entitled per
year is 12 days.

Example One
If an employee joins the company from the 2" to 10" of the month, he/she will be given

one full day’s annual leave for the first month joining the company.
E.g. An employee joined on 08/03/2004,
Number of month from date joined (Mac'04) to the end of the cut-off period (Dec’04) is

equal to 10
Therefore, annual leave entitlement for this employee is 10 days.

Example Two
If an employee joins the company from 11" to 20" of the month, he/she will be given a half-

day’s annual leave for the first month joining the company.

E.g. An employee joined on 15/6/2004,
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(i) Based on the employee’s join day, he/she will be entitled half-day annual leave for the
first month (June’04)

(ii) For the second month (Jul’'04) onwards until end of the cut-off period (Dec’04), total
number of month is equal to 6

(iii) Therefore, total annual leave entitlement for this employee is 2 + 6 = 6 2 days

Lastly, select and specify the First Day of the Week. 1t represents the company’s first
working day of the week.

Effect of changes can be seen in hyperlink View Approved Leave located at the system'’s
front page.

The first day defined in this page will determine the range of dates for filtering employee
database while accessing HR Department > Standard Documents.

For instance, if the First Day of the Week is defined as “Monday’, then the system will
extract all related data from Monday until Sunday of the week. If * Tuesday” is defined here,
the system will extract all related data from Tuesday until the following week’s Monday.

Sharing

Data Sharing:-

This is to link the HRMS with UBS Payroll System for systems installed in same PC or server.
Tick the checkbox “Link to Payroll System’’ and specify the Payroll Directory.

There are 3 files shared with the UBS Payroll System, including employee master file
(pmast.dbf), line no. file (tlineno.dbf) and category file (category.dbf). Therefore, whenever

user make data entry in HRMS, the data can be retrieved directly from payroll system or
vice-versa.

** General Setup gj

Tip || Tip(2) | Others

Company || Leave

Data Sharing :-
Link. To Payrall Swstem

Payroll Directory c:iubs softwarelubswpaya0ydata, []

Smart Lock :-

() smart Lock - Single User () Smart Lock - USE Port - Single User
() Smart Lock - Netwark, (") Smatt Lock, - USE Part - Netwark,
@ Derno Set
[ oK ] l Cancel ] l Apply l

Note:

Since there are new fields (e.g. badge no., email address, passport expire date) which
are not yet included in the existing UBS Payroll System, user still need to maintain these
fields in HRMS.
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Smart Lock:-

This is to identify the type of license (single or network user, USB port, trial version)
Demo set only allows users to key in maximum 10 employees’ records.

Tip

This page enables user to define modification method to be applied when re-generating the
tip points/amount.

First of all, specify the column number in Claim Link No. (Tip) to be posted to UBS
Payroll System'’s Allowance Table for tip amount.

** General Setup E|

Campany || Leave || Sharing T ETip(2) Others
Clairn Link Mo, (Tip) 17 b

For Tip Details Modification :-

Re-generate emplovees tip pointsjamount automatically (for active emplovee only)
(") Re-generate from date joinjall records
(%) Re-generate from a specified effective date

(Based on modification date) --Prompt for Date Entry w

For changing the default confirmation month :-
(For tip scheme with apply status of "After Confirmation™)

Re-generate For non-confirmed employees automatically
=) &l non-confirmed emplovess
I From a specified date join

(Based on modification date)

(o) (oot ] (o ]

Then, for the following examples, please refer the scenario with reference to 7able One and
Table Two shown in next page.

Assuming current month is July 2004.

Please verify the effect/end result of each setup or changes in HR Department =
Employee = Tip.

Table One

Employee Date Join Tip Scheme Default Confirmation Month Date Confirm
Staff A 01/07/2004 TS01 3 months 01/10/2004
Staff B 16/07/2004 TS01 3 months 16/10/2004
Staff C 01/06/2004 TS01 3 months 01/09/2004
Table Two

Tip Scheme TS01 TS02

Apply Status | After Confirmation | After Confirmation

Tip Details:-

Oto< 12 2.00000 3.50000
12to < 24 5.00000 6.00000
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Example One

Re-generate employees tip poinksfamount auktomatically (For ackive employees only)

(%) Re-generate from date join/all records

Select this option during the initial setup or first time using of UBS HRMS for updating of all
employees’ record with the new tip scheme.

After completed, remember to change the setup as per example two shown in the next page.

Example Two

Re-generate emplovees tip points/amount automatically {for active emplovee only)

) Re-generate From date joinfall records

{*) Re-generate From a specified effective date

\Based on modification date) | Prompt for Date Entry w

Tick the relevant option button and specify the effective date to re-generate tip
points/amount, whether the new adjustment shall be effective from 7oday, Tomorrow, 1
Day of Current Month, 1" Day of Next Month or I** Day of Next Year.

Alternatively, user may preset the system to “Prompt for Date Entry", allowing user to define
and specify an exact effective date to re-generate the adjusted tip points/amount.

** Fnter, Date |Z|

Enter an effective date to re-generate
employes bip poink/amount -

Date A

Now, let us look into a scenario.
Staff A from scheme TS01 will be promoted on 01/12/2004 and change to another scheme
TS02.

1. Go to HR Department @ Employee = Personnel File - -> Benefitto change the
employee’s Tip Scheme Code to TS02.

2. Enter the effective date as 01/12/2004 when the system prompts for date entry.

3. Then, go to HR Department = Employee = Tip to verify the changes.

Before adjustment After adjustment
Effective Date No. of Point/Amount Effective Date No. of Point/Amount
01/07/2004 0.00000 01/07/2004 0.00000
01/10/2004 2.00000 01/10/2004 2.00000
- 01/12/2004 3.50000
01/07/2005 5.00000 01/07/2005 6.00000

Note:
(i) Tip point/amount’s records before adjustment will be retained.
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(i) From the adjustment’s effective date onwards, the tip point/amount will change and
follow the new scheme.

Example Three
Modify scheme TS01 as below and apply to all staffs the newly adjusted scheme to replace
the old scheme with effective from 01/07/2005.

Tip Scheme TS01
Apply Status | After Confirmation

Tip Details:-
Oto< 12 3.00000
12to < 24 8.00000

1. Go to HR Department = Tip < Tip Scheme to modify the tip details.
2. Enter effective date as 01/07/2005

3. Then, go to HR Department = Employee = Tip to verify the changes for staff B & staff

C.
Staff B
Before adjustment After adjustment
Effective Date | No. of Point/Amount Effective Date | No. of Point/Amount
16/07/2004 0.00000 16/07/2004 0.00000
16/10/2004 2.00000 16/10/2004 2.00000
- 01/07/2005 3.00000
16/07/2005 5.00000 16/07/2005 8.00000
Staff C
Before adjustment After adjustment
Effective Date | No. of Point/Amount Effective Date | No. of Point/Amount
01/06/2004 0.00000 01/06/2004 0.00000
01/09/2004 2.00000 01/09/2004 2.00000
01/06/2005 5.00000 01/06/2005 5.00000
- 01/07/2005 8.00000

Note:

(i) Effective from 01/07/2005 onwards, staff B will utilize the new adjusted tip point/amount
and ignore the remainder record from old scheme.

(i) On 01/06/2005 before the scheme adjustment, staff C still follows the old scheme. But,
effective from 01/07/2005 onwards, staff C will change to utilize the newly modified scheme.

Modification of Employees’ Confirmation Month

For changing the default confirmation month :-
(For kip scherme with apply skatus af "after Confirmmation™)

Re-generate For non-confirmed employvees automaktically
(& all non-confirmed emplovees
() From a specified date join

({Based on modification date)
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Note:

their confirmation.

MUST BE blank or not input yet.

1. All modifications are only applicable for the tip schemes with apply status “After Confirmation”.
Changes of setup in this option only affecting group of employees with tip scheme applied after

2. All modifications are only affecting those employees who are not yet confirmed by the employer.
In other words, the Date Confirm in HR Department =@ Employee =9 Personnel File - -> Job

3. Modify the number of confirmation month in Housekeeping = Setup = General Setup - ->
Others or Housekeeping = Setup = Default Setting = Confirmation Month to differentiate
the effect of each selected option in this module.

7

Example Four

Change the confirmation month from 3 (old record) to 4 months (new adjustment) for ALL STAFFS,
regardless when the staffs have joined the company.

Re-generate for non-confirmed emplovees automatically

&) all non-confirmed employvees

1. Tick the checkbox and select the first option button as shown above.

2. Go to Housekeeping = Setup = General Setup - -> Others to change the default

confirmation month to 4.

~* General Setup
Company || Leave || Sharing || Tip || Tip(2) | Others
For Leave, Claim, Resource, Appraisal Modules :-

[ allow access to resigned emploves

Default Confirmation Month 4

? ?
‘__./ Are wou sure you wank to save?

[ wes J[  mo

3

[

] [ Cancel ] | Apply |

3. Click "Apply” and then “Yes" button to execute the setup.

4. Then go to HR Department = Employee = Tip to verify the effect of modification.

Staff A
Before modiification (confirmation 3 months)

Effective Date No. of Point/Amount
01/07/2004 0.00000
01/10/2004 2.00000

Staff B

Before modiification (confirmation 3 months)

Effective Date No. of Point/Amount
16/07/2004 0.00000
16/10/2004 2.00000

After modiification (new confirmation 4 months)

Effective Date | No. of Point/Amount

01/07/2004 0.00000

01/11/2004 2.00000

After modiification (new confirmation 4 months)

Effective Date | No. of Point/Amount

16/07/2004 0.00000

16/11/2004 2.00000
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Note:

(i) Before modification, staff A who joined on 01/07/2004 should be confirmed 3 months later on
01/10/2004. But, after modification, the estimated confirmation date has changed to 01/11/2004,
which is 4 months later.

(ii) The structure of tip scheme in number of point/amount remains unchanged.

Example Five
With effective from 01/07/2004, confirmation month for the staffs will be changed to 5 months instead of

old default confirmation month of 3 months.

Re-generate For non-confirmed employvees aukamatically

() all non-confirmed employees
(%) From a specified dake join

(Based on modification date) | Prompt for Date Entry -

1. Tick the relevant option button and specify the effective date to re-generate tip points/amount,
whether the new adjustment shall be effective from Today, Tomorrow, I** Day of Current Month,
I*" Day of Next Month or I°* Day of Next Year.

2. Alternatively, user may preset the system to “Prompt for Date Entry’, allowing user to define and
specify an exact starting date to re-generate the tip points/amount’s effective date.

3. Then, go to Housekeeping = Setup = General Setup - -> Others to change the default
confirmation month to 5.

4. Click “"Apply” and then “Yes" button.

Company || Leave || Sharing || Tip || Tip¢2) | Others

For Leave, Claim, Resource, Appraisal Modules ;-

[ allows access ko resigned emploves

Default Confirmation Month |'s

** Enter Date

Enter a "date join from" to re-generate
employee tip pointfamount {for non-confirmed
emploves) :-

Dake 01/07/2001

Lol (B anic |

5. Enter the effective date 01/07/2004 to re-generate the tip point/amount details. Click "OK" and
then “Yes"” button to acknowledge the setup.

6. Go to HR Department = Employee = Tip to verify the effect of modification.

Staff B
Before modiification After modiification
Effective Date No. of Point/Amount Effective Date | No. of Point/Amount
16/07/2004 0.00000 16/07/2004 0.00000
16/10/2004 2.00000 16/12/2004 2.00000
Staff C
Before modiification After modiification
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Effective Date No. of Point/Amount Effective Date | No. of Point/Amount
01/06/2004 0.00000 01/06/2004 0.00000
01/09/2004 2.00000 01/09/2004 2.00000
Note:

(i) Before modification, all staffs are having confirmation month of 3

(ii) After modification with effective from 01/07/2004, staff B who joined the company after the date
will be affected.

(iii) Staff C who has joined the company earlier that the modification date will not be affected. Staff
C still using the original effective date to calculate the tip point/amount.
(iv) The structure of tip scheme in number of point/amount remains unchanged.

Tip (2

This page allows users to determine the method to be applied in tip calculation.

** General Setup g]
Company || Leave || Sharing || Tip T'P 2) | Others
Enable "Tip Yalue Maintenance” Tez |¥

For Calculating Employee Tip Amount :-

1. When the employee tip point is started/changed in between the specified period in "Tip
Walue Maintenance”, system to take :-

() First day's pointfamount

() Last day's pointfamaount

() awerage of all different poinksfamount in the specified period

(#) Pro-rated poinksfamaunt to days of month
(%) Divide pointfamount by the tatal no. of days in the specified petiod
(3 Divide pointfamount by a fized no. of days [ 25

2. Give tip to the emplovees who are resigned in the current month?

() Yes (total no, of active days in the month)

OND

(o ) (o] (o]

If users are practising tip point method, select * Yes” in Enable "Tip Value Maintenance”
so that to activate the module HR Department = Tip = Tip Value.

Otherwise, select “No" to disable the Tip Value Maintenance module.

Let us evaluate the effect of each calculation method with examples.

Staff A | Effective Date | Point/Amount Staff B | Effective Date | Point/Amount
01/07/2004 20.00000 01/07/2004 30.00000
16/07/2004 25.00000

Assumptions:

(i) Utilisation period is from 01/07/2004 to 31/07/2004
(i) Total value is 1000.00000

(iii) Staff A will be granted increase of point/amount with effect from 16/07/2004
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Steps:

- Setup staffs’ tip details in HR Department = Employee = Tip

- Maintain item (i) & (ii) in HR Department = Tip = Tip Value

- Change different calculation methods in Housekeeping = Setup < General Setup

- Verify the difference of end results in Report = Tip @ Employee Tip Amount Report

Formula:
1. Total Value Per Point = Total Value / No. of Point

2. Employee Tip Amount = Total Value Per Point X Number of Point or Amount for particular
employee

Example One: First day’s point/amount

Employee | Tip Amount

1000 Staff A 400.00000

Total Value Per Point = ---------------- =20 Staff B 600.00000
20 + 30 Total | 1000.00000

Remark: taking the first effective date’s tip point/amount, regardless any adjustment at later date within
the same period

Example Two: Last day’s point/amount

Employee | Tip Amount

1000 Staff A 454.54550

Total Value Per Point = ---------------- = 18.18182 Staff B 545.45460
25+ 30 Total | 1000.00010

Remark: taking the latest effective date’s tip point/amount, regardless any adjustment in earlier days
within the same period

20 + 25 Employee | Tip Amount
No. of Point for Staff A = -----------——-- =22.5 Staff A 428.57145
2 Staff B 571.42860
1000 Total | 1000.00005
Total Value Per Point = ----------------- = 19.04762
22.5+ 30

Remark:

First, calculate the average number of point for employee who has multiple tip point/amount schemes
within the same period.
Then, use this figure to divide total value and also calculate the actual tip amount.

15 16
No. of Point for Staff A = (20 x ----) + (25 x ----- ) = 22.58065
31 31 Employee | Tip Amount
1000 Staff A 429.44783
Total Value Per Point = = 19.018402 Staff B 570.55200
22.58065 + 30 Total 999.99983
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Remark:
Firstly, multiple each different tip point/amount scheme with the exact number of days in the specified
period.

Then, total up all different tip schemes to get the actual number of point for the respective staff.

Note:
By default, the system will use this method to calculate the
employees’ tip amount.

Example Five: Divide point/amount by a fixed no. of days

This method is the same as example four, the main difference is that it allows user to specify a fixed total
number of days as a base.

Assuming that we are using 26 days as the base,

15 16
No. of Point for Staff A = (20 X ) + (25 X ~---) = 26.92308
26 26
Employee | Tip Amount
1000 Staff A 472.97309
Total Value Per Point = = 17.56757 Staff B 527.02710
26.92308 + 30 Total | 1000.00019

Example Six: Resigned employees

Select the option button labeled " Yes (total no. of active days in the month' to include calculation
for those employees resigned within the specified period.

2, Give tip to the employees who are resigned in the current month?

(%) Yes (total no. of active days in the mankh)

Mo

Assume that we have selected calculation method to divide point/amount by the total no. of days.

{*) Pro-rated pointsfamount to days of month

(¥} Divide pointfamount by the tokal na. of days in the specified period

And, assuming that Staff B has resigned on 18/07/2004, therefore,

Employee No. of Point Tip Amount
Staff A 15 16 25.61983 x 22.58065
(20 x ----) + (25 x ----) = 22.58065 | = 578.51241
31 31
Staff B 17 25.61983 x 16.45161
30 x ---- = 16.45161 = 421.48745
31
1000
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Total Value Per Point =

22.58065 + 16.45161

= 25.61983

Others

** General Setup

Company || Leave || Sharing || Tip || Tip (2)

For Leave, Claim, Resource, Appraisal Modules :-

[ allow access ko resigned employes

Default Confirmation Month 3

(o) (o] (o ]

Tick the checkbox “Allow access to resigned employee€’ if user wants to view all
employees database (including those resigned employees) when accessing modules of leave,
claim, resource and appraisal.

Specify the Default Confirmation Month applied to all employees, except those
exclusively defined job titles in Housekeeping > Setup > Default Setting >
Confirmation Month (Refer to chapter 6.1.3.1)

6.1.2 Enquiry Setting

Menu Location: Housekeeping > Setup > Enquiry Setting

Description: This option enables user to define whether want to allow the system to alert
user with reminders. If yes, user may specify the number of days in advance for reminder to
pop out and notify the user.
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** Enquiry Setting

User ID | BOD
Emplovee Mo, E004
Hlame | TAN MING LING

Show Alert .Day in Advance |

I} Birthday Reminder |
| |Confirmation Reminder 14
| |Disciplinary Reminder 14
| |Passport Expire Reminder 14
| |Retraining Reminder 30
| |Reward Reminder 14
| |Termination Reminder 14
| |Work Permit Expire Reminder 50
-

l Edit " Print Il Exit I

1. Click on “Edit” button.

2. At particular reminder record, tick the checkbox “Show Alert’ and specify the number
of Day in Advance for reminder to appear.

3. Click "Save” button to update the setting.

When user login to the system again, user will be prompted with the related reminder(s) for
pending or overdue matters.

6.1.3 Default Setting
6.1.3.1 Confirmation Month

Menu Location: Housekeeping > Setup > Default Setting > Confirmation
Month

Description: This option enables user to define confirmation month specifically for
certain group of employees, if it is different from the default confirmation month
assigned to other employees in the company. For instance, higher level management
or executives might have a longer period of confirmation months compare to normal
employees.

** Default Confirmation Month

Joh Code [aco1
Jab Title | ACCOTNTS  MANAGER
Confirmation Manth [ .
E ob Code  Job Title Confirmation Manth A
| |AD0OL ADMINTIZTRATION MANAGER &
| |C501 COSTOMER SUPPORT MaNAGER 5]
| |HROL HUUMAN RESOURCE MANAGER 6
| |MEOL MARKETING MaNAGER 5]
| |FROL PURCHASING MANAGER g
| [acol QUALITY CONTROL MAWNAGER &
| |FDOL ReD MANAGER 5]
| |8L0O1 BRANCH MANAGER 4
v
[ Add ” Edit " Delete " Prink ] ’ Exit l
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1. Click “"Add” button.

2. Select the affected Job Code. (Records available for selection were created in
HR Department > Miscellaneous File - Job Function.)

3. Specify the Confirmation Month.

4. Click “Save” button to update the setting.

Note:

For job titles not specifically defined in this module, the
respective employees will follow Default Confirmation
Month setup at Housekeeping - Setup > General Setup
- -> Others.

6.1.3.2Salary

Menu Location: Housekeeping > Setup > Default Setting > Salary
Description: This option enables user to setup the default salary amount for the
employees based on different job titles.

Every new job titles created in HR Department > Miscellaneous Files > Jon
Function will automatically updated into this module.

When creating new employee’s details for the first time in HR Department >
Employee > Personnel File, the salary amount applied will depends on the Job
Title (in Job page) selected by user.

The first effective salary amount will be updated concurrently to HR Department
> Employee > Salary.

1. Scrolling through the list to locate for the relevant Job Code. Click “Edit” button.

*“* Default Salary Bj

Job Code ACO1
Jab Title | accommTs MANAGER
Salary 2200.00
Eob Code  Job Title Salary -~
ACOZ ACCOUNTS OFFICER 1200.00
ACOS ACCOUNTS CLERE 1000.00
ADO1 ADMINISTEATION MANAGER Z200.00
ADOZ GENEFRAL CLERE §50.00
ADOS RECEPTIONIST G00.00
Cs0l COSTOMEERE SUPPORT MANAGEER 2500.00
C30z2 CUSTOMER SUPPORT OFFICEE 1500.00
HEOL HUMAN RESOURCE MANAGER 2400.00
HROZ HITMAN RESOURCE OFFICER 1200.00
MEOL MARKETING MANAGER 2600.00
PRO1 PURCHASTNG MANAGER 2400.00
PROZ PURCHASER 1500.00] »
[ Edit H Prink l [ Exit ]

2. Enter the Salary amount for the respective job title.
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3. Click "Save"” button to assign the salary figure to the particular job code.

6.2 Year End Processing

Menu Location: Housekeeping > Year End Processing

Description: This option enables user to close current year’s leave transactions and proceed to the
next fiscal year. It must be done at the end of every fiscal year based on the cut-off period defined
(in Housekeeping > Setup > General Setup - -> Leave)

** Year. End Processing

Please make sure nobody is access to the database,
otherwise execution will not be successful.

Functions of Year End Processing :-

1. Backup individual leave files as YLPdY'Y%Y, YLDEYYYY,
YLSmY Yy and PMastyy in the Folder of "BackUpy" in
hardisk (Y'Y = Year) ;

2. Generate and print Emploves Leave Clearance Report for
those annual leave balance is more than the maximurm day can
be carried Forward, if any ;

3. Calculate and update the total dawv of annual leave to
be carried Forward and annual leave entitled day ;

4, Delete individual leave transactions.

Already backup all files
Already printed all leave reports

Year 004

ol

Before performing year-end process,

(i) backup all files in Housekeeping > Backup and Restore > Backup & Backup
(Administrative Data)

(ii) print the necessary reports for filing, e.g. the Employee Leave Clearance Report,
Employee Leave Summary Report

To perform year-end processing,

1. Confirm by ticking the checkboxes “Already backup all files’ and “ Already printed all
leave reports’.

2. Enter the processing Year.
3. Then, click "OK” and “Yes" button.
4. Preview or print out the Employee Leave Clearance Report.

5. When the process is completed, it will prompt a message. Click "OK” to acknowledge the
message.

After year-end process, the following will take place,
1. A new folder (e.g. Backup04) will be created in the hard disk. It contains: pmast04.dbf,

pmast04.fpt, yldt2004.dbf, ylpd2004.dbf, ylsm2004.dbf and CIrRpt04.txt (Employee Leave
Clearance Report in text format).
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2. Re-calculate the leave entitlement for the employees.
3. Delete the year’s approved leave applications and summary.

4. Update the next cut-off period.

Note:
User should export files to UBS Payroll System before
performing year-end processing.

6.3 Administrative Tools

This category of menus allow users to manage and maintain user security setting, database
management and setup user preference in terms of font type and size.

6.3.1 Group Policy

Menu Location: Housekeeping > Administrative Tools > Group Policy
Description: This option enables users to define the user group’s accessibility in the system.

Add and Edit New Group

** Group Policy @

Policy

Group | STAFF

Mame staff

[ Access all employees in all departments

| [item Tvpe Access Create Edit Delete Print A._

v

Save Cancel

1. Select "Add"” button and key in the group code and name.

2. Tick the checkbox “Access all employees in all departments’ for higher
management. Restrict the accessibility for normal users. Do not tick this check for staff
group.

3. Next, click on "Save” button to confirm.

4. Then, click on the “Edit” button. Notice that both buttons “Item List” and "Delete
Detail” have been enabled. Click on “Item List” button.
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** |tem Control List @

[icheck all
Title  Checked ||

Age Analysis Report
| Age Fange Graph

| Appraizal Form Pending for Sub W
| Appraisal Rating

| Appraisal Result

| Appraisal 3ubmitted

| Approved Leave (By Day) Report
| |areas of Appraisal

| Backup
Backup (Adwinistratiwve Data)
| Birthday Reminder W

| |Branch Graph
| |Branch Table
| Budget Plan Maintenance

| Budget Plan ws Actual Peport
| |Bumiputra Graph
B Category Graph

(o [ o

5. At the Form page, select the form name from the list to assign the authority right for
the group to access to the respective form. Tick the checkbox “Check All” if you want
to select all forms.

6. Click "OK" and the form(s) selected will be display in the table items.

** Group Policy

Group | STAFF | Itemlist ||
Mame | Staff | |
Delete Detail |

| Policy |

[ access all employees in all departments

tem Type Arcess Create Edit Delete Prink il
| |appraisal submitted FORM  [V] V] V] [7] [
| |appraisal Form Pending £JFORM  [V] [ [v] [v] []
| |Ewp. career Movement Mai|FORM [7] 7] ] [] []
| |c1ain approved FOEM  [V] ] ] [V] [
| |rlain Pending for Approw]FOEM  [V] ] [v] [v] (]
| |Emp. Education Backgroun|FOEM  [7] 7 7 [] ]
| |Emp. Experience Maintens|FORM [] ] 7] (] (]
| |Ewp. Family Maintenance |[FORM  [7] ] 7 (] []
| |Ewp. Ewplovwent History |[FORM  [7] ] [ ] [] [
| |Leave approved FORM  [V] ] V] [V] [
| |Emp. Leave Summary FOEM  [V] ] ] [V] [
|| [Leave Pending for Approv{FORM [V [ [ ] [ ] il

Save Cancel

7. There are 5 types of access control to the form you are accessing.

i. Access — enable/disable the user to access to the
form

ii. Create — enable/disable the user to add a new
record

iii. Edit — enable/disable the user to edit the
existing record

iv. Delete — enable/disable the user to delete the
record

v. Print - enable/disable the user to print the
report/listing
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8. Tick the checkbox “Access all employees in all departments” if this particular user
is allowed to access other employees’ data, regardless of their department.

9. Always remember to click “Save” button every time you have finished setup.

Delete Record
To delete any particular form item, you must be in the Edit mode.
1. At the main module screen, click “Edit” button.

2. Move the mouse cursor to point to the unwanted item record and click on “Delete
Detail” button.

3. Click “Yes” if you are sure and wanted to delete the item record.
4. Always remember to click “Save” button to confirm update to the user group profile.
To delete a user group,

1. At the main module screen, select the user group to be deleted, click "Delete” button
at the bottom of the screen.

2. Click “Yes" to confirm deletion of the entire user group.

6.3.2 User Manager
Menu Location: Housekeeping > Administrative Tools > User Manager
Description: This option enables user to create login id as well as assigning user’s
authorization level.

Add New User

** liser Manager.

User

@ User ID | agnes

Marne Aomes Tan Yihg Ying

Password A e e

Retype Password | #wawsaas

User Group HOD * || HOD /Manager
[ stvstem Administrakar [ suspend
Employes Mo, E0OOL * || AGNES TaAN YING YING

Allowy access to the following approval column For own department ;-

HOD Approwval [CJFinal &pprowal

Save Cancel

1. Select "Add” button and key in :-

User ID - Assign login identification code for
each user (maximum 8 characters).
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Name - User name (maximum 30 characters).
Password - Enter unique personal identification

number not exceeding 8 characters
and retype the same password in the
next column to confirm.
User Group - Assign by select the user’s authorization level.
(New user group can be created in
Housekeeping > Administrative Tools > Group Policy)
M System Administrator
System administrator has the authority to access into all modules.

M Suspend

Click on the Suspend checkbox to terminate the user access right for any inactive user.

2. Click on the Employee No. arrow down button to select the relevant employee profile.

3. Tick the related checkbox if the particular employee is aothorised to perform HOD
Approval and/or Final Approval.

4. Click * Save” if confirmed correct, otherwise “Cancel”

Edit User Profile

Select “Edit” button to modify user profile such as user name, re-assign user group,
authorizing administrator function or even suspending any user id.

Remember to click "Save” to confirm any modification done.

Delete User

Select the particular user record and click "Delete” button to remove any user id from the
system.
Click “Yes" to confirm a deletion, otherwise “"No"” to cancel.

Department Approval

Menu Location: Housekeeping > Administrative Tools > Department Approval
Description: This option enables user to assign additional approval authorization rights other
than the original responsibilities. For instance, Head of Department of Admin Department can
be appointed to approve leave application, claim submission and resource request for other
department’s employees, e.g. Accounts and Marketing Department.
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** Department Approval g|
Employes Mo, .Eggl

Mame | AGNES TAN YING YING
Depattrient Code f.ACCT Al
Department Mame f-gccumrrs

Allows access to the Following approwal column for the above depattment -

[ mployes Mo, Department Code HCOD Approval Final approwal ol
| |[EOOL MEET T T
| |E0D4 PURLC T F

S|

l Add " Edit: “ Delete H Prink ] [ Exit l

1. Click on “Add” button.

2. Select the respective Employee No.

3. Specify the Department Code which he/she will be appointed to be in-charge of.
4. Tick the checkbox for approval level HOD Approval and/or Final Approval.

5. Click “"Save” button to update the profile.

6.3.4 Database Clearance
Menu Location: Housekeeping > Administrative Tools > Database Clearance

Description: This option enables user to delete/purge transactions or all records in the
system. After the clearance process, the data files will not be able to recover.

** Natabase Clearance |§|

Database Clearance
Clean up the database records, @

Please select the option below For the cleaning process

(#)iDelete transaction records only:

Al records in khe transaction Files will be erased but the maintenance files will
not affecked,

() Delete all records in the database

Both maintenance and transaction file's records will be erased.

|
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transaction file's records from the database.

Tick the related option button and click “"Next”, follow by "Finish” and then “Yes” to

confirm execution of database clearance.

6.3.5 Language Editor

Menu Location: Housekeeping - Administrative Tools > Language Editor
Description: This option enables user to define and determine the language to be used in the
system. Languages available are English, Chinese, Malay, Thai, Indonesia and Vietnam.

** |anguage Editor gj

English

IMalay

"Other”™ Marital Status Description

"Other”™ Marital Status Description

(days)

{hari)

[mins)

[mins)

* Note: This is only recommended for new

* Note: This is only recommended for new

- The titles are sorted according to an a

- The titles are sorted according to an a

- ¥You can only select 7 titles for the Di

- ¥ou can only select 7 titles for the Di

01/01/2003

0170172003

5.

L.

1. Backup the database if you find that t]

1. Backup the database if you find that t]

_lst, & 2nd Half Payroll

General

Statement (English) (hours)

Statement (Other) jam

Language Malay

1st & 2nd Half Payroll

Total Records

ga0
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-

Save Cancel

To setup the language database, select the relevant Language.

1.
2. Click “Edit” button.
3.
Statement (Other).
4. Click “Save” button. Then, click “Exit” button.
5.
6. To observe the effect, go to the affected module or menu option.

6.3.6 Font Editor

Locate the related word in Statement (English). Enter the converted vocabulary in

Next, go to Help 2 Language, select the particular language. Alternatively, user may
click Language hyperlink at the system front page to change to other language.

Menu Location: Housekeeping > Administrative Tools - Font Editor

Description: This option enables users to reset or change the system’s default font style and

size for labels and text boxes.
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** Font Editor,

% Label
FontMame |Microsoft 3ans Serif l Sample

Font Size g _|

Text Box

Font Mame !Courf_r New I A i
Fant Size !_9 __.._.I

[ o ][ coen ]

1. Click on the button with the capital alphabet “A”.

2. Choose the desired font type and size. The font layout format will be displayed in the
sample text box on the right.

3. Click "OK" button to confirm and exit from the setup screen.

6.4 Reindex Database

Menu Location: Housekeeping - Reindex Database
Description: This option enables users to re-index all the database files in the system.

** Reindex Datahase

Reindex Database
Reindex the existing database. %
F—

In network enyvironment, make sure you are the only user to access
to this option

o || concal |

Before performing reindex database function, please make sure you have closed all the menus and
there is no other user logon or using the system through network environment.

6.5 Upgrade Database

Menu Location: Housekeeping - Upgrade Database
Description: This option enables users to upgrade the database to a latest version.
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*“* Upgrade Database

Upgrade Database
Upqgrade the existing database structure, %
F—

In network enyironment, make sure you are the only user to access
to this option

(0] 4 l l Cancel

Before upgrading the database, please ensure that you have closed all the menus and there is no
other user logon or using the system through network environment.

6.6 Backup and Restore
6.6.1 Backup

Menu Location: Housekeeping - Backup and Restore > Backup
Description: This option enables users to backup all the data files.

** Backup g|

it 1yt

“n In network environment, make sure you are the only user to access to
this option
Default Directory @ ciiyubs softwareiubshrmsidata) MESSAGE g]
= -

Eackup to | &z vhrms2004y “!j) Backup completed! | ID

Backup Progress : | 100% Item 161 of 161

File Progress : | 100%  workcal.dibf

| Eackup | ’ Close ]

1. Click on the button at the far right end of the column “Backup to'".

2. Select the disk drive or destination directory and folder that you want to save your
backup files.

3. Click on “"Backup” button to execute backup process.
4. Click "OK" to start the process, otherwise “Cancel” to abort.

5. Acknowledge the message by click "OK" after the backup process has completed, then
click “"Close” button to exit.
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6.6.2 Restore

Menu Location: Housekeeping - Backup and Restore > Restore
Description: This option enables users to restore all the data files from the backup source, in
case of data corruption or file damage.

** Restore g|

g0
i .

In network environment, make sure you are the only user to access to
this option

Default Directory @ c:iubs softwareiubshrmsidatal

Restare From : arVhrus2004Y . g . D
- 1 y Restore completed! |- =
Restare Progress ; | 100%  Item 161 of 161

File Progress ; |1DD% Extracting: o:wbs softw [ Ok ]

| Restore H Close ]

1. Click on the button at the far right end of the column “"Restore from”.
2. Select the disk drive or source directory and folder of your backup files.
3. Click on “"Restore” button to execute the restore process.
4. Click “Yes" to start the process, otherwise "No” to cancel.

5. Acknowledge the message by click "OK" after the restore process has completed, then
click “Close"” button to exit.

6.6.3 Backup (Administrative Data)

Menu Location: Housekeeping - Backup and Restore > Backup (Administrative
Data)

Description: This option enables users to backup data files which related to administrative
functions such as group policy and user access rights.

% Backup (Administrative Data)

In network environment, make sure you are the only user to access to

this option
Administrative Directory @ c:lubs softwareiubshrmstadminnolh
Backup to : | asvhruszooay \i# Backup campleted! | D
Backup Progress ¢ | 100%  |temn 13 of 13
File Progress ; | 100%  users.dhf

1. Click on the button at the far right end of the column “Backup to’.

2. Select the disk drive or destination directory and folder that you want to save your
administrative backup files.

3. Click on "Backup” button to execute backup process.

4. Click "OK" to start the process, otherwise “"No"” to cancel.
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5. Acknowledge the message by click "OK" after the backup process has completed, then
click “Close” button to exit.

6.6.4 Restore (Administrative Data)

Menu Location: Housekeeping - Backup and Restore > Restore (Administrative
Data)
Description: This option enables users to restore the administrative files from the backup
source.

** Restore (Administrative Data)

In network enyvironment, make sure you are the only user to access to

this option
Administrative Directory @ cubs softwareubshrmsiadmindoll
Restore from | a:vhrmsz004% j) Restare completed! ;D
Restore Progress : | 100% Iltem130f13
File Progress ; | 100% Extracting: cwbs softwareWwbshrms [_OK_]

| Restore H Close ]

1. Click on the button at the far right end of the column “Restore from".

2. Select the disk drive or source directory and folder of your administrative backup files.
3. Click on “"Restore” button to execute the restore process.

4. Click “Yes” to start the process, otherwise "No” to cancel.

5. Acknowledge the message by click "OK" after the restore process has completed, then
click “Close” button to exit.

6.7 Import and Export
Menu Location: Housekeeping - Import and Export

Description: This option enables users to post the records (e.g. personnel, salary, line number,
category table, leave, claim and loan details) to/from UBS Payroll System.
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** |mport and Export fromfto UBS Payroll System

o Please make sure nobody access to the database,

otherwise execution will not be successful.

Functions of Importing and E=porting Data ;-
1. Import/export the employee, zalary, line no., and/or category
tables from/to payroll ystem.
Functions of Exporting Leawve, Claim, and Loan Data -
1. Calculate the total day of leave has been taken and export the
leave data for payroll calculation.

2. Calculate the total claim amount for each claim type and export
the claim data for payroll calculation.

3. Generate the loan repayment detailz and export the total loan
repayment amount for payroll deduction.
Select action :-

O Impoart
@ Export

Tk l [ Cancel ]

1. Select the action to be performed by choosing the related option button Import or Export.

2. Click “"Next” button.

Export Data

Select bype of information ko import or expart ;-

Emplovee Leave
Salary Claim
Line Mo, Loan
Categary

Select if you want the system to automatically update the total no.
of children below 18 wears old For all emplovees :-

® yes Ota
3. Select type of information to export, tick the relevant checkboxes Employee, Salary, Line
No., Category, Leave, Claim and/or Loan.
4. Select “Yes" option button if you want to auto update the total number of children below 18
years old for all employees (in HR Department > Employee > Personnel File - ->

Family).

5. Then, click "Next” button to proceed to the following step.
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Payroll:-
Type énd Half Payroll w
Maonkh DEC w
Leave & Claim:- Leave and claim transaction period are same

Leave Transaction Date From | g1/12/2004 |To | 31/1Z/2004
Claim Transaction Date From 0l/1z/z004 |[To | 31/1zZ/zZ004

Loan:-
Yfear 2004
Manth 12 Loan Payment Date 31712742004

6. Specify Type of salary processing in I Half Payroll or 2 Half Payroll. And, select the related
Payroll Month.

7. Specify the range of Leave and Claim Transaction dates. Tick the checkbox “Leave and
claim transaction period are same’ if both should be calculated within the same period.
Otherwise, you may define individually by untick this checkbox.

8. Next, specify the Yearand Month for loan processing. And, enter the Loan Payment Date,

which refer to the date of loan repayment. This date will update to Payment Date in HR
Department > Loan - -> Link.

9. Then, click "Next” button to proceed to the following step.

Select emploves range -

Emploves Mo, From E00L E]
Ermployves Mo, To EEEEEE E]
[J active Emploves Only

10. Specify the range of employees. Then, click "Next” button to proceed. No need to tick the
checkbox “Active Employee Only' if user wants to export including non-active employees’
database, e.g. to cater processing for employees who left the company within the month.

Enter a temporary folder to be imported from or exported to -

[Mote: While running import/export in UBS Payroll System,
you must enter the same temporary folder as below.]

Folder C:\HEMSY, D

Ceo |

11. This Folder is the destination where data will be exported to. User must specify the same
directory folder when performing import process in UBS Payroll System.

=
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12. Lastly, click “Finish” and then “Yes” button to start the exporting process.

13. Files exported from UBS HRMS are cate9.dbf (category), claim9.dbf (claim amount), leave9.dbf
(total leave day taken for AL, MC, MT, MR, CL, HL, LS, NPL & AB), paytran9.dbf (loan
repayment amount), salary9.dbf (effective salary and amount), tlineno9.dbf (line number),
tpmast.dbf & tpmast.fpt (employee’s details) and CPLeave9.dbf (increased compensation leave).

Import Data

Use these steps to import data after processing export option in UBS Payroll System (at
Miscellaneous > UBS HRMS Option > Export / Import HRMS Files). Files exported are
Cate9.dbf, Salary9.dbf, Tlineno.dbf, Tpmast.dbf and Tpmast.fpt

Select bype of information ko impart or expark ;-

Employes
Salary
Line Mo,
Category

Select if wou wank the syskem to automatically update the total no,
of children below 18 vears old for all emplovess ;-

(®) yes O o

3. Select type of information to import, tick the relevant checkboxes Employee, Salary, Line No.
and/or Category.

4. Select “Yes"” option button if you want to auto update the total number of children below 18
years old for all employees (in HR Department > Employee > Personnel File - ->
Family).

5. Then, click *Next” button to proceed to the following step.

Select emploves range ;-
Employee Mo, From EQ0l

Emploves Mo, To ZEEEEZ

KI[KN

[ active Employee Only

6. Specify the range of employees to be imported. Then, click *Next” button to proceed.
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Enter a bempoarary Falder ko be imported fram or exparted ta -
[Mote: While running import/export in UBS Payroll System,
you must enter the zame temporary folder as helow_)

Folder

C: \HRITS

()

e

7. This Folder represents the source where data shall be imported from. User must specify the
same directory folder while performing export process at UBS Payroll System.

8. Lastly, click “Finish” and then “Yes" button to start the importing process.

(A) Link with UBS Payroll System

System’s Condition

Initial Setup Steps and Procedure

-HRMS (existing users)
-Payroll (new users)

WN =

. HRMS : export (Employee, Salary, Line No & Category)
. Payroll : import (the above 4 files)
. HRMS : setup data sharing at Housekeeping > Setup > General

Setup - -> Sharing

- Payroll (existing users)
- HRMS (new users)

. Payroll : update AL balance at Miscellaneous = UBS HRMS Option

2> Update Annual Leave Balance

. Payroll : export (Salary)
. HRMS : setup data sharing
. HRMS : import (Salary)

- HRMS (new users)
- Payroll (new users)

= BhAWN

. HRMS : setup data sharing

(B) Not Link with UBS Payroll System

System'’s Condition

Initial Setup Steps and Procedure

- HRMS (existing users)
- Payroll (new users)

. HRMS : export (Employee, Salary, Line No. & Category)
. Payroll : import (the above 4 files)

- Payroll (existing users)
- HRMS (new users)

1. Payroll : update AL balance at Miscellaneous > UBS HRMS Option

wWN

> Update Annual Leave Balance

. Payroll : export all files
. HRMS : import all files

Note:

basis.

Subsequently, users should perform export process in HRMS (for
Leave, Claim and Loan) and import to Payroll System, on monthly

6.8 Re-Calculate Leave

Menu Location: Housekeeping - Re-Calculate Leave
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Description: This option will perform re-calculation and update of the employees’ leave entitlement.

** Re-Calculate Leave g|

Please make sure nobody is access to the database,
otherwise execution will not be successful.

Functions of Re-Calculate Leave :-

1. Re-calculate and update the leave summary File;

2. Re-calculate and update the katal annual leave (ALY
entitled and/or balance day, if selected below, *

* hoke: This is only recommended For new setup, those :-

a) has keved in the emplovee particulars (i.e., date join, leave
scheme code) , total brought Forward AL From previous vear

and;
]} has not keved in the opening of AL entitled and balance.

Cut OFf Period From | 01/01/2004 | To |31/12/2004
Cwerwrite botal AL entitled day (Only recommended For new setup)

Crverwrite tokal AL balance day (Only recommended For new setup)
Active Employes Only

[ e |

Cut-off period is according to the setup in Housekeeping > Setup > General Setup - ->
Leave

After recalculation, the system will update the leave summary and overwrite Total Annual Leave
Entitled and Annual Leave Balance in HR Department > Employee > Personnel File - ->
Benefit and Application/Approval > Leave > Leave Summary.

6.9 Change Password

Menu Location: Housekeeping - Change Password
Description: This option enables users to change password.

- n B

% User ID | B

Password wEE

New Password wEE

0] 4 l [ Cancel

% Confirm Password

Please confirm again your new password

Confirm Password wEE

T

1. Enter User ID and existing password.
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2. Key in a new password with maximum of 8 characters.
3. Click "OK” button and there will be another sub-menu pop-out.

4. Re-enter the same new password entered just now to confirm for execution.

5. Click "OK” button to acknowledge change of password.

6.10 Direct Access

Menu Location: Housekeeping > Direct Access
Description: This option enables users to setup preferable menu items and implements them into
the direct access function.

** Direct Access

User ID : UBS

Title Checked |~ |
r ]
| |Age Range Graph |
| |Appraisal Form Pending for Sub
| |Appraisal Rating

| |Appraizal Result

| |Appraizal Submitted W
| |approved Leave (By Day) Report
| |areas of dppraisal

| |Backup

| |Backup {Administrative Data)

| |Birthday Reminder W
| |Branch Graph |
[[Branch Table

- You can only select 7 titles For the Direck Access screen.

- The titles are sorted according to an alphabetical order,

1. Tick in the checkbox for the menu items that you want them to be added into direct access.
2. Users are only allowed to select 7 titles for direct access.
3. Click "OK" button to confirm and exit the screen.
4. Logoff from the system and login again to observe the setup effect at the front page after
system refresh.
6.11 Select Printer

Menu Location: Housekeeping > Select Printer
Description: This option enables users to select the printer for printing of reports and forms.

Printer,

Frirter

REEN

Status:
Type:
wihere:
Comment:

ak. I [ Cahcel

werhHP Laser et 1100 [M5]

Ready
HP Lazer)et 1100 [M5]
WWUBS-SERVERMHPLaser)
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1. Click on the arrow down button at Mame to select and specify the printer that you will be
using.

2. Click on "OK" button to confirm the correct printer to be printed from.

3. Ifitis not shown in the printer name list, you might need to setup and add a printer from the
network. Click on the “"Network” to locate the new printer.

COPYRIGHT © UBS CORPORATION SDN BHD



ssssssssssssssss n Human Resource Management User Manual Page 194 of 223

Human Resource Management

User Manual

(Others)

COPYRIGHT © UBS CORPORATION SDN BHD



EZUBS

User Business System Human Resource Management User Manual Page 195 of 223

CONTENTS

Chapter 7 Others

7.1 News

7.2 Reports

7.3 Recent

7.4 Direct Access
7.5 Help

7.6 Exit

COPYRIGHT © UBS CORPORATION SDN BHD



UBS

User Business System

Chapter 7 OTHERS

Overview:

Human Resource Management User Manual

Page 196 of 223

This chapter explains matters related to other features available in the system. Certain features are
accessible at the front page as short-cut link to the respective menu.

UBS Human Resource Management

HR Department  Appication/Approval Enquiry  Report Graph  Housskesping Help  Exit

o 9 Human Resource
i M. t Syst
\y anagement System

News

Recently joined employee

=8|

Home = Language About

7 . 1 Resigned employee
Employee on leave
View Approved Leave Recent Date
Shortcut to Approve Leave General Setup Today
Job Status Table Today 7 3
Personnel File Maintenance Today
Shorteut To Approve Leave Today
Transport Table Today
Jeparte Direct Access
Emp. Personal Details Appraisal Farm Pending for Sub
7.0 Emp. Personal Listing Claim Approved

Emp. Resignation Report
Emp. Approved Leave Details
Emp, Training Needs Analysis

Claim Pending for Approval
Emp. Leave Summary

Leave Approved

7.4

Personnel File Maintenance

Resource Requisition Pending f

Licznsed To | UBS CORPORATION BERHAD

Copyright @ 1993 - 2004 UBS Carporation, All rights reserved.

7.1 News

This section provides 5 fast access links enabling users to retrieve essential information for quick
view in employees’ database.

7.1.1 Recently Joined Employee

It will display the summary of new employee(s) who joined the company recently within
current week.

Point to the Recently joined employee hyperlink and click on the left mouse button once to
display the list.

Click Back or Next button at bottom of the screen to access forward or backward through
the new employee listing.
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Mew employees who will be joining this week are listed below:

Employee No. MName Department Commencement
EODO4 TAMN MING LING R&D a1/03/2004
EOOS AMNDY LOO CHIM SIM MRET a1josiza04
EQDE ROBERT LIM HUI MUM HR 060812004
E0O7 LIMD QI POH POH MRET Q70512004
Page 1 of 1
Back | | Mext

7.1.2 Resigned Employee

It will display the employees who have resigned from the company within current week. It will
indicate the employee number, name, department and resigned date. Information will be
sorted by resigned date.

Point to the Resigned employee hyperlink and click on the left mouse button once to
display the list.

Click Back or Next button at bottom of the screen to access forward or backward through
the resigned employee listing.

Employees who have resigned this week are listed below:

Employee No. Name Department Resigned
EO0E SITI BIMTI ABDULLAH ADMIN 10/08f2004
EOQO7 LIMD& ©OI POH POH MRKET 14/08/2004
Page 1 of 1
Back | | Mext

7.1.3 Employee On Leave

It will display the employees who are on leave today. It will indicate the employee number,
name, department and type of leave applied.

Point to the Employee on leave hyperlink and click on the left mouse button once to display
the list.

Click Back or Next button at bottom of the screen to access forward or backward through
the listing.
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Employees who are on leave koday are listed belaw:

Employee No. Name

E001 AGHES TAN YING YING
E003 SITI BINTI ABDULLAH
Page 1 of 1
Back | | MNext

7.1.4 View Approved Leave

Human Resource Management User Manual
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Department Leave

ACCT
ADMIN

AL
EM

It will display the summary of all approved leave within specified period of time.

Point to the hyperlink titled View Approved Leave and click on the left mouse button once

to access to the menu.

~* View Approved Leave @
‘ear 2004 v Manth Azt -
1stWeek || 2nd Week || 3rd Week | 4thWeek || SthWeek || 6th Week
04/08 Detzils 05/08,/2004 Thursday Details | ||
Erp. Mo, Mame Leave Session | Ernp. Mo, Marne Leave Session | &
’ | | [ [
*| | ~
Leave Code & Description -
AB & Absent EM : Emergency MT @ Maternity
AD : Advance EX : Examination MP : MNon Pay
AL Annual HL : Hospitalisstion ~ PT : Paternity
L : Compassionabe  MC : Sick 50 ¢ Shut Down
P 1 Compensation MR : Marriage
et

Specify by selecting the related Year and/or Month if user wants to view the details for a

specified period of time.

The main page of multiple index pages in the grid table shows summary of leave taken by
employees for Today & Tomorrow respectively. Select the record and click “ Details” button
placed at the top of the table to access to the Leave Details.
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** View Approved Leave El
Year z004 £v3 Month =Ruqust, £v3
Today & Tomorrow || 1st Week | 12 il ard Week || 4th Week || Sthweek || eth Week
02/08;2004 Monday 05/08/2004 Thursday Details
Emp. Ma. Mame Leave Session | A Ernp. Ma. Mame Leave Session
| | >
03/08/2004 Tuesday Details 06,/08,/2004 Friday
Emp. Mo, Mame Leave Session | A Fmp. Mo, Mame Leave Session |
Sl e
14/08/2 07,/08/2004 Saturday
Emp. Mo, Mame Leave Session | A Ermp. Mo, Mame Leave Session
: |
A w
Leave Code & Description :- 08/08,/2004 Sunday Details
BB @ Absent EM : Emergency MT & Maternity Frip. Mo. Marme Leave Session
AD @ Advance E¥ : Examination MNP : Mon Pay
AL o Annual HL : Hospitalisation  PT @ Paternity
CL : Compassionate  MC : Sick SD ¢ Shut Down |
CP : Compensation MR : Marriage Ll el

Navigate through the index-page labeled 2% week, 2"° week and so on, observing the
remark and information indicated inside individual table. The first item (e.g. Monday) in the
page is appeared according to user setup of First Day of the Week in Housekeeping >
Setup > General Setup - -> Leave. Current date’s records will be colored differently to
differentiate from other day. Employees who are on leave will be indicated in the related date.
Click on the “Details” button to access to the respective Leave Details.

Click on the “Print” button to access and print the Approved Leave (By Day) Report.

7.1.5 Shortcut to Approved Leave

This feature enables eligible users to have a quick view of the leave application pending
approval or fast access to the particular leave application so that to process approval,
cancellation or deletion.

This option is only accessible by System Administrator, HR Manager (HRM) and Head of
Department (HOD). This menu will pop out whenever a system administrator, HRM or HOD
login the system, whenever there is any leave application pending for approval.

** Shortcut To Approve Leave @

HOD App. Finai App. Emp. Mo, Name Dept. Cocié Leave Date From Date To -
C |
Pending | Pending |[E00Z WILLIAM 00I 5IM HUI Rl CP 09/08/2004)09/05/2004
I Pending |[E004 | TAN MING LING Rl HC 05/08/2004)03/05/2004
Pending | Pending |[E00S ANDY LOO CHIN SIM MRET EX 19/08/2004|20/05/2004

v

Display [ Edit " Delete " Print ] [ Exit ]

11

HOD Approved
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The table will list out approval status (HOD approved and Final Approval), employee number
and name, department, type of leave applied and date when take leave.

User may choose to display A/ leave application or only HOD Approved application, by
clicking the arrow down button “Display” located at the bottom left of the menu.

Select a particular leave record and click on “Edit” button to approve or cancel the application.
Select "Delete” button if user wants to delete the unwanted leave application.

Select “Print” button to preview or print out the Leave Application Form or Employee Leave
Details (Pending for Approval) Report,

7.2 Reports

This section will highlight 5 types of common and demanded reports that most users will access to.
Reports available are:-

(i) Employee Personal Details

(i) Employee Personal Listing

(i) Employee Resignation Report

(iv) Employee Approved Leave Details
(v) Employee Training Needs Analysis

Point the mouse cursor to a particular report hyperlink and click left mouse button once to access to
the respective report menu.

7.3 Recent

This section will show 5 menu options that user had accessed recently. It will indicate the date of last
access to the particular menu.

User may point the mouse cursor to a particular menu and left click mouse button once, to access
directly to the respective menu again.

7.4 Direct Access

This section reflects user-defined direct access for 7 types of menu options. User may change
preferable and most frequent used menu option at Housekeeping - Direct Access.

Point the mouse cursor to the selected direct access option and left click mouse button once to
access directly to the respective menu.

7.5 Help

7.5.1 About

This section reveals the software’s copyright and its legal users with authorized license. It will
indicate the software version, working and database folder, current login user and the product
status.
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UBS Human Resource Management System
Capyright @ 1999 - 2004 UES Carparation, All vights reserved.

This product is licensed to:

UES CORPORATION BERHAD

¥ersion: Z.0[11 August 2004]
Working Folder: c:hubshrms
Database Folder: c:ubshrmsidata
Current User: LES

Product Status: License Edition

7.5.2 Calculator

This system is embedded with built-in 14-digit calculator for the convenience of users in
performing calculation.

M| 12345678001234 +

I
b= e ) e
CoaaEn
DoaBns

7.5.3 Calendar

The system is also embedded with calendar/diary facilities, enables users to search for a
specified period in calendar as well as inputting notes and planning daily schedule.

B Calendar/Diary

August 2004 This is the diary section far

SuMoTuWeTh Fr Sa userto input reminder and
plan for daily activities and
112 3 5] 6|7 schedule.

819 (1011121314
151617 1219 20]21
23| 23| 24| 25 28] 27| 28] |
2930021

Try it !

W

= Month | | Month -

= Year ”‘r‘ear> H Today ]

7.6 Exit

There can be two situations when users want to leave the system.
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7.6.1 User Log Off

This option enables users to log out from the authorization level but not totally out from the
program.

.\_‘.'.:) Do wou want ko log off?

[ fes ] [ =] l

If you click “Yes” button, you will be asked to login again to access to the system. If you click
“No"” button, you are still remain in the system.

7.6.2 Exit Application

This option allows user to quit the UBS Human Resource Management System.

? .p
\_,L.(/ Are wou sure ko exiky

[ es ] I Mo ]

Click “Yes" button to exit the system completely. Click "No” button to remain in the system.
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Human Resource Management

Bonus

(Tip Allowance)
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Tip

Some companies provide the benefit of tip allowance to their employees. Therefore, the employers need
to record and calculate amount of tip or number of point earned by each employee. Then, at the end of
a specified period, users can include the tip figure and export to UBS Payroll System for salary processing.

Typical operations for setting, recording and calculating tip can be summarized as the following steps-

i) create the tip scheme (in HR Department = Tip = Tip Scheme)

i) implement default tip scheme based on job title (in HR Department = Tip < Default Tip
Scheme)

ii) assign particular tip scheme to respective employees (in HR Department < Employee 2
Personnel File)

iv) maintain/modify individual employee’s tip figure (in HR Department = Employee = Tip)

v) calculation of tip value (in HR Department = Tip = Tip Value)

vi) view summary reports (in Report = Tip - Employee Tip Amount Reportand Report = Tip >
Employee Salary and Tip Summary Report)

Basically, there are two types of tip activities, whether it is operated by amount or point. Users can setup
the necessary operation method in Housekeeping = Setup =9 General Setup - -> Tip & Tip (2)

Menu Location: HR Department = Tip = Tip Scheme
Description: This option enables users to create/setup different tip schemes.

** Tip Scheme Code Maintenance

Scheme Code ' TCOL
Drescripkion | FOR MANAGEMENT LEVEL
Apply Skatus Before Confirmation
Remark,
Echeme Code Descripkion Apply Status |
| [TCoz FOR NON-MANAGEMENT LEVEL After
L
Addiew Detail l Add || Edit ” Delete || Print | | E ik |

9. Click “"Add"” button to create a new scheme.

10. Enter the relevant information:-
Scheme Code : Create an abbreviation code for each scheme (not more than 4 characters)
Description : Define the scheme code with details not more than 50 characters.
Apply Status : Specify the scheme is to be applied before or after the employees’

confirmation to the job (select Before Confirmation or After Confirmation).

COPYRIGHT © UBS CORPORATION SDN BHD



UBS

User Business System

Remark

11. Click “Save” button to store the information.

Human Resource Management User Manual

Page 205 of 223

: Any additional notes or explanation pertaining to the scheme’s status.

12. Point to the newly created scheme code, select "Add/View Detail” button on the left of the

module.

13. At Tip Scheme Detail Maintenance sub-menu, click "Add” button.

** Tip Scheme Detail Maintenance

Scherne Code TCOl
Description FOR MANAGEMENT LEVEL
Length of Service in Monkth From 1z To = 24
Mo. of Paint | Amounk [ 15.nnnun
[ anth From Manth To Paint | Arnount -~
| ] 12 10. 00000
K
_ L
|. Save || Cancel l

14. Then, classify the category by entering number of months in both Length of Service in Month

From and To. And, specify the humber of point or amount for each range of months. This will
determine the default value earned by each employee based on their length of service with the

company.

15. After that, click "Save” button to update the details. Click "Add” button again if there are more
range of months to be maintained. Repeat step 6 and 7.

16. If there are no more details to specify, select “Exit” button to quit.

Menu Location: HR Department = Tip = Default Tip Scheme
Description: This option facilitates users to setup tip scheme by assigning different scheme to different
job title. This process enables the system to recognize the tip scheme entitlement based on the
employee’s job title.
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** Default Tip Scheme

Job Cade | AC0O1

Jab Title | ACCOTNTS MANAGER

Tip Scheme ;-

Code TCOL

Description FOR MANAGEMENT LEVEL

ﬁnb Code  Job Title Scheme Code -

ACOZ LCCOUNTS OFFICER TCOZ

ACO3 LCCOTUNTS CLERE TCOZ

ADOL ADMINISTEATION MANAGEER TCO1

ADOZE GENERLL CLERE TCOZ

ADO3 EECEFTIONIST TCOZ

Caol CUSTOMEE 3UPPORT MANAGEE TCO1

Ca0z CUSTOMEE. 3UPFORT OFFICEER TCOZ

HEOL HUMAN EE3I0OURCE MANAGEER TCO1

HEOZ HUMAN EE3IOURCE OFFICEER TCOZ

MEOL MAREETING MANAGEER TCO1

FPREOL PURCHALIING MANAGEER TCO1

PROZ PURCHASEER TCOZ b
| Edit || Print l | Exit |

All job titles created in HR Department = Miscellaneous Files = Job Function will be listed in the
module. To assign a specify job title with a particular tip scheme,

6. Select a particular Job Code from the table. Click “Edit” button.

7. At the field Tip Scheme Code, click the arrow down button to select the relevant tip scheme.
This code selected refers to the detailed tip scheme created earlier in HR Department = Tip
= Tip Scheme.

8. Click “Save” button to confirm the scheme assigned for the particular job title.

9. Proceed to the next job title record and complete the scheme assignment process. Repeat step 1
to 3.

10. Click “Exit” button to quit this module.

Menu Location: HR Department - Employee = Personnel File

During the employee’s personnel file maintenance, two areas which will be controlling and affecting the
tip operations are the Benefit and Job page in the Personnel File Maintenance module.

Benefit
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** Parsonnel File Maintenance

Emplovee No. | Eool Marne |AGN'ES TAN YING YING | Initial | TYY |

| Personal | Statutory Job || Family || Education Background || Employment Hiskory | Benefit ITraining

Leave Scheme Code | L1301 | FOR MANAGEMENT LEVEL |
Maximurn Carried Forward Annual Leave 5. |:||:|i Lenath of Service in Year Day Entitled
Leave Code ! AL w || ettt | 0| To = 2.00 Is 15.0
ot 2.00| To = | &.00 Is 15.0
Leave Application Status !ﬂfter Confirmation |
L.00| To < | 99.0 Iz 22.0
Total Brought Forward Annual Leave .00
Mote: '<' = Less Than
Tokal Annual Leays Entitled zz.00 Annual Leave Balance 26,00
Claim scheme Code C302 || FOR NON-3ALES STAFF |
IZlzim Code  Claim Description Max Claim Per Receipt  Max Claim Per Year Remark s
¥
0z DENTAL &0.00 &0.00
a5 OUTSETATION 500.00 5000, 00 E
’/,QQ’_“P-&RKIEG FEE 100,00 1200.00 v
< Tip Scheme Code ) | TCOl ” FOR MANAGEMENT LEVEL |
Edit H Delete " Search " Print I [ Exit ]

e
o Lo Lo |

Select the relevant Tip Scheme Code for the respective employee. The scheme detail is setup in HR
Department = Tip =& Tip Scheme.

Job

** Personnel File Maintenance

Employes Mo. | EQ01 Mame |AGI-]'ES TLN YING YING Initial | TvT |

Personal || Statukory [

Farmily [ Education Backaround || Employment Hiskory _5 Benefit | Training |

< Job Title Arnl | ACCOTNTS MANAGER Specific Job Function

Job Status MG MANAGEMENT 1. GIVE ERIEFING ON COMPANTY *‘_\
POLICY TO ALL NEW EMPLOYEES.

e EELL MAIN ERANCH KL 2. DEAL WITH GOVERMMENT BODY

Department ACCT LCCOUNTS 0N BEHALF 0OF MANAGING
DIRECTOR.

Line Mo, \

Cakegory \

Date Join 04;’5\%)‘1993

Dake Confirm DlKEISXlBBS

Date Promote leDl,n‘]\QBS

Termination of Service :—\

DateTerminate| A \ »
Reasan w
= "
Pay Status Aotive \ -
\
\
=i ’ Mexk “ Léit l ’ add ” Edit ” Delete ” Seatch ” Print l l Exijt ]
\

The tip scheme applicable to the respective employee is according to the appointed job title, which is
preset in HR Department = Tip < Default Tip Scheme.
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Note:

5. If a user inputs the employee’s job title (in Job page) but does not specify the tip scheme code in
Benefit page, the system will still capture the related scheme based on the employee’s job title, provided
user had done setup in HR Department = Tip = Default Tip Scheme.

6. If a user chooses the relevant tip scheme code in Benefit page but does not specify the employee’s job
title, the system will process the tip calculation accordingly based on the tip scheme code selected.

7. If both pages were inputted but there exists conflict of information, e.g. user selecting a job title with
scheme different from the assigned tip scheme in Benefit page, the system will follow tip scheme setting
in the Benefit page. In other words, Tip Scheme Code in Benefit page selected will be privileged and

on hiaher orioritv.

Menu Location: HR Department = Employee = Tip
Description: This option facilitates users to maintain or modify the respective employees’ tip figure.

** Employee Tip Maintenance

Employee Mo, |E0OL
Mame AGHES TaAN YING YING
Tip Scheme Code TCOl | FOR MANAGEMENT LEVEL
Apply Status |Eefore Confirmation | Date Jaoin 04/0241993 | Date Confirm | 01/05/1993
Effective Dake 0d/02/1995 | Mo, of Poink [ Amount [ 10. 00000
Remark, .
FFecEive Date Mo, of Pointfamount Remark. ~
04/02/1993
040271394 15.00000
040271995 Z0. 00000
04,02 /1996 Z5.00000
04/02/1997 3000000
04/05/2076 0.00000
w
l Meck H Lask l l Add " Edit " Delete " Search " Prink l l Ezxit l

The footer of the module will display the Employee No, Name and Tip Scheme Code according to the
maintenance in the employee’s personnel file. Apply Status indicates the particular tip scheme is to be
applied before or after employment confirmation of the employee. Date Join will be the first record as
effective date to start the tip calculation. Date Confirm will be the starting date indicator when to begin
the tip calculation if the tip scheme is to be applied After Confirmation.

If a tip scheme is to be applied Before Confirmation, the first tip point/amount shall be taking effect
immediately from the date the employee joined the company (same as Date Join).
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On the other hand, if a tip scheme is to be applied After Confirmation, the first tip point/amount will only
be effective on the employee’s confirmed date (same as Date Confirm).

** Employee Tip Maintenance

Emploves Mo, |E00S

Mame | ANDY LOO CHIN SIM

Tip Scheme Code 'TCOZ | FOR NON-MANAGEMENT LEVEL

Apply Status After Confirmation | Date Join 01/07/2001 | Date Confirm | 01/10/2001
Effective Date 01707 /2001 . Mo, af Paint | &mounk [ 0. 00000

Remark .
E-I.:I:.ective Date Mo, af F‘u:uint,l;.ﬁ.mnunt Remark A._
| lors10/2001 L.00ooo

01/07/2002 1000000

01/07/2003 1500000

01/07/2004 2000000

01072005 25.00000

0171072084 0.000o0o0

v.

l First ” Previous “ Mexk ” Lask H add ” Edit ” Delete ” Search ” Prink l [ Exjt ]

For instance, based on the sample screen shown above, this employee is having a tip scheme which will
be applied After Confirmation. He joined the company on 01/07/2001 and was confirmed 3 months later,
which is on 01/10/2001. Therefore, his Date Join is the first effective date to begin the tip calculation.
But, he is still not entitled for the tip benefit until he obtained his employment confirmation. Thus, he will
only be entitled for the tip benefit with effective from Date Confirm onwards.

Records in the Effective Date and No. of Point/Amount will be listed according to the tip scheme
code assigned or job title appointed during the employee’s personnel file maintenance.

Nevertheless, if user does not setup any specify scheme and assign it to the employees, user can still

create/maintain the tip structure individually. For instance, when a company introduce a special tip only
for a specify group of employees for a specified period of time.

To add tip details

6. At the relevant employee’s record, click "Add” button to insert the tip detail.
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** Employee Tip Maintenance

Emploves Mo, E00E

Mame |ROBERT LIM HUI MUN
Tip Scheme Code [ i
Apply Status | Dateloin | 01/08/1994 | DateConfirm | 01/11/1994 |
Effective Date 0170172005 Mo, af Paint | Amounk 0. 00000 '
Reemark : '

| Effective Date Mo, D.F.F‘Dint,l;.ﬁ.mu:uunt Remark |
0151272002 S.50000|3PECIAL INCENTIVE FOR DEC Z002

M

v |

| Save ” Zancel l

7. Enter the Effective Date when the tip scheme shall begin. Then, input the No. of
Point/Amount. Indicate the Remark (not more than 50 characters) for reason to implement
this special tip.

8. Click “Save” button to update the record.

9. If the tip is only for a specified period of time or temporary basis, it is advisable to insert another
record to terminate the tip calculation. For example, in the sample screen shown, the special tip
is only for the month of December 2002, therefore, user should insert another record to
terminate the tip calculation from 01/01/2003 onwards. Repeat step 1 to 3 to perform insert
action.

10. Click “Exit” button to quit this module.

To modify tip details

Use Edit mode to change or modify contents of the tip when the changes only affecting a particular
employee, without major reshuffle to the existing tip scheme. For instance, when an employee is granted
an additional increment in tip benefit other than the existing tip scheme he/she is entitled for.

6. At the respective employee’s record, locate and point to the affected tip record to be modified
from the table. Click “Edit” button.
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** Employee Tip Maintenance

Emploves Mo, E004
Marne | T&N MING LING
Tip Scheme Code TCOzZ FOR NON-MANAGEMENT LEVEL
Apply Status |After Confirmation | DateJoin | 07/04/2000 | Date Confirm | 01/07/2000 |
Effective Date 'n?mq;zunq Mo, of Point | Amounk : 2700000
Remark. ADDITIONAL 2% FOR BEST STAFF
| Effective I:;a.te I"-J.D. I:;i:“F;L‘;i-I.';é,I'.':.'.I'ﬂDI.Ii'It Remark. 4‘\
07/042000 L.ooooo
07/04/2001 10.000a00
07/04/2002 15.00000
07/04/2003 20.00000
M
07/07/2083 0. ooooon
Wt ||
[ Save ” Cancel

7. Specify the Effective Date and No. of Point/Amount. Enter the Remark to indicate the
reason for this tip benefit. In the sample screen shown, the existing effective tip point/amount
from 07/04/2004 is 25.00000, now, it will be changed to 27.00000

8. Click “Save” button to update the record.

9. If the tip benefit is to be applied for certain period of time, remember to insert another tip record
to terminate the tip calculation.

10. Click “Exit’ button to quit this module.

To print tip listing
Click “Print” button to access to print option to list/print out the Employee Tip Listing.

Summary report will list out the current effective tip point/amount. Detailed report will display all tip
point/amount from the first until the latest effective date in the employee history.

Menu Location: HR Department = Tip = Tip Value

Description: This option facilitates users to determine total value to be distributed among groups of
employees. The system will calculate the employees’ tip amount based on the value and criteria defined
by user in this module.

COPYRIGHT © UBS CORPORATION SDN BHD



EZUBS

User Business System

Human Resource Management User Manual

** Tip Value Maintenance

Page 212 of 223

[ate From
Tatal Yalue
Mo, of Poink
Payrall Tvpe
Remark.

applicable ko ;-

nl/06/2004

260
13

1zt &

' .Tip écheme. C;:u:l.e

Date To
D.DDDDD_

0.00o00

Znd Half Payroll

Description

Tokal Value Per Poink

| 30/06/2004 |
20.00000

-T.ick, iF. applicalﬁle A

TCO:2

FOR NON-MANAGEMENT LEVEL

Date From

Date To

Total Yalue Mo, af Paink

Remark,

n1/01/2004

31/01/2004

1800, 00000 Accunilated

N1/02/52004

29/02/2004

1200, 00000 Accunialated

01/03/2004

31/03/2004

1500, 00000 Accunilated

n1/04/2004

30/04/2004

1550, 00000 Accunilated

n1/05/2004

01/07/2004

31/05/2004

1300, 00000 Accunilated

31/07/2004

20.00000 1.00000

(e Lo ]

| Cee ]

Delete || Print

11. Click “Add” button to define a new formula.

12. Specify the tip utilization period Date From and Date To.

13. Enter the tip’s Total Value.

Date From 0l/06/2004 Date To ins0e/2004

Total Yalue 2600, 00000 Total Walue Per Point 20.00000

Mo, of Paint 130, 00000 Total accumulated emplovees points

Payroll Tvpe l=zt & 2Znd Half FPayroll »

Remark

Applicable to .- Employees without tip scheme assigned

Tick, all
Tick, if applicable

Y |
FOE. NON-MANAGEMENT LEVEL v

Tip Scheme Code Description ~

TCOZ

14. Tick the checkbox labeled * Total accumulated employees points'.

Tokal accumulated employees points

15. Then, user must specify the source of employees’ points by ticking the relevant group(s) listed in
the table.
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Tip Scheme Code Drescripkion Tick, if applicable | #
TCOL FOR MANAGEMENT LEVEL v
A " |

16. If user wants to include those employees without any tip scheme assigned at respective
Employee Personnel File Maintenance, tick the checkbox labeled “ Employees without tip
scheme assigned'.

Emplovees without tip scheme assigned
In the sample shown above, 130 points is accumulated from three categories of employees,

including those employees classified under tip scheme code TC01 and TC02, as well as other
employees without any particular tip scheme assigned.

17. The formula for value per point is:

Total Value
Total Value Per Point = ---------------------
No. of Point

18. Next, specify the Payroll Type of salary processing method as 1 Half Payrol|, 2" Half Payroll or
1t & 2 Half Payroll.

19. Enter Remark for any additional note, if any.

20. Click “Save” button to update the details.

Alternatively, if users are using fixed value to calculate, follow these steps:-
9. Click “"Add"” button to create the formula setup.

10. Specify the tip utilization period Date From and Date To.

Date Fram al/0% /2004 Date To 31/0%7/2004

Total Walue 10. 00000 Total Walue Per Point 10. 00000

Mo, of Point 1.00000 | [ Total accumulated emplovess points

Pavrall Tvpe lzt & znd Half Payroll Al

Remark

Applicable to :- Emplovees without tip scheme assigned :
Tip Scheme Code Descripkion Tick, if applicable |

v |

TCOZ FOR NON-MANAGEMENT LEVEL W

11. Enter the Total Value and No. of Point. In the sample shown, under the fixed value method, 1
point is equal to a value of 10. For instance, if an employee is entitled for 20 point for the month
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of July 2004, this employee will earned 200 in value. If another employee is entitled for 35 points
for the period, he/she will has 350 in value, and so on.

12. Do not tick the checkbox labeled * Total accumulated employees points’.

13. But, user must specify the calculation is to be applied to which group of employees. Tick the
checkboxes listed below column named * Tick, if applicable’ for the relevant tip scheme code
or include those employees without tip scheme assigned.

14. Specify the Payroll Type.

15. Enter Remark if necessary.

16. Click “Save” button to update the details.

Note:
To view and verify the employees’ tip amount, go to Report = Tip @ Employee Tip Amount
Report. This report will display tip amount earned by the employees for a specified period of

time.

The UBS HRMS allows users to customize the tip calculation method. Go to Housekeeping = Setup =
General Setup to perform the necessary setup.

*“* General Setup @

Company || Leave || Sharing || Tip
Enable "Tip Walue Maintenance” | Tes v |

For Calculating Fmployee Tip Amount :-

1. When the emplovee tip point is started/changed in between the specified period in "Tip
Walue Maintenance”, system bo kake :-

) First dav's point/amount

(" Last day's poink/amount

() Average of all different poinksfamount in the specified period
{(*) Pro-rated pointsfamount to days of month

(%) Divide paint/amaount by the takal no. of days in the specified period
) Divide pointfamount by a fixed no. of days 26

2. tive tip to the employees who are resigned in the current month?

) Yes (total no. of active days in the month)

@.ND

o ] (et ] (oo |

If users are practising tip point method, select * Yes” in Enable "Tip Value Maintenance” so that to
activate the module HR Department = Tip = Tip Value.

Otherwise, select “No" to disable the Tip Value Maintenance module.
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Staff A Effective Point/Amount Staff Effective Point/Amount
Date B Date
01/07/2004 20.00000 01/07/2004 30.00000
16/07/2004 25.00000
Assumptions:
(i) Utilisation period is from 01/07/2004 to 31/07/2004
(ii) Total value is 1000.00000
(iii) Staff A will be granted increase of point/amount with effect from 16/07/2004
Steps:

- Setup staffs’ tip details in HR Department = Employee = Tip

- Maintain item (i) & (ii) in HR Department = Tip = Tip Value

- Change different calculation methods in Housekeeping = Setup < General Setup

- Verify the difference of end results in Report = Tip @ Employee Tip Amount Report

Formula:
3. Total Value Per Point = Total Value / No. of Point

4. Employee Tip Amount = Total Value Per Point X Number of Point or Amount for particular
employee

Example One: First day’s point/amount

Employee | Tip Amount
Staff A 400.00000
1000 Staff B 600.00000
Total Value Per Point = ---------------- =20 a _
20 + 30 Total 1000.00000

Remark: taking the first effective date’s tip point/amount, regardless any adjustment at later date within
the same period

Example Two: Last day’s point/amount

Employee | Tip Amount

1000 Staff A 454.54550

Total Value Per Point = ---------------- = 18.18182 Staff B 545.45460
25+ 30 Total 1000.00010

Remark: taking the latest effective date’s tip point/amount, regardless any adjustment in earlier days
within the same period

20 + 25
No. of Point for Staff A = --------------- =225

1000
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Total Value Per Point = ----------------- = 19.04762 Employee | Tip Amount
22.5+ 30 Staff A 428.57145
Staff B 571.42860
Total 1000.00005
Remark:

First, calculate the average number of point for employee who has multiple tip point/amount schemes
within the same period.
Then, use this figure to divide total value and also calculate the actual tip amount.

15 16
No. of Point for Staff A = (20 x ----) + (25 x ----- ) = 22.58065
31 31
Employee | Tip Amount
1000 Staff A 429.44783
Total Value Per Point = = 19.018402 Staff B 570.55200
22.58065 + 30 Total 999.99983

Remark:

First, multiple each different tip point/amount scheme with the exact number of days in the specified
period.

Then, total up all different tip schemes to get the actual number of point for the respective staff.

Note:
By default, the system will use this method to calculate the employees’ tip amount.

This method is the same as example four, the main difference is that it allows user to specify a fixed total
number of days as a base.

Assuming that we are using 26 days as the base.

15 16
No. of Point for Staff A = (20 x ----) + (25 x ----- ) = 26.92308
26 26
1000 Employee | Tip Amount
Total Value Per Point = = 17.56757 Staff A 472.97309
26.92308 + 30 Staff B 527.02710
Total 1000.00019

Example Six: Resigned employees
At Housekeeping = Setup =9 General Setup, select the option button labeled “Yes (total no. of

active days in the month” to include calculation for those employees resigned within the specified
period.
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2, Give tip to the employees who are resigned in the current month?

(%) Yes (total no. of active days in the mankh)

Mo

Assume that we select calculation method to divide point/amount by the total no. of days.

(%) Pro-rated paintsfamount ta days of maonth

(%) Divide point/amount by the takal no. of days in the specified period

And, assuming that Staff B has resigned on 18/07/2004, therefore,

Employee No. of Point Tip Amount
Staff A 15 16
(20 x ---=) + (25 x ----) = 22.58065 | 25.61983 x 22.58065 = 578.51241
31 31
Staff B 17
30 x ---- = 16.45161 25.61983 x 16.45161 = 421.48745
31
1000

Total Value Per Point =
22.58065 + 16.45161

= 25.61983

** General Setup : @

HTip @) || others

Company || Leave || Sharing ||
Claim Link Mo, {Tipd | NIL v:

For Tip Details Modification ;-

Re-generate employvees bp pointsfamount automatically (For active emploves only)
(%) Re-generate From date join/all records
() Re-generate from a specified effective date

(Based on modificakion dake) |

For changing the default confirmation month :-
(for tip scheme with apply skatus of "Afker Confirmation™)

Re-generate for non-confirmed emplovees automatically
%) all non-confirmed emplovees
) From a specified date join

(Based on modification date) |

| 04 | | Zancel | | Apply |

First of all, specify the column number in Claim Link No. (Tip) to be transferred to and linked into UBS
Payroll System.
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For the following examples, please refer the scenario with reference to 7able One and Table Two.
Assuming current month is July 2004.
Verify the effect/end result of each setup or changes in HR Department = Employee = Tip.

Table One

Employee Date Join | Tip Scheme | Default Confirmation Month | Date Confirm
Staff A 01/07/2004 TS01 3 months 01/10/2004
Staff B 16/07/2004 TS01 3 months 16/10/2004
Staff C 01/06/2004 TS01 3 months 01/09/2004
Table Two

Tip Scheme TS01 TS02

Apply Status | After Confirmation | After Confirmation

Tip Details:-

Oto< 12 2.00000 3.50000
12to < 24 5.00000 6.00000
Example One

Re-generate employees tip poinksfamount auktomatically (For ackive employees only)

(%) Re-generate from date join/all records

Select this option during the initial setup or first time using of UBS HRMS for updating of all employees’
record with the new tip scheme.

Example Two

Re-generate employees tip poinksfamount automatically (For ackive employves anly)

) Re-generate From date join/all records

(¥} Re-generate From a specified effective date

(Based on modification date) | Prompt for Date Entry w

Tick the relevant option button and specify the effective date to re-generate tip points/amount, whether
the new adjustment shall be effective from Today, Tomorrow, 1 Day of Current Month, 1 Day of Next
Month or I** Day of Next Year.

Alternatively, user may preset the system to “Prompt for Date Entry/’, allowing user to define and specify
an exact effective date to re-generate the adjusted tip points/amount.

** Fnter Date IE|

Enter an effective date to re-generate
employee tip poinkfamounk ;-

Date __
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Now, let us look into a scenario.
Staff A from scheme TS01 will be promoted on 01/12/2004 and change to another scheme TS02.
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4. Go to HR Department % Employee = Personnel File - -> Benefitto change the

employee’s Tip Scheme Code to TS02.

5. Enter the effective date as 01/12/2004 when the system prompts for date entry.

6. Then, go to HR Department = Employee = Tip to verify the changes.

Before adjustment
Effective Date No. of Point/Amount
01/07/2004 0.00000
01/10/2004 2.00000
01/07/2005 5.00000
Note:

After adjustment
Effective Date | No. of Point/Amount
01/07/2004 0.00000
01/10/2004 2.00000
01/12/2004 3.50000
01/07/2005 6.00000

(iii) Tip point/amount’s records before adjustment will be retained.
(iv) From the adjustment’s effective date onwards, the tip point/amount will change and follow the

new scheme.

Example Three

Modify scheme TS01 as below and apply to all staffs the newly adjusted scheme to replace the old
scheme with effective from 01/07/2005.

Tip Scheme TS01
Apply Status | After Confirmation
Tip Details:-

Oto< 12 3.00000
12to < 24 8.00000

4. Go to HR Department = Tip = Tip Scheme to modify the tip details.

5. Enter effective date as 01/07/2005

6. Then, go to HR Department = Employee = Tip to verify the changes for staff B & staff C.

Staff B
Before adjustment
Effective Date No. of Point/Amount
16/07/2004 0.00000
16/10/2004 2.00000
16/07/2005 5.00000
Staff C
Before adjustment
Effective Date No. of Point/Amount
01/06/2004 0.00000
01/09/2004 2.00000
01/06/2005 5.00000

After adjustment
Effective Date | No. of Point/Amount
16/07/2004 0.00000
16/10/2004 2.00000
01/07/2005 3.00000
16/07/2005 8.00000
After adjustment
Effective Date | No. of Point/Amount
01/06/2004 0.00000
01/09/2004 2.00000
01/06/2005 5.00000
01/07/2005 8.00000
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Note:

(iii) Effective from 01/07/2005 onwards, staff B will utilize the new adjusted tip point/amount and
ignore the remainder record from old scheme.

(iv) On 01/06/2005 before the scheme adjustment, staff C still follows the old scheme. But, effective
from 01/07/2005 onwards, staff C will change to utilize the newly modified scheme.

Modification of Employees’ Confirmation Month

For changing the default confirmation month :-
(for tip scheme with apply skatus of "After Confirmation™)

Re-generate for non-confirmed emplovees automatically
() al non-confirmed employess
(") From a specified date join

(Based on modification date)

Note:
4. All modifications are only applicable for the tip schemes with apply status “After Confirmation”.

Changes of setup in this option only affecting group of employees with tip scheme applied after
their confirmation.

5. All modifications are only affecting those employees who are not yet confirmed by the employer.
In other words, the Date Confirm in HR Department = Employee = Personnel File - -> Job
MUST BE blank or not input yet.

6. Modify the number of confirmation month in Housekeeping = Setup = General Setup - ->
Others or Housekeeping =9 Setup = Default Setting =@ Confirmation Month to differentiate

the effect of each selected option in this module.

Example Four
Change the confirmation month from 3 (old record) to 4 months (new adjustment) for ALL STAFFS,
regardless when the staffs have joined the company.

Re-generate for non-confirmed employees automatically

() all non-confirmed emplovees

5. Tick the checkbox and select the first option button as shown above.

6. Go to Housekeeping = Setup = General Setup - -> Others to change the default
confirmation month to 4.
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“* General Setup

Company || Leave || Sharing || Tip || Tip (2) | Others

For Leave, Claim, Resource, Appraisal Modules ;-

[] allow access to resigned employves

Default Confirmation Morth | 4

MESSAGE

‘E’/ Are you sure you wank bo savey

[ oves [ Ma

| IE | l Cancel |

7. Click "Apply” and then “Yes"” button to execute the setup.
8. Then go to HR Department = Employee = Tip to verify the effect of modification.

Staff A

Before modiification (confirmation 3 months) After modiification (new confirmation 4 months)

Effective Date

No. of Point/Amount

01/07/2004 0.00000 01/07/2004 0.00000
01/10/2004 2.00000 01/11/2004 2.00000
Staff B

Before modiification (confirmation 3 months)

Effective Date

No. of Point/Amount

16/07/2004 0.00000 16/07/2004 0.00000
16/10/2004 2.00000 16/11/2004 2.00000
Note:

Effective Date

No. of Point/Amount

After modiification (new confirmation 4 months)

Effective Date

No. of Point/Amount

(iii) Before modification, staff A who joined on 01/07/2004 should be confirmed 3 months later on
01/10/2004. But, after modification, the estimated confirmation date has changed to 01/11/2004,
which is 4 months later.

(iv) The structure of tip scheme in number of point/amount remains unchanged.

Example Five

With effective from 01/07/2004, confirmation month for the staffs will be changed to 5 months instead of
old default confirmation month of 3 months.
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Re-generate For non-confirmed employvees aukarmatically

3 all non-corfirmed emplovees

(%) From a specified date join

(Based on modification date) | prompt for Date Entry w

7. Tick the relevant option button and specify the effective date to re-generate tip points/amount,
whether the new adjustment shall be effective from Today, Tomorrow, I** Day of Current Month,
I Day of Next Month or 1 Day of Next Year.

8. Alternatively, user may preset the system to “Prompt for Date Entry’, allowing user to define and
specify an exact starting date to re-generate the tip points/amount’s effective date.

9. Then, go to Housekeeping = Setup = General Setup - -> Othersto change the default
confirmation month to 5.

10. Click “"Apply” and then “Yes” button.

| Company || Leave || Sharing || Tip || Tip (2) | Others i

For Leave, Claim, Resource, Appraisal Modules ;-

[] allow access o resigned employves

Default Confirmation Manth 3

** [nter Date

Enter a "date join From" to re-generate
emplovee tip point/amount {For non-confirmed
employes) :-

Date | 01/07/2004 |

| (0] | | Zancel | | Apply

11. Enter the effective date 01/07/2004 to re-generate the tip point/amount details. Click "OK” and
then “Yes"” button to acknowledge the setup.

12. Go to HR Department @ Employee = Tip to verify the effect of modification.

Staff B
Before modiification (confirmation 3 months) After modiification (new confirmation 5 months)
Effective Date No. of Point/Amount Effective Date | No. of Point/Amount
16/07/2004 0.00000 16/07/2004 0.00000
16/10/2004 2.00000 16/12/2004 2.00000
Staff C
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Before modiification (confirmation 3 months) After modification (retain confirmation 3 months)
Effective Date No. of Point/Amount Effective Date | No. of Point/Amount

01/06/2004 0.00000 01/06/2004 0.00000
01/09/2004 2.00000 01/09/2004 2.00000
Note:

(v) Before modification, all staffs are having confirmation month of 3
(vi) After modification with effective from 01/07/2004, staff B who joined the company after the date
will be affected.
(vii) Staff C who has joined the company earlier that the modification date will not be affected. Staff
C still using the original effective date to calculate the tip point/amount.
(viii) The structure of tip scheme in number of point/amount remains unchanged.
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